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Release Notes – January 2011
Section 1: Please Note the Following Alerts
Expense Administration Functions at Parity will be Retired from the
Classic User Interface with the February Release
Beginning with the February release (February 25, 2011), functions at parity in the
current UI (listed below) will be retired from the classic UI.

TRAVEL ALLOWANCE CONFIGURATION
•

Expense - now available in the current interface

POLICIES
•

Expense - now available in the current interface

EMPLOYEE FORMS & FIELDS
•

Expense - now available in the current interface

Expense Administration Functions at Parity will be Retired from the
Classic User Interface with the April Release
Beginning with the April release (April 15, 2011), functions at parity in the current UI
(listed below) will be retired from the classic UI.

EXPENSE COMPANY CARD ADMINISTRATOR
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•

Manage Cards - now available in the current interface

•

Assign Cards - now available in the current interface

•

Diversion and Lodge Accounts - now available in the current interface

•

Settings - now available in the current interface

•

Manage Transactions - now available in the current interface

•

View Import Logs - now available in the current interface
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Section 2: Enhancements From Client Suggestions Forum
The following features were submitted using Concur's Suggestion service, available
via Concur's forums. They are now included in this service release.
•

Company Card Hover Action Displays Merchant Tax ID:
The merchant Tax identification number will now appear in the popup that
displays when you hover over Company Card Information.

•

Travel Allowance Wizard Includes a Select All Option:
The user can now select an Exclude All check box to select all days, then
clear selected days to be used, in the Wizard's Expenses & Adjustments
page.

•

Vendor Manager Can Now Deactivate a Vendor:
The Vendor Manager can now decide to temporarily deactivate a vendor so
that the vendor is not available as a choice for a new request.

•

Default Distribution Method - Last Choice Becomes Default:
When allocation a line item, the choice the user makes becomes the new
default until a different choice is made.

•

Intelligent Capture: Capture Invoice Owner Data for AutoAssignment:
Intelligent Capture can now identify and capture information in the Attention
field of an invoice, using this information to automatically assign the invoice
during the import process.
Each of the features in this section is described in brief here, and in more
detail in their respective sections within this document - if you need additional
information please refer to these sections.

Release Notes
January 2011

Page 4

Concur Travel & Expense
Client-Facing

Section 3: Shared Functional Updates
The following features include functionality that is shared across the Expense,
Invoice, Travel, and Expense & Travel platforms.

Allow a Mode Where No Cookie - Other Than Session Cookie - is Set
The purpose of this feature is to remove all cookies other than the session cookie. It
is a platform feature that affects Expense, Travel, Invoice, and Travel & Expense.
Some customers would like to operate Concur in a mode where cookies are not set
for security reasons. Concur requires session cookies, but now the use of other
cookies is strictly optional.

Configuration
There is a new module property - Enable Cookies. Module properties are managed
only by Concur. To have this configured, clients must contact Concur Client Support.

What the User Sees
If the Enable Cookies setting is true (which is the default), then Concur will use
cookies to track items such as the following:
•

The language to show on the login screen

•

The list of recently run reports in the Reports portal (using Travel)

•

The last login ID used (if Remember user name on this computer is
selected)

•

The most recent date range used when running a report on Reports portal (to
default for the next report; using Travel)

•

Some debugging information to help troubleshoot Expense connectivity

•

The day of the week on which the user's calendar starts

When the setting is set to false, cookies will not be used and so Concur will not
“remember” those items. Some will be looked up from the database (which is a
minor performance degradation) and for others, the defaults will be chosen. For
companies with browsers that are set to block all cookies except session cookies,
Travel, Expense, and Invoice should work with no issues.

Limitations
When a user arrives at the login page, there are cookies that are set on that page.
Since the user has not yet been authenticated, we do not know who the user is, so
we do not know the user's setting for Enable Cookies. If any cookies are sent, they
can safely be blocked by a browser. They contain a language code for the login page,
and a reference to the specific partner branding for Concur. Upon login, these
cookies will be removed from the machine if the company has cookies disabled.
Release Notes
January 2011
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New Alternative for "Password Reset" - Hide and Security Questions
This release brings a new option to enable or disable the password reset link on the
Login page.

In addition, administrators can configure Concur to provide security questions for
users when they change passwords. There can be up to six possible questions, of
which the user can be presented with up to two.
The administrator selects the questions in Company Admin; the user provides the
answers in Profile.

Configuration
This feature is configured in Company Admin > Password Administrator.

Release Notes
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The administrator uses this page to define/select:
•

If/When the user can request the reset of his/her password

•

Who the user should contact

•

The text of the user message

•

Whether the Forgot your user name link is hidden

•

The available security questions and the number the user has to answer
correctly

What the User Sees - Profile
After configuration (Requires Security Questions for User Password Change is
selected in Company Admin > Password Administrator), the next step is to obtain
the answers from the user.
When the user logs in, this page appears.

The user selects the desired questions, provides the answers, and clicks Save.

What the User Sees - Forgot Password
Later, if the user clicks the Forgot your password? link and if the administrator
selected Any time or After user has at least logged in successfully once in the
When should the user be allowed to request that his/her password be reset
(Company Admin > Password Administrator), then Send me an email with a link
to reset my password appears:
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When the user clicks Submit, the following page appears:

The user provides the answers and clicks Submit.
Then:
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•

If the answers match, the email with the password reset link is sent to the
user.

•

If the answers do not match, this message appears:

Page 8

Concur Travel & Expense
Client-Facing

Section 4: Expense
The following features are included in this service release.

Expense Policies Now Available in Current User Interface
Overview
The Policies functionality is now
available in Expense Admin. Please note
the following about this feature:

Business Purpose
This enhancement moves an expense
administrative function to the current
user interface.

•

The Edit Expense Type
Properties functionality is not
included in the Policies page. That functionality is available in the Expense
Types page in Expense Admin.

•

The Expense Categories for Policy functionality will remain in the classic user
interface.

Refer to the Expense: Policies Setup Guide for more information.

Configuration
No additional configuration is required to use this feature.

Exclude All on the Travel Allowance Expenses & Adjustments Tab
Overview
Business Purpose
A new check box has been added to the
Exclude column on the Expenses &
This enhancement makes editing
Adjustments tab of the Travel
quicker and easier for users.
Allowance wizard. Users can click the
All check box to select all rows - instead of selecting each individually.
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Configuration
No configuration is required; the feature is automatically on.

Forms and Fields: Employee Forms Now Available in Current User
Interface
Overview
The Employee Forms functionality is
now available in the Forms and Fields
page of Expense Admin. This feature is
in full parity with the classic user
interface. The Employee form type is
now available in the Form Types list:

Business Purpose
This enhancement moves an expense
administrative function to the current
user interface.

Refer to the Expense: Forms and Fields Setup Guide for more information.

Configuration
No additional configuration is required to use this feature.

Change in Tax & Reclaim Groups
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Overview
In Tax Administration, the Tax &
Reclaim tab is used to define rates and
conditions for "sets" of expense types.
With this release, there are a few
changes to the way Concur handles
changes in the "sets."

Business Purpose
This enhancement ensures the proper
management of tax and reclaim
groups.

Enhancements
If the administrator changes the effective date of an existing group or adds an
expense type to an existing group or removes an expense type from an existing tax
& reclaim group, Concur creates two new groups:
•

•

For the first group (basically, this is the historical information):
♦

Effective date: effective date of the original group

♦

End date: the day before the new effective date, as set by the
administrator

♦

Expense types: original set of expense types

For the second group:
♦

Effective date: new effective date, as set by the administrator

♦

End date:

♦

•

If the administrator set the end date, then that is the end date for this
group.

•

If the administrator did not set the end date (blank), then there is no
end date for this group.

Expense types:
•

If expense types were added/deleted, then this is the new set.

•

If expense types were not added/deleted, then this is the original set.

These changes have no effect on the effective date, end date, or expense types in a
group:
•

Edit of the name of an existing groups

•

Edit a tax rates condition or tax rates

•

Edit a reclaim conditions or reclaim rates, add or remove a reclaim
configuration

•

Edit a reclaim extraction factor

Workflows Now Available in Current User Interface

Release Notes
January 2011
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Overview
Workflows is now available in Expense
Admin.
Please note that the Request workflow
is still managed in the classic user
interface.

Business Purpose
This enhancement moves an expense
administrative function to the current
user interface.

The workflow setup guides will be updated over the next two weeks.
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Section 5: Invoice
The following features are included in this service release.

Intelligent Capture: Capture and Route Invoice to Invoice Owner
Overview
A new invoice can now be automatically
assigned and directed to an owner's
queue, bypassing manual assignment,
by using Intelligent Capture to capture
the owner's name directly from any
variant of the Attention field of the
paper invoice.

Business Purpose
This enhancement brings the #1 most
requested feature to Intelligent
Capture: automating the assignment of
the invoice to its owner.

How It Works
This feature works by enabling Intelligent Capture to capture the Invoice Owner. It
will automatically capture any name value it finds next to variations on the Attention
field on the paper invoice. This data comprising the owner's name (variations on
First, Last name), populate a new Owner field and become the search criteria the
system uses to attempt a match within the Invoice database via the extract.
Assignment is made on exact match of the employee name within the Invoice
database, or an Unassigned status and routing to Backoffice where no match can be
found.
If the field cannot be populated by Intelligent Capture at the invoice level, whatever
value is found at the batch (import) level is used to populate the invoice. However,
the value found at the invoice level will always override that found at the batch level
as well as any explicit Vendor to user mapping configured in Invoice. With Intelligent
Capture, errors or omissions can be corrected and the process fine-tuned to return
greater success rates.

Configuration
The Intelligent Capture operator will need to manually direct Intelligent Capture to
fingerprint a new vendor's invoice for the value found beside Attention. There may
be some minimal learning of character patterns that transfers across vendors,
increasing initial recognition rates. However, clients should be prepared to manually
direct the application for new vendor invoices if the system does not auto-populate
the Owner field with the first encounter of the new vendor.
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Vendor Manager Can Now Deactivate an Approved Vendor
Overview
Business Purpose
An approved vendor can now be
temporarily deactivated in order to
This enhancement lets the Vendor
prevent a new request from being
Manager move quickly to prevent their
associated with them. Deactivating a
users from associating a new request
vendor is useful whenever a vendor
with a vendor that should no longer be
should not be used because they are no
worked with.
longer in business, they have merged
with another vendor, or when issues arise with financial transactions, as examples.
Deactivating is especially useful when the status change is only temporary, or when
the client does not want to wait for overnight processing updates.

! Deactivating does not delete the vendor or change their status in the Vendor

Master List - the vendor is simply marked as Inactive and can be returned to
active status whenever the Vendor Manager chooses. Permanent deletions can
continue to be handled by deleting the vendor in the Vendor Master List, and
updating Concur via the Approved Vendor import.

When a vendor is deactivated:
•

The vendor is marked with the word Inactive in the Vendor Manager page

•

The deactivated vendor can no longer be selected when creating a new
request using either the import or the user interface functions

•

A new command on the View menu lets the user search for this vendor type

•

All requests currently associated with the deactivated vendor proceed as
normal - no existing request is prevented from completing workflow

•

The vendor can be re-activated at a future date

Deactivating the Vendor
One or more vendors can be deactivated.
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To deactivate an approved vendor:
1.

On the Vendor Manager page, click the Manage Vendors tab.

2.

Perform a search to return the vendor(s) you will deactivate.

3.

Select the vendor(s) to deactivate.

4.

On the Actions menu, click Inactivate Vendor.
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The vendor is now marked as Inactive and cannot be selected for any payment
requests, but can be reactivated for use at a later date.

Refer to the Vendor Manager User Guide for more information.

Percent or By Amount Default Distribution Mode Can Now be Set
Overview
Business Purpose
With this release when the user
allocates a line item by either percent
This enhancement removes an
or amount that choice becomes the new
additional step from allocation and
default each time they allocate a line
allows the user to choose their own
item going forward. Currently
preferences for allocating line items.
Percentage is the default system
option, and the user must select Amount to allocate using that method. With this
change, the user can choose their preferred allocation method and have the system
retain the preference until they change it again.
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Configuration
No configuration is required, the user simply uses the allocation feature as they have
always done. The only change is seen when they allocate another line item and their
last choice (Amount) is shown as the default choice as shown in the figure below:

Refer to the Allocations Setup Guide for more information.

Rebrand: Concur Invoice User now Invoice Full User
As part of the recent rebranding effort, the role Concur Invoice User is now renamed
to Invoice Full User. No functional changes have been performed, only the role name
has changed.

Release Notes
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Section 6: Request
The following features are included in this service release.

Amounts Available at the Segment Level
Overview
Users can now enter estimated amounts (and currency) for each segment.

As the user saves segments, the running total appears at the top of the request - in
the user's reimbursement currency.
Note the following about amounts:
•

Release Notes
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The amount not only appears on the request, it appears in the new Amount
column in the Active Work section of My Concur, in the user's request list,
the Approval Queue section of My Concur, and the approver's Requests
Pending Your Approval page.
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•

If any of the segments are entered in a currency other than the user's
reimbursement currency and if the Expense Rates feature is properly
configured, then:
♦

The total reflects the conversion to the user's reimbursement currency.

♦

The system uses the current exchange rate.

♦

The conversion is calculated when the segment is saved, and it is
recalculated if the segment is reopened and saved.

•

A user can enter zero in the Amount field - even if the field is required.

•

Approvers cannot adjust amounts - even if the form field is configured to
allow the approver to modify the field.

•

These fields are available in Audit Rules.

Configuration
The Amount and Currency fields have been added to the default segment forms.
If the client uses the default segment forms and if the client wants to use these two
fields "as is" then no action is necessary. Otherwise, the client contacts Concur Client
Support for configuration assistance.
Concur can make normal field changes (add them, remove them, make them not
required, etc.) on the default forms or the client's custom segment forms whichever is desired by the client (using Request Admin > Forms and Fields).
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Segment Allocations Available
Overview
Segments can now be allocated. Once the first segment is saved, the Allocate
button appears.
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The user defines the allocations, using the allocation window, which has the same
look-and-feel and the allocations window in Expense.

Allocations in Request are very similar to allocations in Expense, for example:
•

Allocation fields are defined on the allocation form. (There is a new allocation
form in Request.)

•

Data in the allocation fields can be copied down from the employee form or
the request header form.

•

The user can define the allocation as a percentage or an amount.

However, unlike allocations in Expense:
•

Segments cannot be allocated individually. All segments on a request share
the same allocations. If any segment is allocated - all segments are allocated.

•

The Request allocation fields cannot be configured as connected lists.

NOTE: Connected lists will be included in a future enhancement. If your Expense
allocations use connected lists, consider waiting for this enhancement before
using allocations in Request. This will ensure a more consistent experience for
the user and will ensure a more accurate collection of allocation data.

Configuration
If the client wants to use Request allocations, the client contacts Concur Client
Support for configuration assistance.
Concur will then configure the Request allocation form and fields in Request Admin >
Forms and Fields.

Release Notes
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Printing Requests
Overview
Users can now print their requests using the new Print button.

The entire request - including segments - prints.

Release Notes
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NOTE: In a future release, the report format will be configurable. Also, additional
formats will be available so the user can select the desired format.

Configuration
The default printed report is automatically activated on the default request policy.

Release Notes
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Agency Email Notification Enhancements
Overview
The emails that are sent to the agency have been enhanced:
•

The emails now include segment information:
♦

The format is the default request printed report.
NOTE: Currently, the report is not configurable. In a future enhancement,
the report will be configurable and additional formats can be
added.

♦

•

The segments that are included in the report are defined in the policy.

The language that is used in the email and for the attached report can be
specified at the travel agency level.

Configuration
In the “Default Travel Request Agency Approval Notification” and the “Default Travel
Request Agency Booking Request Notification”, the default report is included in the
body of the email.
If the client wants to remove the report, include another one or have it as an
attached file, the client contacts Concur Client Support for configuration assistance.
Concur will then:
•

Release Notes
January 2011

Define the segments that are managed by the agency on the Segments tab
of Request Admin > Request Policies.
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•

Define the travel agency language in Request Admin > Travel Agency Offices.

•

Add to the default Request header to the agency field in Request Admin >
Forms and Fields and check the roles access rights.
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Section 7: Expense Pay
The following features are included in this service release.

Expense Pay Euro: Add Support for French Overseas Regions
Overview
Business Purpose
Prior to this release, the SWIFT codes
used in the French Overseas Regions
This enhancement expands banking
were not supported by Expense Pay
support in France.
Euro. In the January release, Concur
has added support for the following French Overseas Regions:
•

GF French Guiana

•

GP Guadeloupe

•

MQ Martinique

•

PM Saint Pierre and Miquelon

•

RE Réunion

•

YT Mayotte

Configuration
No additional configuration is required to use this feature.
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Section 8: Jobs
The following features are included in this service release.

Name on Card Field Character Limit Increased
Overview
Business Purpose
The maximum length for the Name on
Card field in the 600- and 650-level
This enhancement brings this field to
Employee Import records is now
the required specification.
lengthened from 40 to 255 characters.
This change is done to align the number with a new check being performed on this
field to ensure it does not exceed 255 characters and to match the field with the size
of the database column NAME_ON_CARD in the CT_CREDIT_CARD_ACCOUNT table.

Expense Pay Jobs Renamed
Overview
The Expense Pay jobs have been
renamed to match the updated product
branding. The changes are:

Business Purpose
This enhancement updates the job
branding to Expense Pay.

•

The Direct Reimbursement
Batch Process job is now named Expense Pay Reimbursement

•

The CP Daily Funding Email job is now named Expense Pay Daily Funding
Email

•

The Concur Pay Demand Processor job is now named Expense Pay Demand
Processor

Travel Employee Extract Job Renamed
Overview
The Travel (Cliqbook) extract job has
been renamed to match the updated
product branding. The change is:
•
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Business Purpose
This enhancement updates the job
branding to Travel.

The Cliqbook Employee Extract
job is now named Employee Extract to Travel
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Analysis and Intelligence
The following features are included in this service release.

Analysis/Intelligence – Report Updates
Many of the existing Standard Reports have had some usability updates made to
them in the January Release. The impacted reports are:
•

Employee Details – Logon ID has been added to this report.

•

Missing Receipt Audit – This report was previously only available to
Intelligence clients. This report is now available to Analysis clients as well at
Analysis – Standard Reports > Expense Processing.

•

Employee Roles – This report was previously only available to Intelligence
clients. This report is now available to Analysis clients as well at Analysis –
Standard Reports > Administration.

•

Meeting Attendee Flight Segments – This report was incorrectly retrieving
flight information from the Ticket Segment portion of the model. The report
has been update to use Air Segments.

•

Expense Reports by Country – This report has a date prompt, but the
associated filter was not using the values passed. The report query has been
updated to use the Date Prompt, as expected.

•

Credit Card Transaction – This report had a new date prompt added. Users
can run this report either by Transaction Date or Posted Date. On the
results screen, a new column Transaction Date has been added.

•

Billed Transaction Reconciliation - Details – Submitted Date has been added
to this report.

New Standard Report: Car Receipt Additional Spend Summary
Travel Managers will use this report for two distinct purposes. First, they can use this
to see whether or not their employees are being compliant with company car rental
policy. If employees are not supposed to be purchasing GPS units, but there are
1000.00 a month being spent on them, there is a problem. This report will also
provide Travel Managers with insight on Vendor compliance. If a company has
negotiated a discount/waiver for insurance, yet are being consistently charged for it,
they can quickly take action. This report is available at:
Intelligence – Standard Reports > e-Receipt or Analysis – Standard Reports
> e-Receipt

Release Notes
January 2011
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Car Receipt Additional Spend Summary: Report Prompts

Car Receipt Additional Spend Summary: Report Output

Release Notes
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New Standard Report: Internet Usage
Travelers will frequently charge a company for internet usage at several locations
(hotel, airport, etc). These fees can add up quickly and other cheaper options are
available. For example, a company may choose to issue an Air Card to frequent
travelers. This report will enable companies to identify how much is being spent on
internet usage, and create and enforce a sensible policy. This report is available at:
Intelligence – Standard Reports > Spend or Analysis – Standard Reports >
Spend

Internet Usage: Report Prompts

Release Notes
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Internet Usage: Report Output

New Standard Report: Excessive Personal Car Mileage
Travelers will use a personal car to travel for business. In many cases, it may be
more cost effective for the company to instead rent a car on a trip. This report will
enable companies to identify how much is being spend on car mileage, and create
and enforce a sensible policy. This report is available at:
Intelligence – Standard Reports > Spend or Analysis – Standard Reports >
Spend

Release Notes
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Excessive Personal Car Mileage: Report Prompts
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Excessive Personal Car Mileage: Report Output

New Standard Report: Hotel Receipt Details
This report will allow users to quickly view details provided by Hotel vendors who
provide e-receipts. E-Receipts provide an additional level of detail directly from the
Vendor and can include information about optional costs incurred from the hotel stay
(upgrades, mini bar, phone/internet, etc). This report is available at:
Intelligence – Standard Reports > e-Receipts or Analysis – Standard Reports
> e-Receipts
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Hotel Receipt Details: Report Prompts

Hotel Receipt Details: Report Output
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New Dashboard Metric – Car Rental Fees by Vendor
Travel Managers will use this metric for two distinct purposes. First, they can use this
to see whether or not their employees are being compliant with company car rental
policy. This metric will also provide Travel Managers with insight on Vendor
compliance. This report is available to Intelligence clients in the Dashboard Metrics
folder.

Analysis/Intelligence – Fiscal Calendar Support
Fiscal Calendar - Overview
In the January release, we are introducing the new feature: Fiscal Calendar. This
feature provides a user interface for administrators to map their Fiscal Months to the
Calendar Months. This feature has been frequently requested in Solutions Suggestion
and at the User Conference. Using this feature, clients will have the ability to easily
report on specific fiscal date ranges.
Once the Fiscal Months have been mapped to Calendar Months, the archive
populates the information in the reporting database. All entries and will have a Fiscal
Calendar date, in addition to the actual calendar date. Using pre-built Fiscal Calendar
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Filter, a report writer can easily add a Fiscal Filter to find all transactions for a give
fiscal month, quarter, or year.

FISCAL CALENDAR – CONCUR TRAVEL & EXPENSE USER INTERFACE CHANGES
In order to utilize this feature, a new tab – Fiscal Calendar Set Up - has been
created. This tab is available by selecting the Reporting Configuration link on the
Expense Administration screen.

NOTE: There is a corresponding Fiscal Calendar Set Up tab on the Invoice
Administration screen.
There are two sections that need to be populated on the Fiscal Calendar Set Up
tab. First, the Administrator needs to select a Fiscal Year. This is a static drop down
list of years between 1999 and 2015:
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After a Fiscal Year has been selected, the start dates for the months in that Fiscal
Year will need to be defined. For example, for a company that starts its Fiscal Year
on October 1, the Start Date for Fiscal Month 1 would be October 1. The End Date for
the Fiscal Month is always one day less than the Start Date of the next Fiscal Month.
In the example below, the Start Date for Fiscal Month 2 is November 1, for the end
date for Fiscal Month 1 is October 31.
Once all Fiscal Months have been define for a Fiscal Year, select the Save button in
the upper left corner of the screen. Saving will validate the values are correct and
make sense. If there are any inconsistencies, the Save will not occur. An example of
this would be Fiscal Month 2 having an earlier Start Date than Fiscal Month 1.
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NOTE: Fiscal Calendar date mappings will not be immediately available in the
Reporting Database. An archive must be successfully completed before this
information can be utilized.

FISCAL CALENDAR – CONCUR DATA WAREHOUSE MODEL CHANGES
Once the Fiscal Months have been mapped to the Calendar Months and an archive
has been successfully run, the report writer will have the ability to quickly and easily
filter month for a Fiscal Month, Fiscal Quarter or Fiscal Year. Pre-build filers have
been added to the Concur Data Warehouse Model to facilitate this.
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Analysis/Intelligence – User Interface Updates
User Interface Color and Format Change
In the January Release, we have updated the look and feel of Analysis and
Intelligence. The overall color scheme and formatting are now consistent with the
recent changes made within Concur Travel and Expense. It is important to mention
that these updates have no impact on the functionality of the offering. None of the
links have changed location, and there is no functionality introduced or lost.
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Previous User Interface:

Updated User Interface:

Dashboard Metrics - User Interface Color and Format Change
In the January Release, we have updated the look and feel of the Dashboard Metrics
available to Intelligence clients. We have added a background gradient and
implemented a new color palette. We have also added a baseline value (the yellow
bar in the second screenshot below), which is the average of the amounts displayed
in the metric.
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Previous User Interface:

Updated User Interface:
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Section 9: Web Services
The following features are included in this service release.

Web Services Release Notes
The Web Services release notes are available in a standalone document. This
document is accessed through Concur Client Central > Resources > Release Docs >
Web Services (as shown in the figure below):
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Section 10:

Concur's Mobile App

Separate Release Schedule
The release for the mobile app is not on the same schedule as Travel & Expense,
Expense, and Travel. In addition, each Smartphone is handled differently, resulting
in different release dates for each Smartphone.

How It Works
When the app is ready for release, Concur submits it to the various app stores. Each
app store tests and approves the app, which takes between 3 and 10 days. When
testing is complete, the app is made available in the store.

Information Available on Concur Client Central
As information is released, it will become available to clients:
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•

On Concur Client Central by navigating to Resources > Document Library>
Concur Mobile:

•

On Concur Client Central by navigating to Resources > Release
Documentation:
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•
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In Online Help in Travel & Expense, Expense, and Travel:
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Section 11:

Supported Configurations

The following configurations are either supported or no longer supported with this
service release.

Upcoming Certifications
Support for Adobe 10.0
Support for Adobe Reader version 10.0 will be included in an upcoming release.

Support for Mozilla Firefox Version 4.0
Support for the Firefox browser version 4.0 under both the Mac OS X and Microsoft
Windows operating systems will be included in an upcoming release.

Support for Windows 7 Under Service Pack 1
Support for Microsoft Windows 7 using Service Pack 1 will be included in an
upcoming release.

Support for Windows Internet Explorer Version 9.0
Support for Microsoft Internet Explorer version 9.0 will be included in an upcoming
release.
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Section 12:

Documentation

Please note the following documentation change(s).

Documentation Change - Value Added Tax (VAT) and Tax
Administration Guides Combined
The value added tax (VAT) feature is configured using the Tax Administration tool in
Expense Admin. Instead of having a separate setup guide for the value added tax
(VAT) feature and one for the Tax Administration tool, this information has been
combined into the Expense: Value Added Tax (VAT) / Tax Administration Setup
Guide.
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Section 13:

Resolved Issues - Expense

Case ID

Case/Defect Description

100721000453

Product/Feature: Expense/
Description: An Unexpected Software Error (UE) is generated when the user
attempts to select None Selected from the Airline Fee Type Code dropdown list
after attempting to add the Airline Baggage Charges expense type. In this
scenario, the None Selected option should not be available to the user.
Resolution: The code is modified to relocate the pre-processing code in order
to better handle child and parent entries.

100809000704
101021000657

100818000671

Product/Feature: Expense/Roles
Description: When assigning Cognos roles the user is not able to modify
Group settings - Global Group choices are not available.
Resolution: The stored procedure is modified to now handle the situation
where a Reporting hierarchy list is changed, but users in that hierarchy list
have not yet been assigned the Role Admin.
Product/Feature: Expense/User Roles
Description: All Employee Admin sub-roles remain associated with a user
who was assigned the role in the classic interface, but who has had the
Employee Admin role removed in the current interface. These roles should
have been removed from the user along with the parent role.
Resolution: The code is modified to now append the orphaned roles to the
string of roles to be removed whenever the Employee Admin role is removed
for a user. In addition, a script is used to clean up any orphaned roles in an
entity.

100921000688

Product/Feature: Expense/Card Charges
Description: The "Personal Card Charge" popup text that appears when
hovering over the Personal Expense icon is misleading - the icon could also
refer to a tender of cash or credit card. The text should be changed.
Resolution: The text is modified to now read "Personal Charge."

100923000163

Product/Feature: Expense/Smart Expenses
Description: An audit trail entry is not created when creating a new expense
report by adding card charges from the Smart Expense window.
Resolution: The code is modified to now pass the EditedByEmpKey to the
SaveReport API.

100928000821

Product/Feature: Expense/Card Charge Import
Description: When attempting to import a second credit card charge where
the first charge is of Personal status, the user cannot import the second
charge but instead is shown the message "Selected items cannot be added to
the report at this time - please try again at a later date. If you continue to
have difficulties, please contact your Expense administrator."
Resolution: The code is modified to create the parent entry but prevent
itemization of the expense if it is determined to be of Personal status.
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Case ID

Case/Defect Description

101007000053

Product/Feature: Expense/User Permissions
Description: In User Permissions, searching by role for employees who are
granted that role results in no search criteria displaying - the search return is
blank.
Resolution: The code is modified to add a "Processing" prompt when the
search user query is running and to add a message to this search that will
display when the search query times out, requesting that the user use more
specific search criteria. Prior to this fix the query would end and because no
results were displayed it was thought the search had been abandoned.

101011000617

Product/Feature: Expense/Workflow
Description: A Skip Step should not fire when there is 2 manager approval
steps and a circular approval chain with a change approver workflow rule on
the second step.
Resolution: The code is modified to now perform the Skip Step only after the
system has performed a check to determine that there is only a single
Approver.

101014000071

Product/Feature: Expense/Itemizations
Description: The copy down function is incorrectly clearing fields in
itemizations after modification and save of the parent expense field.
Resolution: The code is modified to change the copy down action to look up
the CT_LIST_ITEM from the correct key to prevent it from nulling the field.

101021000146
101103000912

101026000099

Product/Feature: Expense/User Interface
Description: The receipt image disappears when the user hovers the mouse
over an entry comment in the same window.
Resolution: The code is modified to no longer close the PDF reader that
displays the image when the user decides to hover over an entry comment at
the same time. Instead, the PDF window only closes the image display if
hovering over the entry comment would cause a conflict of the two displays.
Product/Feature: Expense/Travel Allowance (Swedish)
Description: A Swedish user who enters a value in the Border Cross Time
field is incorrectly alerted by the system that the entered time is not within
the arrival and departure times. This is happening because, under Swedish
configuration, the border crossing time is based not on the departure location,
but on the arrival location.
Resolution: The code is modified to reword the text for the error message
that is displayed. The update text now reads:
"Border crossing cannot be later than arrival or earlier than departure. Please
enter the date and time based on the local time at <Domestic City Name>."
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Case ID

Case/Defect Description

101027000131

Product/Feature: Expense/Travel Allowance
Description: When creating a single day itinerary with two itinerary legs, the
border crossing time value for the return leg is incorrectly defaulting to the
depart time from the first leg of the itinerary. This is causing the following
error message to display:
"Border crossing cannot be later than arrival or earlier than departure. Please
enter the date and time based on the local time at your departure location."
Resolution: The code is modified to now use the time of departure from the
second itinerary leg as the border crossing time for the return leg instead of
using the value of the departure time of the first itinerary leg.

101116000002

Product/Feature: Expense/Travel Allowance
Description: The system stops responding after changing the name of an
existing TA itinerary and clicking Save.
Resolution: The code is modified to revise the isValidTime() function to
properly handle undefined departure and arrival time values.

101116000362
101201001173

Product/Feature: Expense/Value Added Tax (VAT)
Description: An Unexpected Software Error (UE) is generated when
attempting to add an expense type to one group from a different group in the
same tax authority that has a start date in the past and an end date in the
future. The expense type in fact should not be available in the Available list
and should be in the Unavailable list.
Resolution: The code is modified to fix the start and end date checks in the
respective lists of the Available and Unavailable lists, and to perform a final
check when saving a group.

101117000859

Product/Feature: Expense/Company Car
Description: The cached odometer reading for a company car is not correctly
updated when that company car is included in an expense report that is
subsequently deleted - the incorrect odometer reading remains until Expense
is restarted.
Resolution: The code is modified to now null out the cached CarConfig
storage for the employee when the report is deleted. Doing this forces a
request the next time the report is opened.

101124000000

Product/Feature: Expense/Travel Allowance
Description: The allocation copy-down action is not happening on the Fixed
Meals expense type in Travel Allowance.
Resolution: The code is modified to now support Entry as a source field.

101124000785

Product/Feature: Expense/Attendees
Description: The Deactivate button does not deactivate attendee types
selected by the user if the chose attendee types have been added to Attendee
groups by a user.
Resolution: The code is modified to update the stored procedure responsible
for removing attendees from attendee groups.
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Case ID

Case/Defect Description

101201000013

Product/Feature: Expense/Localization
Description: The Yes, No, OK, and Cancel buttons that appear on the
standard dialog boxes are not appearing in the user's language.
Resolution: The code is modified to now apply the buttonText localizations
within the extHacks Ext.MessageBox class definition itself.

101201000810

Product/Feature: Expense/User Interface
Description: Alphabetical ordering is not applied to the Currency dropdown
list in the user interface. Instead, the ordering is according to the sequence in
which they were loaded.
Resolution: The code is modified to now add order by clause to
CE_LISTS_GetCurrences.

101207000223

Product/Feature: Expense/Value Added Tax (VAT)

101214001903

Resolution: More information about the update to this feature is available in
the Expense section of this document.

Description: Client request to refactor Value Added Tax.

101202000179
101208000414

Product/Feature: Expense/Cognos Roles
Description: Groups that have been deleted are incorrectly appearing when
assigning Cognos roles.
Resolution: The code is modified to no longer return deleted list items even if
the hierarchy nodes exist.

101216000043

Product/Feature: Expense/Expense Reports
Description: When recalling an expense report, the Delete button that
should be available to delete an expense line item entry is incorrectly grayed
out and unavailable to the user.
Resolution: The code is modified to now clear the last remembered state of
the button when the expense report is reloaded.

101220000140

Product/Feature: Expense/Processor
Description: Inaccurate results are returned when using Processor query
expressions that include date fields. For example, Processor Start Date >
Before > 12/24/2010.
Resolution: The code is modified to prevent a conflict between the
TIME_BEFORE and TIME_AFTER operators that were occupying the same
keyspace as BEFORE and AFTER of the SQL query. This fixes the problem of
the where clause in the SQL query expression not casting date strings as a
timestamp.

110104000391

Product/Feature: Expense/Tax Authorities
Description: Tax authorities configured for the client do not appear in the
Tax Authorities list.
Resolution: The code is modified to now call the stored procedure directly
when fetching tax authorities for the GetTaxAuthoritiy list. Also improved
execution time and over all performance by adding a nolock statement.
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Section 14:

Resolved Issues - Invoice

Case ID

Case/Defect Description

101221000934

Product/Feature: Invoice/Custom List Views
Description: The Description field was incorrectly missing as an available
custom column in the View My Requests, Assign Requests, and Approve
Requests pages.
Resolution: The code is modified to add this field to the pages listed above.
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Section 15:

Resolved Issues - Jobs

Case ID

Case/Defect Description

101220000097

Product/Feature: Jobs/Credit Card
Description: Import of US Bank credit card feed may provide incorrect
warnings about an inability to assign card accounts.
Resolution: The code was modified to correctly handle the occurrence of the
Employee ID in multiple fields.

101222000611
101220000787
101229000771
101129000001

Product/Feature: Jobs/User Import
Description: Import of new users fails using User Import if there is a circular
reference for the specified BI Manager.
Resolution: The code was modified to no longer perform the check for the
circular reference when a user record is first created.
Product/Feature: Jobs/Credit Card Import
Description: Citibank Cash Advance Fee may be hidden upon import.
Resolution: Modified the MasterCard CDF 3.0 importer to recognize the
charge as a type of Cash and Check Fee and make it available to the
employee as required by the card configuration.

101214001710

Product/Feature: Jobs/Credit Card Import
Description: The MasterCard CDF 3.0 and VISA VCF 4.0 importers do not
properly handle transactions with multiple types of addenda data. In select
cases, purchase addenda data is provided in addition to the more relevant
travel, hotel, or car rental detail.
Resolution: Modified the MasterCard CDF 3.0 and VISA VCF 4.0 importers to
place a priority on travel, hotel, and car rental data over purchase data.

101102000637

Product/Feature: Jobs/Credit Card Import
Description: JP Morgan Chase reversal of a Rush Card Fee may be hidden
upon import.
Resolution: Modified the MasterCard CDF 3.0 importer to recognize the
reversal charge as a type of Other Bank Charges and make it available to the
employee as required by the card configuration.

101103000096

Product/Feature: Jobs/Credit Card Import
Description: BCC card feed imports sometimes display the error message
The length of the record does not match the specification.
Resolution: Modified the Concur Enhanced importer to pad out records that
are not the proper length so that the error is not displayed.

101102000240

Product/Feature: Jobs/Employee Import
Description: Unique key constraint may occur when attempting to import
delegate detail when there are multiple delegate configurations in place.
Resolution: Modified the delegate importer to include the product code when
determining if a delegate record is unique.
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Case ID

Case/Defect Description

100916000436

Product/Feature: Jobs/Credit Card Import
Description: Legacy AirPlus ATX Plus feed import may result in a
NullPointerException when attempting to import a hotel charge.
Resolution: Modified the importer to correctly identify the transaction ID of
the hotel charge so that it will import correctly.

100414000433

Product/Feature: Jobs/Credit Card Import
Description: ATM withdrawal transactions are not imported if the employee
doesn’t have a cash advance code.
Resolution: Modified the importer to import the ATM withdrawal but hide it
from the employee until a cash advance code is provided.
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Section 16:

Known Issues - Invoice

Case ID

Case/Defect Description

091209000752

Product/Feature: Invoice/Workflow
Description: Workflow steps configured so that the Vendor Approval step
precedes the Cost Object Approval (COA) step are not supported.
Workaround: The client should configure Workflow so that the Vendor
Approval step never precedes the Cost Object Approval (COA) workflow step.
Instead, the Vendor Approval step should follow the COA step.
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Legal Notice
This document contains proprietary information and data that is the exclusive
property of Concur Technologies, Inc., Redmond, Washington. No part of this
document may be reproduced, transmitted, stored in a retrievable system,
translated into any language, or otherwise used in any form or by any means,
electronic or mechanical, for any purpose, without the prior written consent of
Concur Technologies, Inc.
Information contained in this document applies to the following products in effect at
the time of this document's publication:

Travel & Expense, January 2011

The above product(s) and information contained in this document are subject to
change without notice. Accordingly, Concur Technologies, Inc. disclaims any
warranties, express or implied, with respect to the information contained in this
document, and assumes no liability for damages incurred directly or indirectly from
any error, omission, or discrepancy between the above product(s) and the
information contained in this document.
© 2004 – 2011 Concur Technologies, Inc., Redmond, Washington. All rights
reserved.
Concur® is the trademark of Concur Technologies, Inc. All other company and
product names are the property of their respective owners.
Published by Concur Technologies, Inc.
18400 NE Union Hill Road
Redmond, Washington 98052
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Release Notes – February 2011
Section 1: Please Note the Following Alerts
Administration Functions at Parity to be Retired from Classic UI
Retired With the February Release
Beginning with the February release (February 25, 2011), functions listed below are
at parity in the current UI and will be retired from the classic UI:

PROXY
•

Expense - now available in the current interface

POLICIES
•

Expense - now available in the current interface
Note: The classic Policies link will not be hidden (this month) for clients
using Authorization Requests.

WORKFLOWS
•

Expense - now available in the current interface

EMPLOYEE FORMS & FIELDS
•

Expense - now available in the current interface

Retired With the March Release
Beginning with the March release (March 18, 2011), functions at parity in the current
UI (listed below) will be retired from the classic UI.

GROUP CONFIGURATIONS FOR EMPLOYEES
•

Expense Configuration Admin & Shared Configuration Admin in Expense - now
available in the current interface
NOTE: Invoice-only clients - available via Shared Configuration Admin in
classic interface (that is, no changes for the Invoice client)

TRAVEL ALLOWANCE
•

Expense - now available in the current interface

Retired With the April Release
Beginning with the April release (April 15, 2011), functions at parity in the current UI
(listed below) will be retired from the classic UI.
Release Notes
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CAR CONFIGURATION
•

Expense Configuration Admin - now available in the current interface

EXPENSE COMPANY CARD ADMINISTRATOR
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•

Manage Cards - now available in the current interface

•

Assign Cards - now available in the current interface

•

Diversion and Lodge Accounts - now available in the current interface

•

Settings - now available in the current interface

•

Manage Transactions - now available in the current interface

•

View Import Logs - now available in the current interface
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Section 2: Enhancements From Client Suggestions Forum
The following features were submitted using Concur's Suggestion service, available
via Concur's forums. They are now included in this service release.
•

Localization of the Receipt Types
The Tax receipt, Receipt, and No receipt strings that appear in the Receipt
Status dropdown can now be localized by import.

•

Bank Account Number Field No Longer Forces Data Entry
The Bank Account Number field will no longer cause the user to have to reenter the bank account number if any field other than this field is changed on
the form.

•

Intelligent Capture: Capture the Purchase Order (PO) Field:
A new field in the Verify page allows Intelligent Capture to capture the "PO"
number data in order to include that number in the payment request import
(during the export process).

•

Payment Manager can Place Request on Hold
The Payment Manager can now place a payment request in a holding state
pending review, temporarily removing the request from the payment cycle.

•

Recall of Request by the Invoice Owner
An invoice owner can now send a request back to themselves by recalling it.

•

Ability to Import Preferred Payment Method Via Vendor Import
A new version 3 vendor import allows the client to include the default method
of payment in the imported data, thus indicating the preferred method to use
whenever the vendor-level pay method is not specified.

•

Place a Request into an Under Review Status
A Processor can put a request into Review In Progress status, when a request
requires additional research. This does not change workflow, but is a helpful
indicator for a Processor to manage their task queue and coordinate with
other Processor users.

•

Processor & AP User Can Restore a Deleted Request
The Processor and AP User can now search on and reactivate deleted
requests.
Each of the features in this section is described in brief here, and in more
detail in their respective sections within this document - if you need additional
information please refer to these sections.
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Section 3: Expense
The following features are included in this service release.

Authorized Approver Permissions and Cost Object Approver
Permissions in the Current User Interface
Authorized Approver Permissions
There are two ways to assign the proper
authorized approver permissions in User
Admin, depending on the company's
configuration.

Business Purpose
This enhancement moves an expense
administrative function to the current
user interface.

Permissions are set on the User Detail
page (Administration > Company Admin > User Administration).

GLOBAL GROUP ONLY
If the Authorized Approver feature is activated and the company has only one group
(Global), then the Authorized Approver check box appears in the Expense and
Invoices Setting section in User Administration.

NOTE: In order to see the check box described here, the user must have the User
Admin rights and the Expense Admin rights.
NOTE: This method can be used only for limit-based authorized approvers. It cannot
be used for exception-based authorized approvers.
When the administrator selects the check box, the Manager Approval Limit field
and the Approval Limit Currency list appear. The administrator makes the
appropriate choices and clicks Save.
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AUTHORIZED APPROVER FEATURE HIERARCHY
If the Authorized Approver feature is activated and the company's Authorized
Approver hierarchy has at least one level (in addition to Global), then the
Authorized Approval Limits link appears in the Expense and Invoices Setting
section in User Administration.

NOTE: In order to see the link described here, the user must have the User Admin
rights and the Expense Admin rights.
The administrator clicks the link. The Authorized Approval Limits window appears.

On the left side, the administrator selects the appropriate level in the hierarchy.
On the right side:
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•

For exception-based approvers, the administrator selects the Can approve
exception check box. (The actual exception levels are defined on the
Authorized Approvers tab in Workflows.)

•

For limit-based approvers, the administrator selects the desired currency and
enters the amount.
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•

If an approver has both types of approval authority, the administrator defines
both.

Cost Object Approver Permissions
If the Cost Object Approver feature is activated, then the Authorized Approval
Limits link appears in the Expense and Invoices Setting section in User
Administration.

NOTE: In order to see the link described here, the user must have the User Admin
rights and the Expense Admin rights.
The administrator clicks the link. The Authorized Approval Limits window appears.

On the left side, the administrator selects the appropriate level in the hierarchy.
On the right side:
•

For limit-based cost object approval, the administrator selects a currency and
enters an amount.

•

For level-based cost object approval, the administrator enters a level.

NOTE: The cost object configuration defines the type – either limit or level. If you
complete both areas in this window – the Approval Limit area and the Level field –
Expense will use the one that applies to your configuration and ignore the other.
Release Notes
February 2011
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Configuration
Clients who can normally access User Administration can assign these permissions.
If the client wished to use the authorized approver feature or the cost object
approval feature, the client contacts Concur Client Support. If the client already uses
either of these features but wishes to make changes, the client contacts Concur
Client Support.

Retain Attendee History with the Associated Expense Entry
Overview
Currently, historical attendee
information is not captured; only the
current attendee information (master
record) is available. With this release,
the point-in-time attendee information
can be saved with the associated
expense entry.

Business Purpose
This enhancement provides a benefit
for Concur clients who must retain
historical attendee information.

Attendee information (such as name or title) can change over time. With this
feature, once the attendee is attached to an expense entry, that attendee
information is stored and not allowed to be changed when the master record
changes.

Configuration
If the client wants to use this feature, the client contacts Concur Client Support.

Configurable Attendee Information
Overview
Currently, the default attendee
information includes the attendee name,
type, company, and title. With this new
feature, the administrator can customize
the most common attendee grids.
The administrator can:

Release Notes
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•

Remove existing columns
(cannot remove Attendee Type)

•

Add any of these columns:
♦

First Name

♦

Last Name

♦

Custom 1-20
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♦

Total Amount Previous Year

♦

Total Amount YTD

Once the new "view" configuration is created, it is implemented by assigning it to
one or more Expense groups.

EXAMPLE
For example, by default, the Attendees section of the Expense (or New Expense)
tab contains the Attendee Name, Attendee Title, Company, and Attendee Type
columns. (Visibility of the Amount column is configurable.)

Assume that you work in the pharmaceutical industry and it is important to also
know the state in which the attendee (doctor) practices. In this case, a custom field
has already been renamed State and has been added to the attendee form. With
this new feature, you can easily add that same field to this display.

AFFECTED PAGES
This change affects the most common attendee grids, so when the administrator
adds or removes a column, the change appears in these places:
•

Attendees section of the Expense (or New Expense) tab (shown above)

•

Search Attendees window:
♦

Release Notes
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Accessed by clicking Search in the Attendees section of the Expense (or
New Expense) tab
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♦

•

Expense list attendee summary tool tip:
♦

•

Release Notes
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Includes all four tabs: Search Attendees, Favorites, Recently Used,
and Attendee Groups

Accessed by hovering the attendee

icon in the expense list

Favorite attendees in profile:
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♦

Accessed by selecting Profile > Favorite Attendees

♦

Includes both tabs: Attendees and Attendee Groups

Configuration
The client contacts Concur Client Support for changes. The client should be prepared
with this information:
•

Fields to be added to or removed from the view

•

Sequence of the fields

•

Affected Expense group(s)

! IMPORTANT: Be aware that by adding several columns you are increasing the

possibility that users will have to scroll horizontally to see all of the information.
Please consider the impact on users when adding columns.

Confirmation Agreements Moved to the Current User Interface
Configuration of confirmation
agreements is now available via
Administration > Expense Admin >
Workflows.
For more information, refer to
the Expense: Workflow – General
Information Setup Guide.
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Workflow Email Notification are now Available in Workflow
Since the workflow email notifications
are so closely related to workflows, they
have been moved into the Workflows
section in the current user interface.

Business Purpose
This enhancement moves this
administrative function to the proper
menu option.

Configuration of workflow email
notifications is now available via
Administration > Expense Admin > Workflows.

For more information, refer to the Expense: Workflow Email Notifications
Setup Guide.

Tax & Reclaim Group Changes
Overview
Last month, tax & reclaim groups (Tax
Administration) were enhanced so that
Expense automatically creates a new
group – resulting in a current group and
a historical group – if the administrator:

Release Notes
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Business Purpose
This enhancement ensures the proper
management of tax & reclaim groups

•

Changes the effective date of an existing group

•

Adds an expense type to an existing group
– or –

•

Removes an expense type from an existing group
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This month, we are providing another option that allows the administrator to make
the changes listed above but Expense will not create a historical group. The changes
are simply made to the existing group.

Configuration
Clients contact Concur Client Support in order to make changes to tax & reclaim
groups. Clients now also indicate whether they want one resulting group or two
(current and historical).

Configure Extracts: New Special Character Handling Field
When configuring extracts, the Integration administrator can now specify how to
handle delimiting and enclosing characters in the extract file that might otherwise
cause parsing difficulties of rows containing special characters.
The new field, Special Character Handling, has three options that work as
described below:
•

Normal (default): Existing functionality, which is to escape and enclose
fields only if they contain the specified delimiter character.

•

Remove: Prior to output, all delimiter or enclosing characters are stripped
from the file.

•

Escape and Enclose: If the field contains either the delimiter or enclosing
characters then the field is escaped and enclosed.

Configuration
To configure this feature, the Integration administrator includes one of the selections
above when adding and configuring the extract using the Add Extract functionality.
Or, when editing an existing extract, clicking Edit under Output Files. In both
cases, the new field appears under Field Attribute Defaults as shown in the figure
below:

Edit Travel Allowance Rates
Overview
Prior to this release, the only way Travel
Allowance rates could be changed is via
the Travel Allowance import. With this
release, rates can be edited in the user
interface.
When the administrator makes changes
to the Travel Allowance rates:
•

Release Notes
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Business Purpose
This enhancement provides a benefit
for all Concur Expense clients who use
travel allowances. Administrators can
now easily view full details of a rate
record, and modify the rate amounts to
correct errors.

The new rates go into effect
immediately after the administrator clicks Save.
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•

The new rates apply to all unsubmitted reports.

•

Rates on reports submitted before the update are not changed.

•

If a user resubmits a returned report after the update, the new rates are
used.

Required Roles
All users with the proper permission to access this area may view rates. Those with
the unrestricted Expense Configuration Administrator role assigned at the global
level will also be able to edit the rate amounts.

Configuration

 To access the rates:
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1.

Select Administration > Expense Admin > Travel Allowance.

2.

Select the Rates tab.

3.

Select the desired rate feed, country, etc.

4.

Select Search. The rates appear.
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 To edit rates:
1.

Once you have located the desired rate, either:
♦

Select the desired rate and click Modify.
– or –

♦

Double-click the desired rate.

The Modify Travel Allowance Rate window appears.

Release Notes
February 2011

Page 16

Concur Travel & Expense
Client-Facing

Release Notes
February 2011

Page 17

Concur Travel & Expense
Client-Facing

2.

Enter the appropriate information.
Field

Description

Rate Feed, Rate Location Name,
Administrative Region,
Subdivision, Country, Effective
Date, End Date, Season Start,
Rate Type

These fields cannot be edited.

Rates: Meals, Lodging,
Overnight, Incidentals, custom
fields

These are the imported rates from the feed for
meals, etc.

Deductions: Breakfast. Lunch,
Dinner

These are the amounts that are deducted from
the rates (above) if the user indicates that
these meals were provided.

Edit these fields as needed.

Edit these fields are needed.
Benefits in Kind: Breakfast,
Lunch Dinner

These are the amounts that are deducted from
the rates (above) if the user indicates that
these meals were taxable.
Edit these fields as needed.

3.

Release Notes
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Click Save.

Page 18

Concur Travel & Expense
Client-Facing

Localization of the Receipt Types
In this release, these receipt-related
strings can be localized by the client:
•

Tax receipt

•

Receipt

•

No receipt

Business Purpose
This enhancement allows clients to
localize more strings - allowing options
presented to the user to match
company or local terms.

These are the options that appear in the
Receipt Status dropdown on the
Expense (or New Expense) tab on the expense report:

Release Notes
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Configuration
In Administration > Expense Admin > Localization, these strings are under the
category named Receipt Types.
In the localization import file, these strings are:
•

40.CT_RECEIPT_TYPE_LANG.LABEL.RECEIPT_TYPE.'T'=Tax Receipt

•

40.CT_RECEIPT_TYPE_LANG.LABEL.RECEIPT_TYPE.'R'=Receipt

•

40.CT_RECEIPT_TYPE_LANG.LABEL.RECEIPT_TYPE.'N'=No Receipt

For information about localization, refer to the Shared: Localization Setup Guide.

Release Notes
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Section 4: Invoice
The following features are included in this service release.

Payment Manager: Banking Notice Of Change (NOC) List
Overview
A list of all Notice of Change (NOC)
messages received from supplier banks
will now be displayed in Payment
Manager. Clients are advised, but not
directed, to use this information to
update their Vendor Master List.

Business Purpose
This enhancement adds an additional
level of information that helps the
manager retain current account data.

What The User Sees
A new page, Notice of Change List, is included in the Payment Manager module of
Invoice:

The Payment Manager uses this page to view bank-generated notices alerting to
changes in a supplier's account information. The Payment Manager then updates this
information in Invoice and in their Vendor Master List residing in the client financial
system.
Taking Action on Supplier Bank Account Information Changes

Release Notes
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This feature is intended to alert the client to changes in the supplier's bank account
information. Since there is the possibility of repeated NOCs causing refusal of
payment it is best practice to reference this page and use the Acknowledge button
or command from the Actions menu to dismiss the NOC after acting on the
information.

When you do so, the Please Confirm dialog box appears asking that you confirm
the deletion of the notice of change:

Click Yes to dismiss the dialog box and remove the notice of change row(s) from the
page.

! The system displays but does not automatically update the client banking account
information in Invoice or the Master Vendor List in the client ERP - these tasks
are the sole responsibility of the client.
Refer to the Invoice: Invoice Pay Setup Guide for more information.

Configuration
No additional configuration is required to use this feature.

Payment Manager: Place a Hold on a Payment Demand or Request
Overview
Clients who wish to temporarily hold
payment on an unsent demand or
request can now do so using options in
the Monitor Payments page. This
feature is used whenever a payment
Release Notes
February 2011
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must be reviewed due to (as examples) damaged goods or adjustments that must be
made to the final amount. Once rectified, the Payment Manager can then release the
hold and the payment is placed into the next logical payment cycle.
Placing the Demand or Request on Hold
When the Payment Manager identifies a problem with a payment demand or
payment request, they search for and select the payment to hold using the Put
Payment On Hold command on the Actions menu:

The system removes the marked item from the payment cycle by placing it into an
On Hold batch, marking the item with a status of On Hold, and removing the now
redundant close and send dates from display:

Options for Handling the On Hold Demand or Request
When the demand or request is on hold the client can elect to pay using the Client
Pay payment method available from the Actions menu. This removes it from the
payment cycle, allowing the client to issue a check from the back office stock for
payment. The client can also decide to change the funding and payment dates, but in
doing so, the payment is automatically activated and placed into the next logical
payment batch.
Removing a Demand or Request From the On Hold Status
A demand or request is removed from hold status by either applying new funding or
payment dates as described above, or by using the Actions menu command as
described below. In either scenario the payment is placed into the next logical
payment batch based on the due date and method of payment.
Release Notes
February 2011
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To remove the payment from the On Hold status, the Payment Manager first
searches using the On Hold criteria for a given Funding Account value (note that
Search close and send date criteria are unavailable for an On Hold search):

The payment is selected and the Release Payment command on the Actions menu is
used to remove the payment from the On Hold batch:

The payment is then reactivated and removed from the On Hold payment batch.
Please note the following when using this feature:
•

Only a payment with an Unsent or Failed status can be placed on hold

•

Payments on hold are included in the not processed amounts totals on the
Extract Reconciliation page
Refer to the Invoice: Invoice Pay User Guide for more information.

Configuration
No additional configuration is required to use this feature.

Release Notes
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Payment Manager: Visible Pending Counts
Overview
Business Purpose
If one or more records exist on a page
the total number of these records is
This enhancement alerts the manager
now displayed next to the page name in
to pending work using a simple and
the leftside menu. This feature is
low-key indicator in the user interface.
intended to alert the Payment Manager
to pending work included as a row within each page without need to open the page
itself. This visual cue alerts the manager to pending work and allows them to assess
the total workload contained within each page at a glance.
Pages that include these numbers are the Requests Requiring Action, Failed
Payments, and Notices of Change as shown in the figure below:

Configuration
No additional configuration is required to use this feature.

Invoice Owner Can Recall a Payment Request
Overview
Business Purpose
A payment request submitted in error
or with mistakes can now be recalled by
This enhancement allows the invoice
the Invoice Owner, their Proxy, or their
owner to recall their submission for
Delegate with Submit rights. This allows
mistakes or rectification of data.
the owner to resubmit the request at a
later date, after issues with the request are resolved.
Release Notes
February 2011
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What The User Sees
The Recall feature works by allowing a submitted request that is not pending final
approval to be recalled using options in the Payment Request List page. The user
performs a search using date criteria, selects the request(s), and clicks the Recall
Request command from the Actions menu to move the request back into
Unsubmitted status.

When recalling a request the name of the user is included in the audit trail associated
with the request.
Please note the following about this feature:
•

This action can be performed multiple times on a single request.

•

A request cannot be recalled if workflow is skipped.

•

Recall is compatible with Cost Object Approval workflow.

Configuration
To activate this feature, contact Concur Client Services or your Invoice administrator
to submit a service request.

Processor and AP User Can Restore a Deleted Payment Request
Overview
If a payment request is deleted by
mistake it can now be restored by users
with the Processor or AP User role to
active status, assigned to the original
invoice owner.

Business Purpose
This enhancement allows requests
mistakenly deleted to be restored to
active status.

What The User Sees

Release Notes
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To restore a deleted payment request, the Processor or AP User first performs a
search using date ranges available from the View menu on the Deleted Requests
page or the Search functionality. They can then choose to select one or more
requests for restoration in the rows that display. Once selected, the Restore
Request button or command on the Actions menu is used to move the request
back to active status.

When restoring a request, a comment is required that is entered into the request's
audit trail, which also records the date and the user associated with the event. The
request is then available for action in the original invoice owner's queue.
Refer to the Invoice: Invoice Processor User Guide and the Invoice: Invoice
AP User Guide for more information.

Configuration
No additional configuration is required to use this feature.

Request Description Information Displays in Request Row
Overview
The View My Requests and Approve
Requests pages will now display the
request description in the display row if
the Description field is added to the
Payment form. This feature is useful
whenever a client wishes to use descriptive

Business Purpose
This enhancement provides additional
information to the client about the
request they are viewing.
text to identify a request in the list.

What The User Sees
When the user opens their View My Requests page, or the Approver the Approve
Requests page, the descriptive text entered when the request was created is
displayed:

Release Notes
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Configuration
The Payment Configuration administrator will need to access Forms in the classic
user interface in order to add the Description field to the Payment Header form.

Processor Can Now Place a Payment Request Under Review
Overview
The Invoice Processor can now place a
visible Review In Progress status on one
or more payment requests pending
their approval. Doing this does not
prevent another processor from moving
the request through workflow - it simply
alerts other processors that the request is

Business Purpose
This enhancement provides an easy
way for one processor to work with
others over request issues without
need for direct contact.
under review.

Placing the Review Status on a Request
When the Invoice Processor opens their request list and identifies a request for
review status, they select the request and apply the status using the Review
Required command on the Actions menu:

Release Notes
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The Place Request Into Processor Review dialog box appears, where the
processor includes comments explaining the review status action:

Now, all processors are alerted that a processor, called out by name in the row, has
placed a Review In Progress status on the request. If the viewer hovers over the
icon, they can view the entire comment section explaining the review status:
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When the request is put into review, an audit trail entry is created that includes the
comment text as well as the user and date of status change. If another processor
decides to move the request forward in workflow, the status is removed from the
request and the processor is asked to comment on why the action precipitating the
removal was taken. This is added to the audit trail, along with user name and date.
Searching For a Request in the Review In Progress State
Two new queries are added to the Query menu to allow the processor to find either
specific requests they have put under review, or all requests currently under review:

Removing a Request from the Review In Progress State
A request in review is removed from this status by either using a command to do so,
or by moving the request forward in workflow. Either action requires that a comment
be provided for the action and this is added to the audit trail records, plus the user
name and date.
When using the Actions menu, the processor removes a request from review using
the Remove From Review command:
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Refer to the Invoice: Invoice Processor User Guide for more information.

Configuration
No additional configuration is required to use this feature.

Invoice Capture: Capture Purchase Order Number From Paper Invoice
Overview
Business Purpose
The Purchase Order (PO) number of a
paper invoice can now be detected and
This enhancement brings a highly
assigned through Capture export to the
requested feature to Invoice Capture.
Request PO Number field of the
Payment Request import. Doing this
saves the user from having to manually record this number - the system does this
automatically.
How It Works
This feature works by enabling Capture to detect the purchase order number it finds
next to variations on the Purchase Order # field on the paper invoice. It will then
automatically capture the detected numeric value and use this value to populate a
new PO Number field on the Verify panel.

Release Notes
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During the extract step this number then populates the Request PO Number field
in the 300-level record of the Payment Request import.

If no number is detected the user can either fingerprint a value in the invoice image
in Capture or manually hand enter it. With Intelligent Capture, errors or omissions
can be corrected and the process fine-tuned to return greater success rates.

Configuration
The Intelligent Capture operator will need to manually direct Capture to fingerprint a
new vendor's invoice for the value found beside Purchase Order #. There may be
some minimal learning of character patterns that transfers across vendors,
increasing initial recognition rates. However, clients should be prepared to manually
direct the application for new vendor invoices if the system does not auto-populate
the PO Number field with the first encounter of the new vendor.

Release Notes
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Invoice Capture: Client Can Opt Out of Invoice Owner Capture
Overview
Business Purpose
In January 2011 a feature allowing the
Invoice Capture user to capture and
This enhancement adds flexibility for
route an invoice directly to the invoice
the client to decide how they want to
owner was introduced. With this
use Invoice Capture.
feature, the system captures a variant
of the Attention field on the paper invoice to identify the invoice owner, automatically
assigning the invoice to the owner when a match is found.
With this release, this feature can now be disabled. That is, the client can decide to
turn this feature off if, as an example, the Attention field value is outdated or
otherwise unreliable for correct assignment of ownership.
Refer to the January 2011 Release Notes for more information.

Configuration
The feature is activated or deactivated using the Enable Invoice Owner Capture
check box on the Administrator tab as shown in the figure below:

The default setting is selected, meaning the feature is enabled. Clearing the check
box disables the feature.

Invoice Capture: ICMonitor Role Added
Overview
A new Invoice Capture role, ICMonitor, is now added to Capture. This role is
responsible for monitoring Capture, and is a role that will be hidden from other
users, including those with User Admin privileges. This means no other user can
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assign or unassign the role and it will never appear in the Administrator > Users
page.

Configuration
The role is assigned or unassigned by accessing the Administrators > Users page.
After adding this user type, the added user will no longer display in the user
interface. To remove this user type, access the Taskmaster database TMUSER table
directly and remove the user from this table.

Approved Vendor Import Version 3 (V3) Now Available
Overview
A new version of the Approved Vendor
Import is now available. The primary
difference between this version and the
earlier versions is the addition of the
100-level Pay Method Type field.

Business Purpose
This enhancement brings additional
flexibility in handling payment methods
for a supplier in Invoice.

NOTE: This change does not apply to the on demand import available in Invoice this change applies only to the OverNight Processing (ONP) type import.
The field appears in the specification like so:

This field is intended to complement the 200-level Pay Method Type field by
allowing the user who does not specify a payment method at the 200 level to specify
a default payment method at the 100 level or rely on the system default of Client
Pay (CLIENT) if no payment method value whatsoever is provided in the import.
Sequence Used to Determine the Payment Method
The vendor importer will now attempt to apply a payment method of either ACH,
CHECK, or CLIENT for a supplier in the following sequence:
The value in the 200-level Pay Method
- if no value is specified, refer to and use: The value in the 100-level Pay Method Type
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- if no value is specified, use system default of: Client Pay method
Examples:
200-level Value

100-level Value

System Will Use This Value:

ACH

CHECK

ACH
The 200-level value takes precedence.

<none>

CHECK

CHECK
No value at 200-level; use 100-level
value instead if found.

<none>

<none>

CLIENT
No value at either 200 or 100-level; use
system default of Client Pay (CLIENT).

Refer to the Chapter 4: Approved Vendor Import - Invoice V3 (Current) for
more information.

Configuration
Clients are advised to work with their Invoice administrator or contact Concur Client
Services directly for configuration.

Payment Request Import Now Imports 410 Custom Line Item Fields
Overview
Business Purpose
The Payment Request import job will
now process and store values from the
This enhancement provides additional
410-level 1 - 20 Custom fields. These
flexibility when importing payment
fields will be validated using the custom
request data to Invoice.
field definitions in the default Request
Line Item form, including data types that can include lists and connected lists.
Refer to Chapter 8: Payment Request Import of the Invoice - Import and
Extract File Specifications for more information.

Configuration
No additional configuration is required to use this feature.
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Section 5: Expense Pay
Payment Manager: Reconfirm Funding Account Functionality Added
Overview
Business Purpose
The ability to reconfirm funding
accounts has been ported to Payment
This enhancement closes a feature gap
Manager. Clients with Euro funding
with the classic user interface.
accounts can only use Payment
Manager, so this enhancement grants them the ability to reconfirm funding accounts.

Configuration
No additional configuration is required to use this feature.

Support for Card Payments to Multiple Countries on a Single Card Feed
Overview
Business Purpose
Expense Pay has been enhanced to
support card payments to multiple
This enhancement makes card
countries on a single Global card feed
payments in the Eurozone easier and
where the posting or billing currency is
more economical to manage.
the same among two or more countries.
The enhanced functionality considers both the posting currency and the country of
origin of each card transaction when creating payment demands. This allows clients
to use a single card feed for all countries in the Eurozone without having to pay their
banks to split the feed into countries.

Configuration
No additional configuration is required to use this feature.
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Section 6: Analysis and Intelligence
The following features are included in this service release.

Analysis/Intelligence – Report Updates
Many of the existing Standard Reports have had some usability updates made to
them in the February Release. The impacted reports are:
•

Audit Statistics Details – Expense Audit Required field has been added to
this report.

•

Audit Exception Details – Expense Audit Required field has been added to
this report.

•

Expense Accrual – This report had a new date prompt added. Users can run
this report either by Transaction Date or use the existing “year to date”
functionality. On the results screen, a new column Posted Date has been
added.

New Standard Report: Hotel Receipt Additional Spend Summary
Travel Managers will use this report for three distinct purposes. First, they can use
this to see whether or not their employees are being compliant with hotel policy. If
employees are not supposed to be reimbursed for movies, but there is 1000.00 a
month being spent on them, there is a problem. This report will also provide Travel
Managers with insight on Vendor compliance. If a company has negotiated a
discount/waiver for parking, yet are being consistently charged for it, they can
quickly take action. Last, they can look at the information by city to see trends on
additional fees to assist in negotiation planning. This report is available at:
Intelligence – Standard Reports > e-Receipt or Analysis – Standard Reports
> e-Receipt
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HOTEL RECEIPT ADDITIONAL SPEND SUMMARY: REPORT PROMPTS

HOTEL RECEIPT ADDITIONAL SPEND SUMMARY: REPORT OUTPUT

New Standard Report: Expense Audit Required
This report will show the “Audit Required” status of an employee. This will give
administrators better insight and visibility into their Audit configuration. This report is
available at:
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Intelligence – Standard Reports > Audit or Analysis – Standard Reports >
Audit

EXPENSE AUDIT REQUIRED: REPORT OUTPUT

Intelligence – Custom Bursting
CUSTOM BURSTING - OVERVIEW
In the January release, we are introducing the new feature: Custom Bursting. About
a year and a half ago, Concur introduced Bursting to our Intelligence offering.
However, it was a limited implementation. Clients were only able to burst off their
Reporting Hierarchy or their BI Manager relationships. Based on client feedback, it
was determined that this limited offering was not meeting the needs of all our users.
Clients also wish to burst reports based on Cost Center, Divisions, etc. In order to
fulfill this requirement, we need to create a mechanism that allows clients to define
the relationship between the recipient and the data they looking for. Once this
relationship has been defined (essentially creating a custom bursting table) in Concur
Travel & Expense, we will move that data into the Reporting database, where report
writers will be able to burst out reports based on the user defined relationships.
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CUSTOM BURSTING – EMPLOYEE IMPORT CHANGES
In order to utilize this feature, the Employee Import definition file has been updated
with two new record types:
Record Type 1000 – This record type adds a new record to the custom bursting
table of the transactional database. In order to successfully utilize this record, there
are ten required fields:
•

Emp ID – The Employee ID of the user that will receive the bursted report
(JSMITH, for example)

•

Bursting ID – A user defined value that groups users who receive bursted
reports (Cost Center owners, for example)

•

Bursting Value – The actual value that the report will be bursted off of (if a
user wanted to receive all data on Cost Center 1234, for example)

•

Seven Future Use Fields – Any data in these field will be ignored, but it is
required they are on the record

A sample record:
1000,JSMITH,COST_CENTER_OWNERS,1234,,,,,,,,
Record Type 1100 – This record type deletes values from the custom bursting table
of the transactional database. The same ten fields as the 1000 Record Type are
required. There are a couple delete options that are available. If
DELETE_ALL_RECORDS is specified in any of the required fields, then all records that
match the remaining values will be deleted. For example, the row below would
delete all records for employee JSMITH with the Bursting ID of
COST_CENTER_OWNERS:
1100,JSMITH,COST_CENTER_OWNERS,DELETE_ALL_RECORDS,,,,,,,,
To quickly delete all records in the custom bursting table, the following record can be
used:
1100,DELETE_ALL_RECORDS,DELETE_ALL_RECORDS,DELETE_ALL_RECORDS,,,,
,,,,
NOTE: Custom Bursting inserts or deletes will not be immediately available in the
Reporting Database. An archive must be successfully completed before this
information can be utilized.

CUSTOM BURSTING – CONCUR DATA WAREHOUSE MODEL CHANGES
Once the Custom Bursting values have been loaded into the transactional database
through the Employee Import and an archive has been successfully run, the report
writer will have the ability utilize the custom bursting data from the model. Custom
Bursting data is available under the Bursting directory of the Concur Data Warehouse
Model.
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Analysis/Concur Intelligence – Model Updates
The following fields have been added to the Concur Data Warehouse model in the
February release.

Added to:

Concur Data Warehouse > Expense > Expense Reports > Entry Information > Additional
Entry Details
Added these fields to this folder:
•

Ticket Number

•

Car Rental Days

•

Is Billable

Added to:

Concur Data Warehouse > Expense > Expense Reports > Report Heading Information >
Additional Employee Details
Added this field to this folder:

•
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Added to:

Concur Data Warehouse > Expense >Expense Reports > Report Dates and Statuses
Added these fields to this folder:
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•

Created Date/Time

•

Last Submitted Date/Time

•

First Submitted Date/Time
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Section 7: Web Services
The following features are included in this service release.

Concur Connect Developer Portal Now Available
Overview
Business Purpose
The Concur Connect Developer
Portal is now available at
This portal site allows clients and partner
www.concurconnect.com. This
developers to view detailed information about the
site provides access to the
Concur web services.
complete documentation set for
Concur web services. Once a user has registered for the site, they can view detailed
documentation about each web service:

In addition, users have access to:
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•

Service Architecture information

•

Sample Code

•

FAQs

•

Troubleshooting tips

•

Forums

•
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Configuration
A simple site registration (name and email only) must be completed in order to view
the documentation.
NOTE: This portal site replaces all previous web services documentation. All new
documentation will be published only on the portal site.

User Web Service Now Available
Overview
Business Purpose
The User web service allows
Concur clients to add and update
This enhancement allows clients to maintain user
user information in real time.
data in real time.
The functionality is similar to the
spreadsheet based User Import. The User web service provides employee form field
information, supporting clients with multiple employee forms. Once the form and
required fields have been determined, the client can add or update users by sending
the required information.
Refer to the User Web Service information on www.concurconnect.com for
more information.

Configuration
A partner application must be created and registered with Concur before the client
can use this feature.
Refer to the Managing Partner Application information on
www.concurconnect.com for more information.

Imaging Web Service Now Available
Overview
Business Purpose
The Imaging web service allows
clients to send receipt images
This web service allows clients to send or request
directly to Concur, to associate
receipt images dynamically.
with either a user or a report.
Clients can also request a receipt
image URL by supplying the image ID.
Refer to the Imaging Web Service information on www.concurconnect.com for
more information.
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Configuration
A partner application must be created and registered with Concur before the client
can use this feature.
Refer to the Managing Partner Application information on www.concurconnect.com
for more information.
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Section 8: Concur's Mobile App
Separate Release Schedule
The release for the mobile app is not on the same schedule as Travel & Expense,
Expense, and Travel. In addition, each Smartphone is handled differently, resulting
in different release dates for each Smartphone.

How It Works
When the app is ready for release, Concur submits it to the various app stores. Each
app store tests and approves the app, which takes between 3 and 10 days. When
testing is complete, the app is made available in the store.

Information Available on Concur Client Central
As information is released, it will become available to clients:
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•

On Concur Client Central by navigating to Resources > Document Library>
Concur Mobile:

•

On Concur Client Central by navigating to Resources > Release
Documentation:
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•
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Section 9: Supported Configurations
The following configurations are either supported or no longer supported with this
service release.

Upcoming Certifications
Support for Adobe 10.0
Support for Adobe Reader version 10.0 will be included in an upcoming release.

Support for Mozilla Firefox Version 4.0
Support for the Firefox browser version 4.0 under both the Mac OS X and Microsoft
Windows operating systems will be included in an upcoming release.

Support for Google Chrome Version 9.0
Support for Google Chrome version 9.0 will be included in an upcoming release.

Support for Windows 7 Under Service Pack 1
Support for Microsoft Windows 7 using Service Pack 1 will be included in an
upcoming release.

Support for Windows Internet Explorer Version 9.0
Support for Microsoft Internet Explorer version 9.0 will be included in an upcoming
release.
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Section 10:

Resolved Issues - Expense

Case ID

Case/Defect Description

100521000564

Product/Feature: Expense/List Import
Description: The List Import feature does not accept the format of an Excel
file generated from the Excel 2007 product - it should accept this format.
Resolution: The code is modified to now accept the Excel 2007 XLS format
by installation of the correct driver pack.

100729000170

Product/Feature: Expense/Travel Allowance
Description: When creating a Lodging itemization with the Travel
Allowance checkbox cleared for all the entries, the Lodging Tax itemizations
are set to a limit of zero, resulting in incorrect over limit amounts. This issue
is specific to USGSA when lodging is set to Reimbursable.
Resolution: The code is modified to now check if there are zero lodging
entries with the Travel Allowance checkbox selected for the transaction
date, then carry null values down to the lodging tax journal splitting amounts.

100818000671

Product/Feature: Expense/User Permissions
Description: Removing the Employee Admin role is not fully removing access
records, making these roles still applicable to the user.
Resolution: The code is modified to clear out admin group access rights for
all areas. Also added a cleanup script to migrate.xml to clean up orphaned
roles.

100829000012

Product/Feature: Expense/Expense Entry
Description: Expense types are grouped in such a way that it is not possible
to select them. This issue is appearing for Taiwan users using Internet
Explorer as their browser.
Resolution: The code is modified to encode in HTML those elements of
Expense Type Name and Expense Type Category that were not HTML encoded
and contained a special character.

100902000202

Product/Feature: Expense/User Permissions
Description: A user assigned the Processor role cannot have processor
access modified as is expected.
Resolution: The code is modified to allow editing of the role assignment.

100913000244

Product/Feature: Expense/Validation Rules
Description: Alphanumeric characters that should not be allowed in the
Employee Admin field are allowed even though Validations specifically exclude
this syntax type.
Resolution: The code is modified to add a validation for EmployeeID if there
is also a validation rule defined on the Employee form.

Release Notes
February 2011

Page 49

Concur Travel & Expense
Client-Facing

Case ID

Case/Defect Description

100922000001

Product/Feature: Expense/Connected List
Description: Connected lists in Expense Entry are incorrectly reset to no
value if a Most Recently User (MRU) value is chosen for the parent list in the
connected list series.
Resolution: The code is modified to now add an override to no longer set a
value at the single level MRU list item, but rather the regular list item. Before
this was causing the other list items fields to be cleared because it made it
appear that the single level MRU list item was selected by the use

100928000609

Product/Feature: Expense/Travel Allowance
Description: User of Czech travel allowance is getting the incorrect allowance
for the duration of their trip.
Resolution: The code is modified to now use minutes instead of rounded
hours when looking up the applicable time band rate.

101006000664

Product/Feature: Expense/Configuration Reports
Description: A script timeout or Out of Memory error is generated when
retrieving a configuration report that exceeds a certain size.
Resolution: The code is modified to enable Response.Buffer, flush buffer
between sections and add a progress indicator to keep user apprised of
current section being loaded.

101007000932

Product/Feature: Expense/Card Charges
Description: The Personal Card Charge Imports button is appearing on
the Expense tab, and personal card charges can be imported, even though
this is disabled in the Expense Admin Site Settings.
Resolution: The code is modified to display the Import button if the value
held in the session entity settings is Yes and this value is derived from the
Host database table settings.

101008000015

Product/Feature: Expense/User Admin
Description: Administrator cannot perform a search in User Admin when
more than 17 Groups are assigned with privileges to modify users.
Resolution: The code is modified to lengthen the variable to the MAX
character string so that any portion of the SQL query created for an employee
admin with 18 groups does not get truncated.

101011000398

Product/Feature: Expense/Allocations
Description: When choosing to allocate an expense the system is not
allowing a second or third allocation.
Resolution: The code is modified to filter out Most Recently Used (MRU)
items that are without a list mapping record, or have a value of IS_DELETED.

101015000791

Product/Feature: Expense/Car Mileage
Description: Canadian users of the Car Mileage feature do not see the
correct set of values when accessing the Trip Type list.
Resolution: The code is modified to now show the correct values by the
selected region.
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Case ID

Case/Defect Description

101029000009

Product/Feature: Expense/List Management
Description: The List Import template fails to import list items - the error
message The file wasn't processed because it contains one or more errors
with its formatting that prevents the system from processing it is displayed.
Resolution: The code is modified to remove an extra "0" in front of the
10_CODE parameter.

101108001063

Product/Feature: Expense/
Description: Expense types including square brackets [] are not displayed on
the list of expense types.
Resolution: The code is modified to properly display expense types that
include square brackets in the name.

101109000010

Product/Feature: Expense/Expense Entry
Description: The Save button is not displayed under the Fixed Lodging
expense type.
Resolution: The code is modified to no longer hide the Save button if the
itemization type for the lodging expense was not allowed.

101112000094

Product/Feature: Expense/Travel Allowance - Czech
Description: The Czech Travel Allowance Pocket Money feature is calculating
on the domestic part of a Single Day trip type - it should only calculate on the
foreign part of the trip.
Resolution: The code is modified to calculate the pocket money calculation
based on the allowance from the foreign portion of the trip and not the
domestic portion for days that include both.

101118000635

Product/Feature: Expense/VAT
Description: The Next button cannot be clicked when editing VAT
information if a specific language is selected.
Resolution: The code is modified to now return True value rather than set
the max value and validate when the end date is set to NULL.

101130000101

Product/Feature: Expense/Travel Allowance - Austria
Description: An incorrect amount is displayed under Austrian TA when lunch
and dinner are provided on deducted amount after 12 days of travel and the
Overnight check box is selected.
Resolution: The code is modified to change the logic so that overnight is
added after subtracting provided meal types.

101228000031

Product/Feature: Expense/Lists
Description: List items for complex connected lists cannot be modified. This
appears to be a general issue when making adjustments to lists using list
manager.
Resolution: The code is modified to allow a timeout to be set, then modified
to allow additional time.

101228000115

Product/Feature: Expense/Locations
Description: Incorrect values are displayed when modifying existing state
and province values for a city.
Resolution: The code is modified to now update the location name table for
every name instead of only the modified names.
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Case ID

Case/Defect Description

101230000615

Product/Feature: Expense/Travel Allowance
Description: The copy down action is not occurring when fixed meals or fixed
lodging expenses are created. This occurs when the source field is TEXT and
the target field is LIST type.
Resolution: The code is modified to add a section to the fixed entry
procedure for copying down from the employee and expense report fields of
TEXT type to entry fields of LIST type.

110111000107

Product/Feature: Expense/Travel Allowance
Description: Re-saving an itinerary row causes the fixed meals itemizations
to lose the correct journal splitting amounts - instead they are incorrectly set
to a NULL value. This problem is specific to using a rate feed with government
and company rates and also using itemized fixed meals.
Resolution: The code is modified to fix the base travel allowance rules
handler to now use the correct government base amounts for fixed meals
when calculating the fixed allowance amounts again.

110111000953

Product/Feature: Expense/Audit Rules
Description: While creating an audit rule using the Authorization Request
Category Save event, if the data object AR Category is used and Expense
Category field selected, no values are displayed as field values for selection.
Resolution: The code required to present the Expense Category helper is
now included in the current user interface.

110112000015

Product/Feature: Expense/Create New User
Description: The Expense preference Make the Single Day Itineraries
page my default in the Travel Allowance wizard incorrectly defaults to
Yes - it should default to No.
Resolution: The code is modified to now default the Make the Single Day
Itineraries page my default in the Travel Allowance wizard to No.

110124000344

Product/Feature: Expense/User Admin
Description: The user interface for User Admin is displaying the Travel field
labels in narrow type with some bleeding of image. This problem is restricted
to the Firefox and Chrome browsers - Internet Explorer does not display this
issue.
Resolution: The code is modified to correct the display of the fonts in User
Admin.

110124001160

Product/Feature: Expense/Itemizations
Description: The New Itemization page is incorrectly displayed after the user
has completed itemizations and all amounts are correctly distributed.
Resolution: The code is modified to no longer exit addNewExpense after
clearing exceptions and to no longer call this procedure twice.

110125001347

Product/Feature: Expense/Attendees
Description: An Unexpected Software Error (UE) is generated when a user
attempts to access their list of Favorite Attendees under their Profile, and
when attempting to open an existing or new expense report.
Resolution: The code is modified to check if the attendee list form key is not
available. If so, the code will now fall back to the default fixed attendee list
fields (Attendee Name, Attendee Title, Company, Attendee Type).

Release Notes
February 2011

Page 52

Concur Travel & Expense
Client-Facing

Case ID

Case/Defect Description

110128000213

Product/Feature: Expense/Policy Admin
Description: Not all selections are displayed when selecting items in the
Policy Admin module - instead only a single selected item is shown when a
value has previously been selected.
Resolution: The code is modified to display all available selections.

110130000084

Product/Feature: Expense/Attendees
Description: Attendee list data is not being correctly translated to list item
values for Custom attendee fields displayed in the table view.
Resolution: The code is modified to now display the actual list item text for
list type Custom attendee fields.

110201000941

Product/Feature: Expense/Travel Allowance
Description: Travel Allowance rates cannot be viewed and configured in the
user interface - the browser stops responding.
Resolution: The code is modified to remove the auto return of Rate records,
extra filtering is added, and the return number is now reduced to 500 to
prevent overflow where large (20,000+) records exist in the database.

110201001037

Product/Feature: Expense/
Description: Importing an Expense Type spreadsheet fails to activate the
expense types listed in the import.
Resolution: The code is modified to add a null pointer check around the
expense type limits code.

110203001041

Product/Feature: Expense/Travel Allowance
Description: Hotel itemizations have their Travel Allowance property
reversed when attempting to use the Nightly Lodging Expenses tool a second
time for the same expense.
Resolution: The code is modified to carry forward the Travel Allowance value
on itemizations where the expense type matches the parent by checking if the
itemizations are marked for Travel Allowance.

110208000273

Product/Feature: Expense/Attendee History
Description: An Unexpected Software Error (UE) is generated when editing
an attendee after an expense report has been sent back to the employee.
Resolution: The code is modified to remove the Save and Save & Add
Another buttons - these should not be available for an attendee on an
expense when that attendee record is not the most current version.
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Section 11:

Resolved Issues - Invoice

Case ID

Case/Defect Description

110104000418

Product/Feature: Invoice/Workflow
Description: A payment request incorrectly moves (skips) the Vendor
Approval step.
Resolution: The code is modified to add two optional parameters to the
request that will now indicate which workflow step the request resides. The
parameters are validated to the request's current workflow step.

101021000127

Product/Feature: Invoice/Delegates
Description: A delegate selected by the Employee Admin for deletion cannot
be deleted.
Resolution: The code is modified to remove a validation that was causing the
selection of the check box to be cleared in the background as the user was
attempting to complete the deletion.

110202000720

Product/Feature: Invoice/Vendor Management
Description: The vendor import (both overnight in a job, and on demand
through the user interface) is not importing vendors on a consistent basis client reports that some imports fail unexpectedly.
Resolution: The code is modified to remove insert statements for CT_AUDIT
in order to avoid writing primary key values to the message.
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Section 12:

Resolved Issues - Jobs

Case ID

Case/Defect Description

100205000404

Product/Feature: Expense Jobs/Extracts

100224000190

Resolution: An additional configuration option has been provided to allow the
client to specify handling of the designated delimiter and enclosing characters.

Description: Enclosing Characters showing up in fields in the SAE file.

See Configure Extracts: New Special Character Handling Field in the Expense
What's New section for more information.
101115000012

Product/Feature: Expense Jobs/Company Card Import
Description: Japanese “Stop Payment” transactions in the American Express
GL1025 are incorrectly imported as regular expenses.
Resolution: Modified the importer to recognize “Stop Payment” transactions
using the MIS Code and import them as Payments.

101007000188

Product/Feature: Expense Jobs/Company Card Import
Description: Error in credit card reader (GE Capital, Bank BPH - Poland).
Resolution: The MasterCard CDF 3.0 importer was modified to correctly
import BPH’s special coding of cash withdrawals.

101210000023

Product/Feature: Expense Jobs/Company Card Import
Description: Certain Bank of America International Transaction Fees are
hidden upon import
Resolution: Modified the MasterCard CDF 3.0 importer to recognize
AdjustmentReasonCode value of 8064 as a bank charge. The visibility of these
charges will be based on the card’s configuration.

101227000115

Product/Feature: Expense Jobs/Company Card Import
Description: Certain JP Morgan Chase adjustments are hidden upon import.
Resolution: Modified the MasterCard CDF 3.0 importer to recognize
AdjustmentReasonCode value of 7901 and 8056 as a regular expense and
bank charge respectively.

110112000354

Product/Feature: Expense Jobs/User Import
Description: The check for the BI Manager circular reference may result in
failure during import.
Resolution: The code performing the BI Manager circular reference check
was modified to use a non-recursive algorithm.

110119001044

Product/Feature: Expense Jobs/User Import
Description: The order of approvers and users in the file may result in errors
in certain scenarios.
Resolution: The code controlling the priority on record processing was
modified to help ensure that users are processed prior to their approvers.
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Case ID

Case/Defect Description

110113001006

Product/Feature: Expense Jobs/Company Card Import
Description: American Express eData importer may import duplicate
transactions.
Resolution: Modify the American Express eData importer used for APA BTA
to treat the transaction ID as unique. This will ensure that transactions resent
in the monthly Scrub file are not imported.

110106000707

Product/Feature: Expense Jobs/Card Account Sync to Cliqbook
Description: “Replaced” American Express cards are still displayed in the
user’s profile in Travel.
Resolution: The code that pushes card account information from Expense to
Travel was modified to include the provider status so that canceled cards can
be removed from the Travel profile.

110209000366

Product/Feature: Expense Jobs/Card Account Sync to Cliqbook
Description: Synchronization of card accounts of type “Other” results in a
NullPointerException.
Resolution: The code was modified to exclude these card accounts because
“Other” is not a valid card type in Travel.
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Section 13:

Known Issues - Invoice

Case ID

Case/Defect Description

091209000752

Product/Feature: Invoice/Workflow
Description: Workflow steps configured so that the Vendor Approval step
precedes the Cost Object Approval (COA) step are not supported.
Workaround: The client should configure Workflow so that the Vendor
Approval step never precedes the Cost Object Approval (COA) workflow step.
Instead, the Vendor Approval step should follow the COA step.
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Legal Notice
This document contains proprietary information and data that is the exclusive
property of Concur Technologies, Inc., Redmond, Washington. No part of this
document may be reproduced, transmitted, stored in a retrievable system,
translated into any language, or otherwise used in any form or by any means,
electronic or mechanical, for any purpose, without the prior written consent of
Concur Technologies, Inc.
Information contained in this document applies to the following products in effect at
the time of this document's publication:

Travel & Expense, February 2011

The above product(s) and information contained in this document are subject to
change without notice. Accordingly, Concur Technologies, Inc. disclaims any
warranties, express or implied, with respect to the information contained in this
document, and assumes no liability for damages incurred directly or indirectly from
any error, omission, or discrepancy between the above product(s) and the
information contained in this document.
© 2004 – 2011 Concur Technologies, Inc., Redmond, Washington. All rights
reserved.
Concur® is the trademark of Concur Technologies, Inc. All other company and
product names are the property of their respective owners.
Published by Concur Technologies, Inc.
18400 NE Union Hill Road
Redmond, Washington 98052
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Release Notes – March 2011
Section 1: Please Note the Following Alerts
Administration Functions at Parity to be Retired from Classic UI
Retired With the March Release
Beginning with the March release (March 18, 2011), functions at parity in the current
UI (listed below) will be retired from the classic UI.

GROUP CONFIGURATIONS FOR EMPLOYEES
•

Expense Configuration Admin & Shared Configuration Admin in Expense - now
available in the current interface
NOTE: Invoice-only clients - available via Shared Configuration Admin in
classic interface (that is, no changes for the Invoice client)

TRAVEL ALLOWANCE
•

Expense - now available in the current interface

Retired With the April Release
Beginning with the April release (April 15, 2011), functions at parity in the current UI
(listed below) will be retired from the classic UI.

CONFIGURABLE REPORTS
•

Configurable Reports Admin - now available in the current interface

EXPENSE GROUP CONFIGURATION
•

Expense Group Configuration for Expense Admin - now available in the
current interface

CAR CONFIGURATION
•

Expense Configuration Admin - now available in the current interface

EXPENSE COMPANY CARD ADMINISTRATOR

Release Notes
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•

Manage Cards - now available in the current interface

•

Assign Cards - now available in the current interface

•

Diversion and Lodge Accounts - now available in the current interface

•

Settings - now available in the current interface

•

Manage Transactions - now available in the current interface
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•
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Section 2: Enhancements From Client Suggestions Forum
The following features were submitted using Concur's Suggestion service, available
via Concur's forums. They are now included in this service release.
•

Invoice Pay: New Readability Format for Remittance Advice
Both the ACH and Check payment methods feature enhancements that
provide greater readability of the account numbers, date, and other
information.
Each of the features in this section is described in brief here, and in more
detail in their respective sections within this document - if you need additional
information please refer to these sections.
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Section 3: Expense
The following features are included in this service release.

Car Configurations Now Available in Current User Interface
Overview
The Car Configurations functionality is
now available in Expense Admin. This
feature is in full parity with the classic
user interface:

Business Purpose
This enhancement moves an expense
administrative function to the current
user interface.

Refer to the Expense: Car Configuration Setup Guide for more information.

Configuration
No additional configuration is required to use this feature.

Expense Group Configurations Now Available in Current User Interface
Overview
The Expense Group Configurations
functionality is now available in Expense
Admin. This feature is in full parity with
the classic user interface:
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Business Purpose
This enhancement moves an expense
administrative function to the current
user interface.
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Refer to the Expense: Group Configurations for Expenses Setup Guide for
more information.

Configuration
No additional configuration is required to use this feature.

Expense Admin Menu List Now in Alpha-Order
The Expense Admin page and leftside navigational panel is now organized in alphaorder in order to allow the user to find the administrative item more quickly.

Please note the following about this feature:
Release Notes
March 2011
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•

Not all languages reflect this change - all supported languages will be updated
in a future release

•

Not all administrative areas (Invoice Admin, Request Admin, etc.) are alphaordered as of this release - all administrative areas will be updated in a future
release

Configuration
No additional configuration is required to use this feature.

Printed Reports in the New Interface
The Printed Reports feature now appears in Expense Admin in the current interface,
but full functionality, including the ability to preview both the template and the
printed report, will only become available in a future release.
Clients who use this feature should continue to work with the full functionality
available in the classic user interface up until full functionality is added to the current
interface in a future release.
Refer to the Expense: Printed Reports Configuration Setup Guide for
additional information.

Authorized Approver List in the Classic User Interface
The Authorized Approver List will be moved to the current user interface in April.
Until then, use the list in the classic user interface.
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Section 4: Invoice
The following features are included in this service release.

Invoice Pay: Show Close Time When Configuring Funding
Overview
Business Purpose
A client is now alerted if the time they
set to disallow any more payment
This enhancement helps the user avoid
batches for processing (the Close time)
costly mistakes in setting Close and
is past the time at which payments are
Sent times in Invoice Pay.
to be sent for processing (the Sent
time). Now, when the Close time exceeds the system-enforced Sent time, an
informational message displays a reminder of the batches' Sent time and the effect
the user's change will have on batches falling after that time. The user can then
decide to retain their selection or change it.
How It Works
Invoice Pay maintains internal system Sent times of 3pm PST for ACH funding
accounts, and 6pm for Check. These are the times at which all payment batches are
sent for processing for the respective payment method. If the client elects to set a
Close time later in the day than the Sent time, an informational message appears:

The system detects the difference between the new Close time and existing Sent
time and displays the Funding Account informational message. Options in this
message let the client choose to verify the new Close time and implicitly the delay
that will result from this action, or elect to cancel this action and choose a different
Close time.
Example & Best Practices
In general the client will enforce a Close time prior to the Sent time - this ensures
that payments intended to begin the payment cycle that day will not fall after the
time at which they will be sent for processing. However, if the client requires an
enforced "Review" period prior to the Sent time, they should determine how much
time this is and set their Close time that many hours prior to the Sent time.
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As an example, if the Backoffice reviewers need one hour prior to the systemenforced Sent time of 3pm PST, they set their Close time to 2pm PST to "reserve"
that hour difference for the task of reviewing.

Configuration
Configuration of the Close time is done in the Funding Account (ACH) or Check
Configuration pages of Payment Manager by selecting a value, in half hour
increments, from the Close Time drop down field.

Refer to the Invoice: Invoice Pay Setup Guide for more information.

Invoice Pay: Enhanced Readability of Remittance Advice
Overview
Business Purpose
With this release the remittance advice
information provided with the ACH and
This enhancement improves the user
Check payment methods is now
interface for users who need to
enhanced. This change makes is easier
manage the remittance advice of their
for the Invoice Pay administrator to
payments.
view and extract information such as
the original invoice number, date of payment, amount, and any additional notes
provided with the payment.
The template of the updated payment information is shown below:
INV#<number> <date> <amount> <currency> <notes>
The output will appear as:
INV#445889008 2011/03/03 123.76 USD NOTES Partial pay due to water damage.
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Refer to the Invoice: Invoice Pay Setup Guide for more information.

Configuration
No additional configuration is required to use this feature.
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Section 5: Analysis and Intelligence
The following features are included in this service release.

New Standard Report: Expense Accrual By Date Range
This report shows all transactions that are not been assigned to an expense report or
have been assigned to an expense report that has not yet been paid over a user
defined date range. It provides visibility to financial professionals within the
organization regarding outstanding liabilities and potential future cash requirements.
This report is available at:
Intelligence – Standard Reports > Accrual or Analysis – Standard Reports >
Accrual

EXPENSE ACCRUAL BY DATE RANGE: REPORT PROMPTS

Release Notes
March 2011

Page 13

Concur Travel & Expense
Client-Facing

EXPENSE ACCRUAL BY DATE RANGE: REPORT OUTPUT

Analysis/Intelligence – Custom Field Support for Concur Travel
CUSTOM FIELD SUPPORT FOR CONCUR TRAVEL - OVERVIEW
Many Concur Travel or integrated clients take advantage of custom field within
Concur Travel at the User and Trip level. Since the application allows client to create
an unlimited number of custom fields, we are unable to bring the custom fields in the
Reporting database. This is because there needs to be a one to one relationship
between the database field and Cognos model.
In the October Release, the Travel team updated the Manage Custom Fields
screen that enabled users to map a custom field (Trip or User) to a pre-defined
value. In the March release, we have updated the DW Travel archive and are now
moving the mapped fields from the Travel database into the Reporting Database.
The pre-defined values that can be selected are as follows:
User

Release Notes
March 2011

•

Purpose Of Trip

•

Cost Center

•

Department

•

Project

•

Client Name

•

Client Number

•

Approval Code

•

Is Billable
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•

Job Number

•

Division

•

Business Unit

•

Approver

•

Account Code

•

Profile Custom 1

•

Profile Custom 2

•

Profile Custom 3

•

Profile Custom 4

•

Profile Custom 5

•

Profile Custom 6

•

Profile Custom 7

•

Profile Custom 8

•

Profile Custom 9

•

Profile Custom 10

•

Profile Custom 11

•

Profile Custom 12

•

Profile Custom 13

•

Profile Custom 14

•

Profile Custom 15

•

Profile Custom 16

•

Profile Custom 17

•

Profile Custom 18

•

Profile Custom 19

•

Profile Custom 20

Trip:
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•

Purpose Of Trip

•

Cost Center

•

Department

•

Project

•

Client Name

•

Client Number

•

Approval Code

•

Is Billable
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•

Job Number

•

Division

•

Business Unit

•

Approver

•

Account Code

•

Guest Custom 1

•

Guest Custom 2

•

Guest Custom 3

•

Guest Custom 4

•

Guest Custom 5

•

Meeting Name

•

Meeting ID

•

Meeting Custom 1

•

Meeting Custom 2

•

Meeting Custom 3

•

Trip Custom 1

•

Trip Custom 2

•

Trip Custom 3

•

Trip Custom 4

•

Trip Custom 5

•

Trip Custom 6

•

Trip Custom 7

•

Trip Custom 8

•

Trip Custom 9

•

Trip Custom 10

CUSTOM FIELD SUPPORT FOR CONCUR TRAVEL – CONCUR DATA WAREHOUSE
MODEL CHANGES
Once the User or Trip custom fields have been successfully mapped and an archive
has been successfully run, the report writer will have the ability utilize the Concur
Travel Custom field from the model. Concur Travel Custom Fields are available in
the following locations:
User
Travel > Trips > Additional Employee Details > Traveler User Fields
Expense > List > Employee Information > Traveler User Fields
Expense > Expense Reports > Report Header Information > Additional Employee
Release Notes
March 2011
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Details > Traveler User Fields
Expense > Expense Reports > Expense Report Workflow Trail > > Additional
Employee Details > Traveler User Fields
Expense > Expense reports > Credit Card > Credit Card Accounts > Additional
Employee Details > Traveler User Fields
Expense > Authorization Requests > Authorization Request Headers > Additional
Employee Details > Traveler User Fields
Expense > Authorization Requests > Authorization Request Workflow Trails >
Additional Employee Details > Traveler User Fields
Expense > Travel Allowances > Fixed Travel Allowance > Additional Employee
Details > Traveler User Fields
Expense > Travel Allowances > Reimbursable Allowance > Additional Employee
Details > Traveler User Fields
Expense > Travel Allowances > Itineraries > Additional Employee Details > Traveler
User Fields
Expense > Cash Advances > Cash Advance Details > Additional Employee Details >
Traveler User Fields
Expense > Cash Advances > Cash Advance Workflow Trail > Additional Employee
Details > Traveler User Fields
Expense > Lists > Cars > Additional Employee Details > Traveler User Fields
Invoice > Payment Request Header Information > Additional Employee Details >
Traveler User Fields
Invoice > Payment Request Workflow Trail > Additional Employee Details > Traveler
User Fields
Trip
Travel>Trips>Additional Trip Details>Trip Custom Fields

Analysis/Concur Intelligence – Model Updates
In addition to the model changes made to support Concur Travel Custom fields, the
following fields have also been added to the Concur Data Warehouse model in the
March release.
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Added to:

Concur Data Warehouse > Expense > Expense Reports > Entry Information > Amount
(Reimbursement Currency)
Added these fields to this folder:
♦

Total Tax Posted Amount

♦

Total Tax Adjusted Amount

♦

Total Reclaim Posted Amount

♦

Total Reclaim Adjusted Amount

♦

Net Tax Amount

♦

Net Adjusted Tax Amount

♦

Net Reclaim Amount

♦

Net Reclaim Adjusted Amount

Added to:

Concur Data Warehouse > Expense > Expense Reports > Entry Information > Amount
(Reporting Currency)
Added this field to this folder:
♦

Total Tax Posted Amount (rpt)

♦

Total Tax Adjusted Amount (rpt)

♦

Total Reclaim Posted Amount (rpt)

♦

Total Reclaim Adjusted Amount (rpt)

♦

Net Tax Amount (rpt)

♦

Net Adjusted Tax Amount (rpt)

♦

Net Reclaim Amount (rpt)

♦

Net Reclaim Adjusted Amount (rpt)

Analysis/Intelligence – Additional Changes
INCREASING THE RECORDS RETURNED LIMIT
Concur currently limits the number of records returned in a single report to one
hundred thousand records. This limit is imposed to prevent negative performance
experiences for our users; in a pooled environment the actions of one individual can
have a significant impact on the user experience of everyone using Analysis or
Intelligence. Concur has made a significant investment in the infrastructure of our
Operations environment and we feel we can safely increase the records returned
limit to two hundred thousand records.

DELETING OLD MODEL REPORTS
On April 1, 2011 Concur will be performing maintenance on the Content Store (this is
the Cognos database that stores all report definitions and user information). The
Content Store currently stores copies of report definitions of reports associated with
the Concur Reports data model. The majority of clients no longer have access to this
model and the report definitions are not usable. If you do not have access to the
Concur Reports model and have report definitions for reports that used to run
Release Notes
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against the Concur Report model, those report definitions will be deleted by Concur
on Friday April 1.
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Section 6: Web Services
The following features are included in this service release.

Imaging Web Service: Get Image Using Report ID
Overview
The Imaging web service has
been enhanced to allow clients to
get report images by supplying
the report ID.

Business Purpose
This enhancement allows clients to request
image data for an entire report.

Refer to the Imaging Web Service information on www.concurconnect.com for
more information.

Configuration
A partner application must be created and registered with Concur before the client
can use this feature.
Refer to the Managing Partner Application information on
www.concurconnect.com for more information.

User Web Service Now Provides Additional Information
Overview
The User web service has been
enhanced in the following ways:

Business Purpose
This enhancement gives clients more
information about the Employee Form fields.

•

The service now provides
additional information
about Employee Form fields.

•

The service now uses the form Field Id instead of the Label for user batch
requests.
Refer to the User Web Service information on www.concurconnect.com for
more information.

Configuration
A partner application must be created and registered with Concur before the client
can use this feature.
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Refer to the Managing Partner Application information on
www.concurconnect.com for more information.

Expense Portal Web Service is Now Expense Report Web Service
Overview
The Expense Portal web service
has been renamed to Expense
Report. This name change
reflects the most commonly used
resource supplied by the web
service, the Expense Report.

Business Purpose
This update clarifies the purpose of the web
service.

Refer to the Expense Report Web Service information on
www.concurconnect.com for more information.

Configuration
A partner application must be created and registered with Concur before the client
can use this feature.
Refer to the Managing Partner Application information on
www.concurconnect.com for more information.
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Section 7: Concur's Mobile App
Separate Release Schedule
The release for the mobile app is not on the same schedule as Travel & Expense,
Expense, and Travel. In addition, each Smartphone is handled differently, resulting
in different release dates for each Smartphone.

How It Works
When the app is ready for release, Concur submits it to the various app stores. Each
app store tests and approves the app, which takes between 3 and 10 days. When
testing is complete, the app is made available in the store.

Information Available on Concur Client Central
As information is released, it will become available to clients:
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•

On Concur Client Central by navigating to Resources > Document Library>
Concur Mobile:

•

On Concur Client Central by navigating to Resources > Release
Documentation:
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•
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In Online Help in Travel & Expense, Expense, and Travel:
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Section 8: Supported Configurations
The following configurations are either supported or no longer supported with this
service release.

Upcoming Certifications
Support for Adobe 10.0
Support for Adobe Reader version 10.0 will be included in an upcoming release.

Support for Mozilla Firefox Version 4.0
Support for the Firefox browser version 4.0 under both the Mac OS X and Microsoft
Windows operating systems will be included in an upcoming release.

Support for Google Chrome Version 9.0 and 10.0
Support for Google Chrome version 9.0 an d 10.0 under both the Mac OS X and
Microsoft Windows operating systems will be included in an upcoming release.

Support for Windows 7 Under Service Pack 1
Support for Microsoft Windows 7 using Service Pack 1 will be included in an
upcoming release.

Support for Windows Internet Explorer Version 9.0
Support for Microsoft Internet Explorer version 9.0 under the Windows 7 and
Windows Vista operating systems will be included in the April 2011 service release.
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Section 9: Resolved Issues - Expense
Case ID

Case/Defect Description

100829000012

Product/Feature: Expense/Expense Entry
Description: Expense types are grouped in such a way that it is not possible
to select them. This issue is appearing for Taiwan users using Internet
Explorer as their browser.
Resolution: The code is modified to encode in HTML those elements of
Expense Type Name and Expense Type Category that were not HTML encoded
and contained a special character.

101019000154

Product/Feature: Expense/Travel Allowance
Description: The Travel Allowance "Double Dipping" exception check is not
working. This is resulting in the user being allowed to enter both Fixed
Lodging and Standard Lodging for the same day without an exception firing.
Resolution: The code is modified to now perform a search on both regular
and child transactions. This fix allows the system to now analyze both levels
to correctly determine if an exception should be fired.

101118000657

Product/Feature: Expense/Hotel Expenses
Description: A user attempting to itemize hotel expenses under Internet
Explorer version 7.0 is unable to do so - javascript errors are displaying.
Resolution: The code is modified to only perform a debug operation on a
string when the debug feature is activated, and prevent concatentation of
multiple debug events into a single string (instead, into an array). Also, to
create child attendees with the correct amounts instead of zero.

101119000007

Product/Feature: Expense/Tax Authorities
Description: The system takes up to half a minute to display the full ist of
Tax Authorities available to the client.
Resolution: The code is modified to direct the system to no longer use the
report entry table but instead to seek the tax authority items in the map
table. This prevents issues if a user attempted to delete a tax authority that
was used in a tax reclaim group that had not been used in any report entries.

101130000841

Product/Feature: Expense/Attendees
Description: The browser (any) becomes unresponsive when attempting to
display a large number of attendees.
Resolution: The code is modified to now limit the number of attendees that
can be returned on a search to 5,000. A site setting can be changed to
accommodate additional, but in general clients with many thousands of
attendees should filter the return list to reduce the possibility of causing the
browser to hang up on a script.

Release Notes
March 2011

Page 25

Concur Travel & Expense
Client-Facing

Case ID

Case/Defect Description

101203001000

Product/Feature: Expense/User Interface - Forms & Fields
Description: Under Internet Explorer version 7.0 and 8.0 the administrator
sees the system stop responding ("A script is running") whenever attempting
to work with the Forms and Fields and Audit Rules modules. This appears to
work fine in both Firefox and Chrome browsers.
Resolution: The code is modified to optimize the Forms and Fields page by
not attempting to load all tabs at one time, call the correct formatting when
the branch expander template is expanded, and make the Form Fields tab
dynamic so that it only loads fields when the form is expanded by the user
clicking the tab.

101208000540

Product/Feature: Expense/Attendees
Description: The browser (any) becomes unresponsive when attempting to
display a large number of attendees.
Resolution: The code is modified to now limit the number of attendees that
can be returned on a search to 5,000. A site setting can be changed to
accommodate additional, but in general clients with many thousands of
attendees should filter the return list to reduce the possibility of causing the
browser to hang up on a script.

101210000225

Product/Feature: Expense/Ledgers
Description: No values from the drop down list can be added to any ledger.
Resolution: The code is modified to display the short code for lists or
connected lists in the Account Code administration module.

101220001237

Product/Feature: Expense/Audit Rules
Description: The Sort option is not available for the Editable By and Applies
To column headers that have this option available to them.
Resolution: The code is modified to remove an internal restriction preventing
these columns in all tables throughout the system from being sorted.

110111000702

Product/Feature: Expense/Car Mileage
Description: A waypoint calculation is not included in the submitted expense
report.
Resolution: The code is modified to disable the Assign to Expense button
whenever a change in the Location field is made, and enable the button
when the new route is calculated. This fix prevents the user from incorrectly
clicking the Assign to Expense button prior to the full calculation being
made.

110120000496

Product/Feature: Expense/Expense Reports
Description: The user is not able to view filtered date ranges of expenses
contained in a report using the View button. Instead, the default view is
shown to the user.
Resolution: The code is modified to fix a date math error contained in the
code.
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Case ID

Case/Defect Description

110121000217

Product/Feature: Expense/Employee Import
Description: A valid Travel Request Approver is included in an employee
import but the import fails to assign that Approver to the employee.
Resolution: The code is modified to now assign the Travel Request Approver
to the employee for clients who have enabled the Travel Request feature at
their sites.
NOTE! If Travel Request is enabled, then the Travel Request User and
Approver roles and corresponding assignments are imported. If Travel
Request is not enabled, then the Authorized Request User and Approver roles
and corresponding assignments are imported.

110124000005

Product/Feature: Expense/Policies
Description: A user attempting to view and modify all of their policies cannot
do so - no scroll bar is available to view all policies.
Resolution: The code is modified to automatically create separate windows
for each form type and only display the needed elements for the form type.

110126000476

Product/Feature: Expense/Sort Order
Description: The sort order created by approval status always sorts in
ascending order - it cannot be sorted as expected into descending order.
Resolution: The code is modified to now add the identical clause to the inner
query that generated the sort order as is used in the main select query itself.

110207001009

Product/Feature: Expense/Car Mileage
Description: Google waypoints calculated through Google maps mileage
calculations cannot be viewed by Processors and Approvers. Instead, an
Unexpected Software Error (UE) is being generated.
Resolution: The code is modified to prevent firing a "check" event when
setting initial values on the check boxes in the Mileage Calculator. Doing this
prevents redundant exectution of code that results in undefined error
generation.

110209000560

Product/Feature: Expense/User Interface - Personal Car
Description: Internet Explorer displays the Personal Car form incorrectly,
displaying the Currency field when it should be hidden, and blurring the
display of the Amount and Distance fields together.
Resolution: The code is modified to now rearrange the generated HTML
syntax. In addition, labels on the page are now moved and pixel width and
height changed to accommodate the display.

110211000183

Product/Feature: Expense/Printed Reports
Description: The Posted Amount currency shown for a credit card on a
printed report is incorrectly using the user's reimbursement currency instead
of the correct posted amount currency.
Resolution: The code is modified to now show the correct currency for the
credit card posted currency.

Release Notes
March 2011

Page 27

Concur Travel & Expense
Client-Facing

Case ID

Case/Defect Description

110214000865

Product/Feature: Expense/Expense Entries
Description: The system is incorrectly returning a user who has itemized the
full amount of their expenses to the Itemization page. The system is not
determining that there are no more itemizations to be made.
Resolution: The code is modified to now use the logic included in the
Itemization Wizard.

110222000628

Product/Feature: Expense/Smart Expenses
Description: Credit card charges are not appearing under the Trip section of
a report if the transaction dates fall within the trip dates.
Resolution: The code is modified to check the credit card and strip the times
from the transaction date and the start and end dates of the trip itself.

110301001474

Product/Feature: Expense/Policies
Description: No active categories for newly-created Policies are available,
preventing the user from creating an Authorization Request.
Resolution: The code is modified to now determine if the client using
Authorization Request instead of simply determing if the Policy was available
to the administrator.

110302001168

Product/Feature: Expense/Processor
Description: Expense reports marked as In Review status do not refresh to
Review In Progress status when set to that status by the Processor.
Resolution: The code is modified to now call the correct layout when either
the Review Required or Review Completed status is invoked by the Processor.

110311000637

Product/Feature: Expense/Reports
Description: Expense reports are stuck in a holding state when the ereceipts
associated with them are stored as empty strings by the system.
Resolution: The code is modified to now include the report ID in the stored
procedure.
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Section 10:

Resolved Issues - Invoice

Case ID

Case/Defect Description

110228001006

Product/Feature: Invoice/Policies
Description: The user is not shown the default policy associated with the
associated group configuration when creating a new payment request and
choosing a policy in the New Payment Request page.
Resolution: The code is modified to no longer set all policies as the default
policy when loading elements of the Invoice tab. Now, the policy identified as
the default is that one associated with the employee's hierarchy.

110218000724

Product/Feature: Invoice/Adobe Reader - Version 9.4.2 (Only)
Description: Adobe Reader version 9.4.2 under Internet Explorer versions
7.0 or 8.0 incorrectly offers to save an image file that the user only wishes to
view.
Resolution: The code is modified to remove the extraneous UTF-8 syntax
from the response header.

110302001284

Product/Feature: Invoice/Request Management
Description: Empty queries are being returned when the user attempts to
run the Invoices Approved This Month query in the Approve Requests page.
This issue is associated only with users who perform many approvals and
whose site processes many transactions.
Resolution: <unresolved at this time>
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Section 11:

Resolved Issues - Jobs

Case ID

Case/Defect Description

110113001006

Product/Feature: Expense Jobs/Company Card
Description: Duplicate transactions on Amex eData feed
Resolution: The code was modified to ignore transactions previously
imported based on the transaction ID. Per American Express, it is sufficient to
identify a transactions uniqueness.
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Section 12:

Known Issues - Invoice

Case ID

Case/Defect Description

091209000752

Product/Feature: Invoice/Workflow
Description: Workflow steps configured so that the Vendor Approval step
precedes the Cost Object Approval (COA) step are not supported.
Workaround: The client should configure Workflow so that the Vendor
Approval step never precedes the Cost Object Approval (COA) workflow step.
Instead, the Vendor Approval step should follow the COA step.
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Legal Notice
This document contains proprietary information and data that is the exclusive
property of Concur Technologies, Inc., Redmond, Washington. No part of this
document may be reproduced, transmitted, stored in a retrievable system,
translated into any language, or otherwise used in any form or by any means,
electronic or mechanical, for any purpose, without the prior written consent of
Concur Technologies, Inc.
Information contained in this document applies to the following products in effect at
the time of this document's publication:

Travel & Expense, March 2011

The above product(s) and information contained in this document are subject to
change without notice. Accordingly, Concur Technologies, Inc. disclaims any
warranties, express or implied, with respect to the information contained in this
document, and assumes no liability for damages incurred directly or indirectly from
any error, omission, or discrepancy between the above product(s) and the
information contained in this document.
© 2004 – 2011 Concur Technologies, Inc., Redmond, Washington. All rights
reserved.
Concur® is the trademark of Concur Technologies, Inc. All other company and
product names are the property of their respective owners.
Published by Concur Technologies, Inc.
18400 NE Union Hill Road
Redmond, Washington 98052
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Release Notes – April 2011
Finding Additional Product Release Notes
For products not covered in these release notes, log in to Concur Client Central, then
click Resources > Release Documentation > Release Notes to select and
download additional product-specific release notes matching your Concur solution(s):

Section 1: Please Note the Following Alerts
Administration Functions at Parity to be Retired from Classic UI
Retired With the April Release
Beginning with the April release (April 15, 2011), functions at parity in the current UI
(listed below) will be retired from the classic UI.

CAR CONFIGURATION
•

Expense Configuration Admin - now available in the current interface

EXPENSE COMPANY CARD ADMINISTRATOR

Release Notes
April 2011

•

Manage Cards - now available in the current interface

•

Assign Cards - now available in the current interface

•

Diversion and Lodge Accounts - now available in the current interface

•

Settings - now available in the current interface

•

Manage Transactions - now available in the current interface

•

View Import Logs - now available in the current interface
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NOTE: Merchant Code Mapping remains in the classic product - use this interface to
create and maintain these codes.

Retired With the May Release
Beginning with the May release (May 13, 2011), functions at parity in the current UI
(listed below) will be retired from the classic UI.

CONFIGURABLE REPORTS
Configurable Reports Admin - now available in the current interface

EXPENSE GROUP CONFIGURATION
•
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Expense Group Configuration for Expense Admin - now available in the
current interface
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Section 2: Enhancements From Client Suggestions Forum
The following features were submitted using Concur's Suggestion service, available
via Concur's forums. They are now included in this service release.
•

Exception "Pauses" Report Creation Before Creator Can Proceed
The user creating an auto-generated report (one-click report) that encounters
an exception prior to submit is now paused on the page and shown the
exception - they have the option to resolve the exception and proceed, or
proceed directly to the Expense List page without resolving the exception.

•

Calculate Tax Option Now Displayed on Expense Entry Form
The user will now see tax calculation using the new Calculate Tax link as
they enter the expense entry if VAT is applicable to the entry (has tax
configuration and expense type is applicable) and the configuration allows the
user to edit the tax amount.

•

Travel Request Copy Down of Allocations to Expense Entry
When configured to do so, Travel Request allocations will now copy down
from the travel request entry to the expense entry level.
Each of the features in this section is described in brief here, and in more
detail in their respective sections within this document - if you need additional
information please refer to these sections.
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Section 3: Expense
The following features are included in this service release.

Login Failure Behavior Made Configurable
Overview
Business Purpose
Until now, when a user attempted to log
in with an incorrect password, we
This enhancement allows clients to
allowed the user 5 failed attempts in 10
define their own security settings.
minutes before locking the user out for
24 hours. This is still the default
behavior. However, each of these elements is now configurable.
These settings are set for the entire company:
•

Login failure count triggering lockout: Number of login attempts... field

•

Login attempt window (minutes): login failure window field

•

Login failure lockout duration (minutes): How long the user... field

If the administrator sets the login failure lockout duration (How long the user...
field) to -1 and the user attempts to log in more than 5 times (or the number in the
Number of login failures... field) with an incorrect password, the user will be
locked out until his/her password is reset through one of the existing reset methods
(administrator reset, using the password reset link, etc). There are no minimum or
maximum requirements for any of the fields.
No changes are required. If the administrator does not change these values, they will
continue to behave the way they always have.

! IMPORTANT: This setting applies to logins for Travel as well as Expense.
Configuration
These settings reside in Company Admin > Manage Password Policy, which is
accessible only by Concur.
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If a client wants to change any of these new settings, the client must open a ticket
with Concur Client Support, noting the setting changes.

Password Reset Behavior Made Configurable
Concur has added a new configuration
item for password administration:
Business Purpose
Restrict Password Reset Once Per
Day. If enabled, users can reset their
This enhancement allows clients to
password no more than once per day
manage their own security settings.
(24 hours after the last reset time). The
default for this setting is OFF (check box unchecked).
This feature will not affect administrators resetting passwords via User Admin.

! IMPORTANT: This setting applies to logins for Travel as well as Expense.
What the User Sees
When the user clicks the link to reset his/her password, the following page appears:

If this feature is enabled and if the user attempts to reset the password more than
once in the same day, the following message appears:

Configuration

Release Notes
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1.

Select Administration > Company Admin > Password Administrator (left
menu).

2.

Enable the new feature.
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Password Reset Login Link Expiration Date Made Configurable
Concur has added a new configuration
item for password administration:
Business Purpose
Initial Login One Time Link
Expiration Length in Days. The
This enhancement allows clients to
administrator can now define how long
manage their own security settings.
the link that is sent to a user for a
password reset will remain valid. The default is 24 hours but can be expanded up to
72 hours.

! IMPORTANT: This setting applies to logins for Travel as well as Expense.
What the User Sees
When the user clicks the Forgot Your Password link on the login page, the user
sees the following page:
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The user is then sent an email that contains a link that - when active - will take the
user to the password reset page. If the link is expired, the user will see the following
message:

Configuration
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1.

Select Administration > Company Admin > Password Administrator (left
menu).

2.

Select 1, 2, or 3 days.
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Enhancement for Editing Value Added Tax (VAT) Amounts
Overview
Before this release, if a company's
configuration allowed a user to edit the
amount of value added tax, the
following would occur:

Business Purpose
This enhancement provides a benefit
as it removes unnecessary and likely
annoying extra steps for the user.

•

The Tax Posted Amount field
appeared on the Expense (or New Expense) tab but the field was
uneditable.

•

When the user saved the expense:

•

♦

Expense calculated the tax amount.

♦

The label on the Tax Posted Amount field changed to VAT Amount in
GBP (or whatever was configured by the client).

The user had to re-open the expense in order to edit the tax amount.

With this enhancement, the Tax Posted Amount field no longer appears. Instead,
the new Calculate Tax link appears.

When the user clicks the link:

Release Notes
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•

Expense calculates the tax amount.

•

The VAT Amount in GBP (or whatever was configured by the client) field
appears.

•

The user can edit the tax amount and then save.
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Note the following:
•

The user is not required to click Calculate Tax. If the user does not click the
link, the tax amount is calculated when the expense is saved. The link
provides the user the option to calculate (and perhaps edit) the tax before
saving.

•

If the user saves and then reopens the expense, the Calculate Tax link no
longer appears, but VAT Amount in GBP (or whatever was configured by the
client) field is editable.

Configuration
There is no configuration. This link appears automatically for users who are allowed
to edit VAT amounts.

Authorized Approver List and Cost Object Approver List Moved to the
Current User Interface
Overview
With this release, the Authorized
Approver List and Cost Object Approver
List are available to the current user
interface. These are functionally
equivalent to the functions found in the
classic user interface.

Business Purpose
The approver lists have been moved to
the current user interface - making it
easier for clients to fully manage
Expense in the current user interface.

The two approver lists can be accessed
by selecting Administration > Expense Admin > Workflows, and then selecting
the Authorized Approvers tab.

Release Notes
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The Authorized Approver List tab and the Cost Object Approver List tab can be
accessed by users with the Expense Configuration Administrator (restricted) role as
well as users with the unrestricted Expense Configuration Administrator role.
Refer to the Expense: Workflow – Authorized Approvers Setup Guide for more
information.

End Proxy Session Button Label Changed to Stop Proxying
Overview
The Expense for me proxy button that
appears when ending a proxy session is
renamed to make the meaning
consistent across all tabs in the user
interface.

Business Purpose
This enhancement makes the product
more product neutral and easier to
use.

The new label text is Stop Proxying.

Configuration
No configuration is required to use this feature.
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Cash Advance Administrator Now in the Current User Interface
Overview
With this release, the Cash Advance
Administrator tool is available in the
current user interface.
Users with the Expense Cash Advance
Administrator role can access the tool
using Administration > Expense Tools >
Cash Advance Admin.

Business Purpose
Cash Advance Administrator is another
tool moved to the current user
interface - making it easier for clients
to fully manage Expense in the current
user interface.

Audit Service - New Categories
Overview
For clients who use Concur's Expense
Report Audit Service, the list of
categories has been expanded to
include additional categories that more
precisely describe the reason for the
audit failure.

Business Purpose
This enhancement provides better
descriptions for audit failures, giving
the client a more precise categorization
of the failure.

The new options are:
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•

Attendees Type Incorrect

•

Receipt: Date Not Matching
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•

Receipt: Vendor Doesn't Match

•

Expense: Excessive Tip / Gratuity

•

Payment Method Does Not Match

•

Receipt Status Not Accurate

•

HCP Concerns

•

Sign In Sheet Not Present

•

Hotel Itemization: Incorrectly Itemized

The reports available in Analysis and Intelligence will reflect the historical and new
categories.

Configuration
There is no configuration; these new options appear automatically.

Allocations from Travel Requests to Expense Entries
Overview
Business Purpose
Until this release, travel requests
(created using Concur's Request
This enhancement provides a benefit to
feature) could be allocated but those
clients who use allocations for both
allocations did not carry through to the
travel requests and Expense by saving
associated expense entry. With this
the user some data-entry time.
month's enhancements, travel request
allocations can be copied down to the expense entry.

EXACT MATCH WITH EXPENSE TYPE MAP
If the expense entry allocation is configured to copy down from the request entry,
when a travel request is associated with an expense report and the mapped expense
types match, the expense entry (or entries) is automatically allocated – exactly
matching the travel request. For example, assume that the travel request Air Ticket
segment is mapped to the Airfare expense type. Further assume that on this
particular travel request, the Air Ticket segment is allocated at 50% Sales and 50%
Marketing. If the user associates the travel request with an expense report and if
that report has an Airfare expense, then the Airfare expense is automatically
allocated at 50% Sales and 50% Marketing.
Note the following:

Release Notes
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•

If there are multiple travel requests attached, Expense will prompt the user to
select one of them so Expense knows which allocations to copy.

•

This feature sets the initial allocations. The user can edit the allocations if
necessary.
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SETTING TO ALLOCATE ALL EXPENSES TO MATCH THE TRAVEL REQUEST
There is a new option that allows Expense to automatically allocate every expense
on an expense report to exactly match the associated travel request – regardless of
expense type matching. For example, assume that a particular travel request is
allocated at 50% Sales and 50% Marketing. If the user associates the travel request
with an expense report, all expenses on the report are automatically allocated at
50% Sales and 50% Marketing.
Note the following:
•

This feature works only if there is one travel request associated with the
expense report. If there are multiple travel requests associated, Expense
cannot determine which allocations to use and will not copy any allocation
data.

•

This feature sets the initial allocations. The user can edit the allocations if
necessary.

Known Issue - Travel Allowances
At this time, travel request allocations do not automatically copy down to systemcreated fixed travel allowance expense entries. This issue will be corrected in an
upcoming release. Until then, the user can enter the allocations manually.

Configuration
If the client wants either of these two features, the client contacts Concur Client
Support for assistance.

Preview: Concur User Interface Feedback
Overview
Beginning June, all clients are notified
that a feedback questionnaire is
included in the page displayed when
they submit their expense report. This is
not a new screen, this pop-up already
appears today.

Business Purpose
This enhancement allows Concur to use
customer feedback to improve our
products.

NOTE: Client information is not gathered using this questionnaire - it is for the sole
purpose of improving the product and no information will be shared to
existing clients or publicly.
The feedback questionnaire is shown in the figure below, within the Report Submit
Status page:
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Why Are We Doing This?
The inclusion of this feedback section lets the user provide feedback directly to
Concur at the time at which issues are clearest to them, and the task point at which
they are most likely to comment. The client is not required to provide feedback - this
task is optional.
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Section 4: Expense Pay
The following features are included in this service release.

Documentation Change: Reimbursement Manager User Guide is Now
Expense Pay – Professional Implementation User Guide
Overview
Business Purpose
The Expense: Reimbursement Manager
User Guide has been renamed to
This consolidates information into a
Expense Pay – Professional
single document making it easier to
Implementation User Guide. This guide
find information regarding Expense
now contains the information available
P
in various Expense Pay documents, including process details, timelines, and email
notification text.
Refer to the Expense Pay – Professional Implementation User Guide for more
information.

Configuration
No additional configuration is required to use this feature.

New AMEX Card Program Support
Overview
Expense Pay has been enhanced to
support the following card programs:
•

AMEX International Euro Card

•

AMEX EMEA Greece

•

AMEX EMEA Dollar 45

•

AMEX EMEA Switzerland

•

AMEX EMEA Finland

Business Purpose
This enhancement allows Expense Pay
to pay addition AMEX card program
types

The AMEX credit card feed import now supports multiple countries in a single card
feed using the Euro currency.
Refer to the Expense Pay – Professional Implementation User Guide for more
information.

Release Notes
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Configuration
No additional configuration is required to use this feature.
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Section 5: Documentation Updates
The following documentation changes are included in this service release.

Release Notes Now Available in Product-Specific Documents
Overview
Business Purpose
With this release the client can now
choose from product-specific release
Administrators can now build the set of
notes, each document or group of
release notes they need for their site
documents matching a specific Concur
without sorting through unnecessary
offering. Now, if one administrator is
material.
tasked with reviewing resolved issues,
they can download a document with only case information in it. The Invoice user can
download either Invoice release notes, or both Invoice and Mobile if that solution
applies to the client site.
How It Works - Concur Client Central
Beginning in April a table will now be displayed when the user logs in to Concur and
proceeds to Release Documentation > Release Notes using the Resources menu.
The design of the table allows the client to use the uppermost row of the table to
quickly identify their Concur product and what notes are applicable to their solutions:
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Each set of release notes include descriptions on the cover detailing what supporting
products can be found within the document. For example, the client who reviews
Expense Pay changes does so by downloading the Expense - Professional/Premium
release notes.
Help System Updates
The Concur administrative Help systems now include links to release notes as well.
When the user opens administrative Help (only), the leftside navigational area now
features the What's New link for the product release notes, plus additional links to
Mobile if that product is applicable to the solutions at the client site.

With this update the administrator can now avoid logging in to Concur Client Central
to view the release notes for their product(s).
Restrictions
To ensure security and "no see" restrictions, only the administrative Help systems
(Expense Tools; Expense Admin; Invoice Admin, etc.) contain the release note links no End User Help system allows viewing of the notes.

Configuration
No additional configuration is required to use this feature.
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Section 6: Supported Configurations
The following configurations are either supported or no longer supported with this
service release.

Certifications for This Release
Support for Adobe 10.0
Support for Adobe Reader version 10.0 is certified for this release.

Support for Mozilla Firefox Version 4.0
Support for the Firefox browser version 4.0 under both the Mac OS X and Microsoft
Windows operating systems is certified for this release.

Support for Google Chrome Version 9.0 and 10.0
Support for Google Chrome version 9.0 an d 10.0 under both the Mac OS X and
Microsoft Windows operating systems is certified for this release.

Support for Windows Internet Explorer Version 9.0
Support for Microsoft Internet Explorer version 9.0 under the Windows 7 and
Windows Vista operating systems is certified for this release.

Upcoming Certifications
Support for Windows 7 Under Service Pack 1
Support for Microsoft Windows 7 using Service Pack 1 will be included in an
upcoming release.

Release Notes
April 2011

Page 20

Concur Travel & Expense
Client-Facing

Legal Notice
This document contains proprietary information and data that is the exclusive
property of Concur Technologies, Inc., Redmond, Washington. No part of this
document may be reproduced, transmitted, stored in a retrievable system,
translated into any language, or otherwise used in any form or by any means,
electronic or mechanical, for any purpose, without the prior written consent of
Concur Technologies, Inc.
Information contained in this document applies to the following products in effect at
the time of this document's publication:

Travel & Expense, April 2011

The above product(s) and information contained in this document are subject to
change without notice. Accordingly, Concur Technologies, Inc. disclaims any
warranties, express or implied, with respect to the information contained in this
document, and assumes no liability for damages incurred directly or indirectly from
any error, omission, or discrepancy between the above product(s) and the
information contained in this document.
© 2004 – 2011 Concur Technologies, Inc., Redmond, Washington. All rights
reserved.
Concur® is the trademark of Concur Technologies, Inc. All other company and
product names are the property of their respective owners.
Published by Concur Technologies, Inc.
18400 NE Union Hill Road
Redmond, Washington 98052
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Resolved and Known Issues Case List
Concur Clients

Release Notes – April 2011
FOR CONCUR INTERNAL USE ONLY – DO NOT DISTRIBUTE OUTSIDE CONCUR

Finding Additional Product Release Notes
For products not covered in these release notes, log in to Concur Client Central, then
click Resources > Release Documentation > Release Notes to select and
download additional product-specific release notes matching your Concur solution(s):

Section 1: Resolved Issues - Expense
Case ID

Case/Defect Description

091015000407

Product/Feature: Expense/Forms & Fields
Description: The red bar indicating a Required field type correctly appears
for the Hotel field if it is a cash expense, but incorrectly disappears if the
payment type is by a credit card import.
Resolution: The code is modified to fix an API that marks site required fields
as required.

100614000633

Product/Feature: Expense/
Description: User sees an error message stating that their work address is
not stored in the database and that they need to save to prevent the message
from appearing again. However, the error message does appear again even
after saving.
Resolution: The code is modified to now check if the Travel application is
enabled for the client before checking the work address because work address
is not set to appear for Expense-only users.
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Case ID

Case/Defect Description

100723000522

Product/Feature: Expense/Smart Expenses
Description: Smart Expenses do not automatically prompt for a match where
part of the smart expense is included in the report and part of the expense is
not.
Resolution: The code is modified to add a criterion to prevent unnecessary
updates of the report entry, which leads to the last modified column being
updated. With an updated date, the application believed that the entry had
been checked since the last time new matching information was last available.

100827000579

Product/Feature: Expense/Email Notifications
Description: The Subject line of an Email notification generated by the Send
Back the Report functionality is confusing. The name included in the Subject
line is the Processor who returned the report, but it is misinterpreted as the
name is the owner of the report.
Resolution: The code is modified to now show the report owner's name
instead of the name of the Processor who sent the report back to the report
creator.

100903000637

Product/Feature: Expense/Car Mileage
Description: When entering mileage via the Google Maps feature only
company locations in the user’s home and work location countries are
appearing. Any location worldwide should be available.
Resolution: The code is modified to now fetch the company locations for the
country that is assigned to the user in expense settings.

100922000094

Product/Feature: Expense/Smart Expense
Description: Matching an itinerary item from a trip header to a credit card
transaction eReceipt incorrectly causes the creation of a new trip header
instead of correctly adding it to the trip header that the itinerary items came
from.
Resolution: The code is modified to resolve problems with manually
matching "orphaned" eReceipts.

101014000033

Product/Feature: Expense/Approver Search - Chinese
Description: A user cannot return any results if they search for Approvers by
typing Chinese characters - they must type in the employee ID instead.
Resolution: The code is modified to now treat this search criteria as
VARCHAR (non-Unicode) instead of NVARCHAR (Unicode).

101015000017

Product/Feature: Expense/Processor Query - Chinese
Description: A user cannot create a query in Process Reports by typing
Chinese characters - they are replaced in the system with "?" instead.
Resolution: The code is modified to now treat this query as VARCHAR (nonUnicode) instead of NVARCHAR (Unicode).

101101000315

Product/Feature: Expense/Groups
Description: The system cannot return a full list of Group hierarchy for
Reporting role available to a user with the Reporting role. The list is so large
that the system time out before the full list can be displayed.
Resolution: The code is modified to remove the functionality that was
expanding all the nodes when the user attempted to edit an existing node.
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Case ID

Case/Defect Description

101222001012

Product/Feature: Expense/Attendees
Description: Changing the expense type incorrectly clears the Attendee field
of its existing attendee value and causes an error message to appear.
Resolution: The code is modified to now preserve attendee data that was
being cleared when changing the expense type.

110105000927

Product/Feature: Expense/Credit Card Imports
Description: The restriction of 60 card imports is enforced in both My Concur
(credit card charges) and smart expenses but the system only shows the error
message that the user is importing more than 60 transactions in the smart
expense module - it should appear in both areas.
Resolution: The code is modified to add the same check for 60 records in My
Concur as is used in the expense report > smart expenses module of the
system.

110106000270

Product/Feature: Expense/Report Creation
Description: An Unexpected Software Error (UE) is generated when a
Delegate attempts to create an expense report from the Trip List.
Resolution: The code is modified to add a check so that, even if there is a
report-level exception or warning, the user will be able to continue to the next
screen if the user is creating a report from a trip chosen from the Trip List.

110114000762

Product/Feature: Expense/Attendees
Description: When the Approver performs a partial approval of an expense
item that has attendees the total does not match the separate attendee
amounts and an exception is generated that clears only after clicking Save a
second time.
Resolution: The code is modified to now de-format the approved amount
prior to performing the comparison between the attendee total and the
approved amount.

110117000699

Product/Feature: Expense/Currencies - Romanian
Description: The ROL currency (retired Romanian) is incorrectly available as
a choice. The current currency for Romania is RON.
Resolution: The code is modified to now retire the ROL currency type.

110120000553

Product/Feature: Expense/Currencies
Description: Double-byte character display is garbled in the
Reimbursement Currency dropdown list.
Resolution: The code is modified to render the display correctly by setting
the system currency name prior to display.

110124000006

Product/Feature: Expense/Car Configuration
Description: Reconfiguring the Car Configuration results in the correct softdeletion of the discarded data, but the incorrect removal of this still-valid data
from submitted expense reports.
Resolution: The code is modified to load deleted car configurations when
displaying submitted expense reports created with those car configurations.
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Case ID

Case/Defect Description

110125000011

Product/Feature: Expense/Travel Allowance
Description: The system is translating Unicode characters (e.g. Japanese
Kanji) into question marks when saving a travel allowance itinerary with a
name containing these characters.
Resolution: The code is modified to now change "name" values to nvarchar
types.

110125001247

Product/Feature: Expense/Company Card
Description: Removing a company card charge requires a refresh of the page
in order to see the change - it is not happening automatically.
Resolution: The code is modified to update the grid when a successful delete
action is encountered.

110131001072

Product/Feature: Expense/Allocations
Description: The Allocations pop up does not display for itemized expenses
when the Processor views an expense report.
Resolution: The code is modified to correct a recent code change that was
preventing a call to display allocations method for submitted expense reports.
Now, when the user clicks Allocate, the allocation grid will be displayed.

110209001098

Product/Feature: Expense/List Manager
Description: Duration of time required to populate Edit List Items in List
Manager is unacceptable - can take over three minutes.
Resolution: The code is modified to increase the speed of list load times
where there are many hierarchy nodes defined. The code will now retrieve list
usage information when deleting the list rather than getting that information
for each node while loading.

110222001022

Product/Feature: Expense/Attendees
Description: If identical List-type fields exist on two different Attendee
forms, each with different source lists, data is not correctly cleared from the
field when switching between the two forms.
Resolution: The code is modified to clear the field if the source list is not the
same for the list fields in the two forms.

110223001258

Product/Feature: Expense/Attendees
Description: An error message is appearing when adding an attendee and
the line that should include the attendee is blank.
Resolution: The code is modified to no longer remove parts of the key
attendee properties when changing expense types. Now all attendee data is
retained when changing expense types.

110224000976

Product/Feature: Expense/Locations
Description: The State/Province field of Locations does not appear after
opening a location that does not use this field.
Resolution: The code is modified to now display the subcountry value if it is
present after a location without a subcountry value is displayed.
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Case ID

Case/Defect Description

110228000510

Product/Feature: Expense/Role Admin
Description: Role Administrator is unable to assign Cognos permission at ES
and IS Group level. These Groups are also incorrectly duplicated on the Group
Listing page when modifying groups
Resolution: A SQL script is run to correct this issue.

110301000428

Product/Feature: Expense/Tax Admin
Description: The Reclaim section of Tax Admin is not showing the correct
configuration set up for tax receipt. However, the correct information displays
when re-checking the tax configuration.
Resolution: The code is modified to add an additional check to determine if
the configuration is new prior to setting a False flag.

110301001239

Product/Feature: Expense/Cost Object Approval
Description: Cost objects pending approval do not show a total value on the
Approver's page.
Resolution: The code is modified to now correct an issue where the returned
data was no longer being made available due to an earlier code change in the
report list data.

110302000022

Product/Feature: Expense/Approval
Description: The system is incorrectly stamping an earlier date on the report
approval action than the date stamped for the actual submission date.
Resolution: The code is modified to now set the first approval time stamp as
the manager's approval, and to set the approval time based on GMT and not
the actual server time.

110302001258

Product/Feature: Expense/Processor
Description: When using the Select All button to select a single line item
entry in order to activate the Mark as Reviewed button, the system does not
make the Mark as Reviewed button available - it is grayed out.
Resolution: The code is modified to change the behavior so that the system
treats clicking the Save All button exactly the same as selecting the single
check box next to the single expense entry or authorization request.

110307000571

Product/Feature: Expense/Change Log
Description: Changing the Travel Request configuration causes no record to
be logged in the system's Change Log.
Resolution: The code is modified to update a stored procedure so that it is
now able to audit changes in this module.

110310000970

Product/Feature: Expense/Forms & Fields
Description: The Submit Date field does not show a date for the Approver
or Traveler when the field is read-only to that role.
Resolution: The code is modified to now populate the Submit Date field on
the report header for all users.

110321000833

Product/Feature: Expense/Car Configuration
Description: The Expense Configuration administrator (Restricted) role is
incorrectly denied access to Car Configuration.
Resolution: The code is modified to now add access to Car Configuration to
the Expense Configuration administrator (Restricted) role in the new interface.
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Case ID

Case/Defect Description

110322001217

Product/Feature: Expense/Roles
Description: The Approver logging in as both user and approver is not able
to create a new expense report using the New Report button from the
Approve Reports page - the system presents the new report form as readonly with only the Cancel button available.
Resolution: The code is modified to now set the correct role prior to allowing
the Approver to create a new expense report.

110323001118

Product/Feature: Expense/Localization - Spanish
Description: Two Spanish translations lack capitalization: Date (envio) and
Remaining (restante).
Resolution: The code is modified to correct the terms to now display Envio
and Restante.

110324000042

Product/Feature: Expense/Expense Reports
Description: The system incorrectly displays the single character "N" instead
of "No Receipt" in the Receipt Status field.
Resolution: The code is modified to ensure all possible choices are available
for display in the Receipt Status field.

110331000139

Product/Feature: Expense/Localization French-Canadian
Description: The date format for French-Canadian display is incorrect - it
includes a day element at the end of the year element (AAAAJ-MM-JJ).
Resolution: The code is modified to update the XML file to change this string
for French-Canadian display.

110331000533

Product/Feature: Expense/Car Configuration
Description: The administrator is unable to enter a rate that exceed the
decimals for the currency, such as ".338" - the system rounds the number up
to 2 decimals only.
Resolution: The code is modified to allow up to 4 decimal places.

110401000166

Product/Feature: Expense/Travel Allowance
Description: Norwegian travel allowance is incorrectly showing a Single Day
Over limit error.
Resolution: The code is modified to now set partial deductions for
government amounts just as is done for company amounts.

110405000428

Product/Feature: Expense/Workflow
Description: Data is being corrupted by stored procedure transactions within
Workflow.
Resolution: The code is modified to remove the rollback transaction handling
from the stored procedure so that different code can handle the errors.

110407000912

Product/Feature: Expense/GSA Rates
Description: Incorrect GSA lodging and travel rates are being imported for
San Bernardino county.
Resolution: The code is modified to now draw the rate file with updated data
from a different location as the source file was relocated to a new location by
the US government site as of 4/1/2011.
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Section 2: Known Issues - Expense
Case ID

Case/Defect Description

N/A

Product/Feature: Expense/Allocations
Description: Under the new Request policy, approved request allocation rows
being copied from Request to Expense are empty of their original values.
Workaround: There is no workaround - this issue will be resolved in the April
service release.
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Section 3: Documentation Updates
The following documentation changes are included in this service release.

Release Notes Now Available in Product-Specific Documents
Overview
Business Purpose
With this release the client can now
choose from product-specific release
Administrators can now build the set of
notes, each document or group of
release notes they need for their site
documents matching a specific Concur
without sorting through unnecessary
offering. Now, if one administrator is
material.
tasked with reviewing resolved issues,
they can download a document with only case information in it. The Invoice user can
download either Invoice release notes, or both Invoice and Mobile if that solution
applies to the client site.
How It Works - Concur Client Central
Beginning in April a table will now be displayed when the user logs in to Concur and
proceeds to Release Documentation > Release Notes using the Resources menu.
The design of the table allows the client to use the uppermost row of the table to
quickly identify their Concur product and what notes are applicable to their solutions:
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Each set of release notes include descriptions on the cover detailing what supporting
products can be found within the document. For example, the client who reviews
Expense Pay changes does so by downloading the Expense - Professional/Premium
release notes.
Help System Updates
The Concur administrative Help systems now include links to release notes as well.
When the user opens administrative Help (only), the leftside navigational area now
features the What's New link for the product release notes, plus additional links to
Mobile if that product is applicable to the solutions at the client site.

With this update the administrator can now avoid logging in to Concur Client Central
to view the release notes for their product(s).
Restrictions
To ensure security and "no see" restrictions, only the administrative Help systems
(Expense Tools; Expense Admin; Invoice Admin, etc.) contain the release note links no End User Help system allows viewing of the notes.

Configuration
No additional configuration is required to use this feature.
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Legal Notice
This document contains proprietary information and data that is the exclusive
property of Concur Technologies, Inc., Redmond, Washington. No part of this
document may be reproduced, transmitted, stored in a retrievable system,
translated into any language, or otherwise used in any form or by any means,
electronic or mechanical, for any purpose, without the prior written consent of
Concur Technologies, Inc.
Information contained in this document applies to the following products in effect at
the time of this document's publication:

Travel & Expense, April 2011

The above product(s) and information contained in this document are subject to
change without notice. Accordingly, Concur Technologies, Inc. disclaims any
warranties, express or implied, with respect to the information contained in this
document, and assumes no liability for damages incurred directly or indirectly from
any error, omission, or discrepancy between the above product(s) and the
information contained in this document.
© 2004 – 2011 Concur Technologies, Inc., Redmond, Washington. All rights
reserved.
Concur® is the trademark of Concur Technologies, Inc. All other company and
product names are the property of their respective owners.
Published by Concur Technologies, Inc.
18400 NE Union Hill Road
Redmond, Washington 98052
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Release Notes – May 2011
Finding Additional Product Release Notes
For Travel release notes, log in to Concur Client Central, then click Resources >
Document Library > Travel and then either TMC Partner or Direct Customers.
For all other products, log in to Concur Client Central, then click Resources >
Release Documentation > Release Notes to select and download additional
product-specific release notes matching your Concur solution(s):

Section 1: Please Note the Following Alerts
Administration Functions at Parity to be Retired from Classic UI
Retired With the May Release
Beginning with the May release (May 13, 2011), functions at parity in the current UI
(listed below) will be retired from the classic UI.

CONFIGURABLE REPORTS
Configurable Reports Admin - now available in the current interface.

EXPENSE GROUP CONFIGURATION
Expense Group Configuration for Expense Admin - now available in the current
interface.

Release Notes
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Retired With the June Release
Beginning with the June release (June 17, 2011), functions at parity in the current UI
(listed below) will be retired from the classic UI.

VALIDATION RULES
Validation Rules for Expense Admin – now available in the current release.

July Release Preview: French Language Review and Update
Concur is reviewing all French language translations and updated string changes will
be introduced in the July service release (SU69).

July Release Preview: Japanese Language Review and Update
Concur is reviewing all Japanese language translations and updated string changes
will be introduced in the July service release (SU69).
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Section 2: Enhancements From Client Suggestions Forum
The following features were submitted using Concur's Suggestion service, available
via Concur's forums. They are now included in this service release.
•

Display Requested Amount in Expense
The Total column is replaced by the Requested Amount column in the
Active Work, Approval Queue, and expense entry section of the expense
report.

•

Attendees Can Be Selected from Multiple Pages
Attendees selected as the user moves from page to page in Expense are now
all added to the total list of attendees.

•

Email Address Added to Cash Advance Pending Issuance Tab
A new column, Email Address, is now added to the Pending Issuance tab
of Cash Advance Admin so that the admin can now differentiate between
same-name employees when issuing a cash advance.
Each of the features in this section is described in brief here, and in more
detail in their respective sections within this document - if you need additional
information please refer to these sections.
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Section 3: Expense
The following features are included in this service release.

TripIt Integration with Integrated Travel & Expense
If your company uses integrated Travel & Expense, upon login on May 20, your users
will see an alert at the top of My Concur or the Travel home page:

These links allow your travelers to authorize Concur’s Travel solution to automatically
deliver itinerary data directly into TripIt.
For more information, refer to your Travel Release Notes (a guide to finding
product release notes is in the section Finding Additional Product Release
Notes in this document).

Receipt Store and Line Item Receipt Matching
Overview
Business Purpose
With this release users can link
receipts to the individual expense
This enhancement allows users to
entries to allow one-to-one linkage
associate receipt images with specific
between expenses and recipts. The
expense entries, and managers and
image is stored and is available only
processors to easily reconcile the expense
to the user, who can log in to
report receipts at the expense level.
Expense and use options to attach
these images to their expense report line item expense entries (only). Users can also
email their receipt image files to the new Receipt Store image repository.

Benefits of the Receipt Store Feature
Receipt Store provides many benefits to Expense users, managers, and processors:

Release Notes
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•

The user can now email images for storage and association to line item
entries

•

Receipts can be attached at virtually any time of the expense entry process
prior to Submit

•

Concur Assistant Help is available by clicking Information in the Expense
Report view
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•

Different attachment methods provide flexibility in attaching receipts including a Submit action that reminds the user that receipts are required

•

Approval is easier when reconciling an image to an expense at the entry level
instead of multiple images at the report level

•

Receipt Store complements, but does not replace, the current Imaging
Service Upload functionality in Expense

•

An Audit Trail entry is recorded to track when the manager views the line
item receipt image

ADDITIONAL INFORMATION
Complete information about the Receipt Store feature is included in the following
guides, fact sheets, and online presentation:
•

The Expense: Receipt Handling - Receipt Store Setup Guide

•

The Receipt Store and Delegate Handling Fact Sheet

•

Recorded Demonstration: A recorded demonstration of this feature is
posted on the client support site and can be opened by cutting and pasting
the URL below:
http://www.concurtraining.com/customers/tech_pubs/webinars/201104/receipt_store_video_v5.wmv

Excel List Import: Audit Trail of User Who Performs List Import
Overview
A user who imports list structure using
the List Import feature in Expense will
now be included in the audit. This
feature allows Implementation and
Client Support to now note the login ID
of users who perform list imports within
an entity.

Business Purpose
This enhancement provides additional
security by retaining a record of user
action within a company.

Details
To determine the name, by Login ID, of the user performing the list import the
administrator looks for the value in the RUN_AUDIT_DATA field of the CT_RUN table.
The syntax is similar to employee_name=<login ID value>. Multiple values are
separated by a "pipe" (|) character.

Configuration
No additional configuration is required to use this feature.
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Group Configuration: Attendee Types by Group Now Available
Overview
Business Purpose
The Group Configuration page has
been enhanced to allow the
This enhancement brings an Expense
administrator to set the attendee types
Administration page to parity with the
by group. This enhancement brings the
classic user interface.
Group Configurations page in the
current user interface to parity with the classic user interface.

Configuration
This column will only appear if the company is set to manage attendee types by
group in the Settings tab of the Attendees page in Expense Admin:
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Validation Rules Now Available in Current User Interface
Overview
Business Purpose
With this release, the Validation Rules
functionality of Audit Rule is available in
This enhancement makes it easier to
the current user interface. This is
manage Audit Rules and brings
functionally equivalent to the functions
additional parity to the new user
found in the classic user interface. It is
interface.
accessible to the Expense Configuration
Administrator and the Expense Configuration Administrator (Restricted) roles only.
Validation Rules is accessed by selecting the Expense Admin > Audit Rule >
Validation tab.

Configuration
The Validation tab of Validation Rules is not available by default. To activate this
tab, the client will need to submit a Service Request to Concur Client Support to
have the site setting set in their entity database.
Refer to the Expense: Audit Rules (Validation Rules) Setup Guide for more
information.
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Email Address Added to Cash Advance Pending Issuance Tab
Overview
Business Purpose
A new column, Email Address, is now
added to the Pending Issuance tab of
This enhancement helps the
Cash Advance Admin. Now, when the
administrator prevent cash advances
Cash Advance Admin role is issuing the
from being issued to the wrong
cash advance they can differentiate
employee.
between same-name employees with
the additional identifier of the
employee's email address within the displayed record.

What The User Sees
When the request is made for a cash advance the Cash Advance Admin opens Cash
Advance Admin from Expense Tools and clicks the Pending Issuance tab. After
performing a search for the employee, the details, including the new Email Address
column, are displayed as shown in the figure below:

Configuration
No additional configuration is required to use this feature.

Select Multiple Attendees From Different Pages
Overview
Business Purpose
A usability issue forcing the user
working with attendees to save each
This enhancement speeds the work of
attendee before exiting a page and
the user performing bulk actions on a
opening another is now resolved. Prior
group of attendees.
to this fix the user could work only
within a single page of attendee search
results before saving for addition or deletion all the attendees they had selected.
Now the user can select attendees and navigate from page to page to add additional
Release Notes
May 2011
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attendees. Then, when they perform the final action, all selected attendees are
resident and the action performed on the entire selected group.
This enhancement spans all related attendees pages, including the Search, Favorites,
and Recently User tabs, as well as the Attendees and Attendee Group tabs under
Profile > Favorite Attendees.

Configuration
No additional configuration is required to use this feature.

Concur Audit Service Can Now Send Back Selected Expenses
Overview
The Audit Team can now select expense
entries to send back to the employee
while allowing approved entries to move
forward in the workflow.

Business Purpose
This enhancement allows auditors to
focus on entries that fail audit and lets
the compliant entries move forward in
the workflow.

Commonly referred to as splitting the
report, this functionality allows the original report containing approved entries to
move forward in the workflow, while entries marked to send back are contained on a
new, system-generated addendum report. Please note the following about this
feature:
•

Auditor comments and audit exception category codes are only attached to
the Addendum report containing the entries sent back to the end user.

•

When the report is split, the addendum report returned to the employee
generates the billable audit instance. The original report moving forward in
the workflow has no audit billing impact.

•

The audit status of the sent back report is Failed.

•

Cognos Reporting will appropriately reflect the failed audit and related audit
exception categories associated with the Addendum report.

•

If the auditor chooses not to split a report the audit process remains exactly
as it is today.

Configuration
The Send Back Expense field must be configured on the report entry form and the
Expense Report Audit Service must be enabled. Contact Concur Client Services for
more information.

Release Notes
May 2011

Page 11

Concur Travel & Expense
Client-Facing

Requested Amount Column Added
Overview
The Requested Amount column has
been added to the Active Work and
Approval Queue sections on My
Concur, replacing the Total column.

Business Purpose
This usability enhancement helps users
to easily see the total cost of the
expense report to the company.

The requested amount is the sum total
of the amount to be considered as a business expense and is comprised of the sum
total of all expenses less any amounts marked as personal. This total better reflects
the costs to be addressed as business expenses for the company.

Requested Amount has also been added to the Active Reports and Reports to
Approve pages:

The report creator will see the Requested column when they view their expense
entries, and the total amount versus requested amount compared at the bottom:
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Configuration
No additional configuration is required to use this feature.

Attendee Required Fields Check on Use/Edit
Overview
The Attendee functionality has been
enhanced to verify the currently
required fields whenever an attendee is
added to an expense, or the attendee
details window is opened for edit of the
attendee record.

Business Purpose
This enhancement helps clients collect
newly required attendee information
when company policies change.

For example, if the Custom 1 field was not marked as required during the initial
implementation, some attendee records may not contain information in that field.
With this release, changing the Custom 1 field to required causes Expense to prompt
the user to enter the newly required information whenever they add an attendee to
an expense and click Save.
This check is only performed when the user is able to edit the attendee; the check is
not performed for attendee records maintained by the company and not modifiable
by the user.

Configuration
No additional configuration is required to use this feature.

Release Notes
May 2011

Page 13

Concur Travel & Expense
Client-Facing

Attendee Duplicate Check Can Be Expanded Across All Attendee Types
Overview
Previously, the Attendee duplicate
check functionality only examined
attendees of the same type. In the May
release, there is a new setting on the
Settings tab of the Attendees page in
Expense Admin that expands the duplicate

Business Purpose
This enhancement allows
administrators to widen the scope of
the duplicate attendee check.
check across all attendee types:

When this setting is selected, the attendee duplicate check looks across all attendee
types that the user has access to when the user adds an attendee.

Configuration
This optional setting is enabled as described above.

Additional Fields Added to Condition Editor
Overview
The condition editor available in Tax
Administration, Audit Rules, Processor
and other locations has been enhanced
with several additional fields.
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Expense related information:
•

•

•

A new Data Object, Entry Car, with the following fields:
♦

Car Criteria

♦

Vehicle ID

♦

Engine Size

♦

Energy

♦

CO2 Emission Rate

♦

First Date of Circulation

♦

Comp First Date of Circulation

♦

End Date of Circulation

♦

Registration Date

♦

Custom 01-05

New Report Entry fields:
♦

Tax Source

♦

Has User-Attached Receipt Image

Two new Company Card fields:
♦

Merchant Tax Number and

♦

Merchant Tax Class

Other information:
•

A new Employee field:
♦

City

Refer to the Expense: Audit Rules Setup Guide for more information.

Configuration
No additional configuration is required to use this feature.

New Location Type for the Locations Page and Locations Import
A new field – Location Type – has been added to the Location page and import.
The new field is used to distinguish between city, airport, and rail station locations.
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There are two location types:

•

•

Standard: This type includes:
♦

United Nations locations (generally cities)

♦

International Air Transport Association (IATA - airport) locations

Rail: Used to identify various rail vendors' train station codes (SNCF,
Deutsche Bahn, Amtrak, etc.) within a city

NOTE: Currently, only "standard" locations (UN locations and airport IATA locations)
can be added via the Locations page. Rail locations must be managed via
the Locations import. In an upcoming release, Rail will be added to the
Locations page.
The Location page and import are shared by Expense, Invoice, and Request.

Locations Page
The Shared Configuration Administrator role is required. This page can be access
using any of these:
•

Administration > Expense Admin

•

Administration > Invoice Admin

•

Administration > Request Admin

A new column appears on the Locations page.

Release Notes
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When adding or editing a location, note the following:
•

Currently, the only Location Type is Standard. Rail will be added in an
upcoming release.

•

The IATA Code field appears only when Standard is selected in the Location
Type field. Enter the IATA (International Air Transport Association) code.
For more information, refer to the Shared: Locations Setup Guide and the
Locations Import chapter of the Expense – Import and Extract Specifications.

Configuration
For more information, refer to the Shared: Locations Setup Guide and the Locations
Import chapter of the Expense – Import and Extract Specifications.

Module Property Controls Number of Concurrent Sessions for User
Overview
Business Purpose
A module property can now be
configured to disallow a user from
This enhancement ensures security
opening more than a set number of
compliance at the client site.
concurrent sessions. The default value is
"0", or OFF, which allows any number of
sessions to be initiated by any single user across the entire client site. Providing a
value, such as 2, restricts all users to 2 concurrent sessions before they encounter
an error message notifying them they are exceeding their session limit.

Using the Module Property
Clients wishing to establish a site-wide restriction on the number of concurrent
sessions the user can initiate will contact Concur directly and request the following
module property be changed:
Maximum concurrent login sessions per user (0=OFF)
Release Notes
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In use, the user who attempts to exceed the maximum number of sessions is
redirected back to their login page and the following error message is displayed on
that page:

Please note the following about this feature:
•

Login via a mobile device is not counted against the total open sessions count

•

Users who wish to have multiple windows open can do within the same
session in most browsers

•

A user should log out of a running session to access another session

•

Users who have left a browser open, without activity, will experience a 30 120 minute delay in timing out of that session and logging out

Configuration
The client will need to submit a Service Request to Client Support to change the
default value of "0" (OFF) to the number they wish to enforce at their site.

Client Preview: Concur User Interface Feedback
Overview
Beginning next month a feedback
questionnaire is included in the page
displayed when the user submits their
expense report or completes their
booking process. This is not a new
screen, this pop-up already appears today

Business Purpose
This enhancement allows Concur to use
customer feedback to improve our
products.
during the report submit action.

NOTE: Client information is not gathered using this questionnaire - it is for the sole
purpose of improving the product and no information will be shared to
existing clients or publicly.
The feedback questionnaire is shown in the figure below, within the Report Submit
Status page:

Release Notes
May 2011

Page 18

Concur Travel & Expense
Client-Facing

NOTE: The appearance for Travel users has not yet been determined.
Why Are We Doing This?
The inclusion of this feedback section lets the user provide feedback directly to
Concur at the time at which issues are clearest to them, and the task point at which
they are most likely to comment. The client is not required to provide feedback - this
task is optional.
See the Concur User Interface Feedback fact sheet for additional information.

Release Notes
May 2011

Page 19

Concur Travel & Expense
Client-Facing

Section 4: Jobs
The following features are included in this service release.

Update to the Standard Accounting Extract
Overview
The Authorization Request ID field is now added to position 239 of the Standard
Accounting Extract. This field allows clients to pass this data into their financial
systems.

Configuration
No additional configuration is required to use this feature.

Update to the Employee Import
Overview
The Employee Import is updated with changes to the following fields:
•

Level 400: Addition of the Travel Request roles

•

Level 700: REQ is now a valid approval type for the Approval Type field

•

Level 750: REQ is now a valid approval type for the Approval Type field

Configuration
No additional configuration is required to use this feature.
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Section 5: Documentation Updates
The following documentation changes are included in this service release.

Release Notes Now Available in Product-Specific Documents
Overview
Business Purpose
With this release the client can now
choose from product-specific release
Administrators can now build the set of
notes, each document or group of
release notes they need for their site
documents matching a specific Concur
without sorting through unnecessary
offering. Now, if one administrator is
material.
tasked with reviewing resolved issues,
they can download a document with only case information in it. The Invoice user can
download either Invoice release notes, or both Invoice and Mobile if that solution
applies to the client site.
How It Works - Concur Client Central
Beginning in April a table will now be displayed when the user logs in to Concur and
proceeds to Release Documentation > Release Notes using the Resources menu.
The design of the table allows the client to use the uppermost row of the table to
quickly identify their Concur product and what notes are applicable to their solutions:
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Each set of release notes include descriptions on the cover detailing what supporting
products can be found within the document. For example, the client who reviews
Expense Pay changes does so by downloading the Expense - Professional/Premium
release notes.
Help System Updates
The Concur administrative Help systems now include links to release notes as well.
When the user opens administrative Help (only), the leftside navigational area now
features the What's New link for the product release notes, plus additional links to
Mobile if that product is applicable to the solutions at the client site.

With this update the administrator can now avoid logging in to Concur Client Central
to view the release notes for their product(s).
Restrictions
To ensure security and "no see" restrictions, only the administrative Help systems
(Expense Tools; Expense Admin; Invoice Admin, etc.) contain the release note links no End User Help system allows viewing of the notes.

Configuration
No additional configuration is required to use this feature.
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Section 6: Supported Configurations
The following configurations are either supported or no longer supported with this
service release.

Certifications for This Release
Support for Google Chrome Version 11.0
Support for Google Chrome version 11.0 under both the Mac OS X and Microsoft
Windows operating systems is certified for this release.

Upcoming Certifications
Support for Mac OS X Lion
Support for Mac OS X Lion (version 10.7) will be included in an upcoming release.

Support for Firefox v. 5.0
Support for Firefox 5.0 will be included in an upcoming release.
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Legal Notice
This document contains proprietary information and data that is the exclusive
property of Concur Technologies, Inc., Redmond, Washington. No part of this
document may be reproduced, transmitted, stored in a retrievable system,
translated into any language, or otherwise used in any form or by any means,
electronic or mechanical, for any purpose, without the prior written consent of
Concur Technologies, Inc.
Information contained in this document applies to the following products in effect at
the time of this document's publication:
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The above product(s) and information contained in this document are subject to
change without notice. Accordingly, Concur Technologies, Inc. disclaims any
warranties, express or implied, with respect to the information contained in this
document, and assumes no liability for damages incurred directly or indirectly from
any error, omission, or discrepancy between the above product(s) and the
information contained in this document.
© 2004 – 2011 Concur Technologies, Inc., Redmond, Washington. All rights
reserved.
Concur® is the trademark of Concur Technologies, Inc. All other company and
product names are the property of their respective owners.
Published by Concur Technologies, Inc.
18400 NE Union Hill Road
Redmond, Washington 98052
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Finding Additional Product Release Notes
For Travel release notes, log in to Concur Client Central, then click Resources >
Document Library > Travel and then either TMC Partner or Direct Customers.
For all other products, log in to Concur Client Central, then click Resources >
Release Documentation > Release Notes to select and download additional
product-specific release notes matching your Concur solution(s):
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Section 1: Resolved Issues - Expense
Case ID

Case/Defect Description

101220001237

Product/Feature: Expense/Audit Rules
Description: The Editable By and Applies To columns in Audit Rules are
not sorting as they should.
Resolution: The code is modified to remove the restriction for sorting on
these specific columns. Up to this fix, these columns were excluded from
sorting by column.

101207000071

Product/Feature: Expense/User Interface
Description: The pop-up icon for a credit (lodge) card is the wrong color - it
should match the icon that displays on the Expense row.
Resolution: The code is modified to now use the correct color for the lodge
card icon.

101207001109

Product/Feature: Expense/Exceptions
Description: An Unexpected Software Error (UE) is generated when a reportlevel exception is thrown for a missing Fringe Benefit Tax ledger, expense
type, and attendee type combination where the exception text is over a
certain number of characters. Under these conditions the report cannot be
viewed at all; instead, a UE is generated.
Resolution: The code is modified to no longer include parameters in the
exception - these parameters were exceeding the maximum and causing the
XML to truncate.

110202000370

Product/Feature: Expense/Card Import
Description: A personal card import fails to upload expenses, in this case gas
expense files. The system is telling the user that these expenses are already
imported and associated with entries.
Resolution: The code is modified to add an additional check to the hash code
check since the hash code can be duplicated under certain conditions,
resulting in the error message stating the expense(s) is already imported.

110224000016
101109000595

Product/Feature: Expense/Attendees
Description: User is not able to select multiple names from different pages
when navigating Attendees and assembling a list of attendees to add or
delete.
Resolution: The code is modified to correct his behavior - the user can now
select attendees from different areas of the product and these are cached and
available for adding or deleting.

110124000998

Product/Feature: Expense/Processor
Description: Addendum Report is not created if the expense report is in a
status of Review.
Resolution: The code is modified to now carry over the parameters from the
first dialog box values to the second dialog box so that data from split entries
will be included in the split report.
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Case ID

Case/Defect Description

110304000308

Product/Feature: Expense/Forms & Fields
Description: When choosing from a list of fields to add to a form, some of
the selections are those that are already on the form - these should be
suppressed so that only fields not currently on the form are displayed.
Resolution: The code is modified to now add forms to the field list query so
that the stored procedure responsible for fetching the field set will not pass
any fields already resident on the form.

110311000290

Product/Feature: Expense/User Interface (Travel Allowance)
Description: Longer localized text strings, such as German language
translations, do not appear correctly as column headings, and the column is
not adjustable to fit the full string length of any language exceeding the
default column width.
Resolution: The code for the columns is modified to make them adjustable in
the new user interface.

110310000943

Product/Feature: Expense/Printed Reports
Description: The Key value is being displayed instead of the correct currency
name when attempting to print a report containing the employee's
reimbursement currency.
Resolution: The code is modified to suppress the Key value and instead force
the display of the currency value for Currency Name.

100928000928

Product/Feature: Expense/Report Creation
Description: The system is incorrectly saving the previously cached vendor
name when the user types in a different vendor name manually. The manually
typed name should be saved and displayed by the system instead.
Resolution: The code is modified to add additional validations to ensure that
the vendor name is populated correctly from either the list or from the manual
entry typed by the user.

110328000954

Product/Feature: Expense/Forms
Description: An Employee Form name that exceeds the display area
available in the drop-down list in Group Configurations does not appear at all
in the list under Internet Explorer.
Resolution: The code is modified to change the width of the drop down Form
list box to accommodate the length of the form name.

110224000794

Product/Feature: Expense/Entry Comments
Description: Supplemental comments viewed under Previous Comments
are viewable randomly - these comments will appear in some expense
reports, but not in others.
Resolution: The code is modified to prevent the query that gets the report
entry form from including the entry comment on the paid report - this causes
the comment to now appear correctly, under Previous Comment.
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Case ID

Case/Defect Description

110325000439

Product/Feature: Expense/Tax Administrator
Description: Adding a new Reclaim condition in Tax Admin causes the
Otherwise condition to no longer automatically reset itself to Always when all
other criteria are deleted.
Resolution: The code is modified to no longer rely on the execution order of
the record sets as was used in the classic interface. Now, a condition count is
added to the reclaim rate configuration and reclaim configuration records to
ensure that Always or Otherwise will display correctly.

110203000225

Product/Feature: Expense/Groups
Description: The Employee Group Configuration drop-down list is
incorrectly appearing for the Travel-only user - it should only appear for roles
associated with Invoice and Expense.
Resolution: The code is modified to display or hide the drop-down list based
on whether an Expense, Invoice, or Approver role is selected for the user.

110322000995

Product/Feature: Expense/Company Car
Description: Users are incorrectly able to modify the criteria type for an
existing variable rate personal or company car.
Resolution: The code is modified to no longer overwrite the read-only stat of
CriteriaKey.

110404000056

Product/Feature: Expense/Travel Allowance
Description: A Travel Allowance configuration assignment set of 10 or more
will not appear under Internet Explorer version 7.0 or 8.0. When the user
returns to the page, none of the configuration assignments are displayed.
Resolution: The code is modified to now convert the synv_guide to a hex
string. This resolves the issue where stored procedures converted these
values into a varchar, which as non-ASCII characters cause Internet Explorer
to be unable to display the json record set.

101212000038

Product/Feature: Expense/Auditor
Description: Comments entered by the Auditor are not visible - they are not
being displayed even though they have been entered.
Resolution: The code is modified to now also look for comments stored in
CT_AS_BILLING - this is where the auditor's comments are stored.

110311000122

Product/Feature: Expense/Groups
Description: After verifying a tax group that has an end date associated with
it, the Next button is incorrectly greyed out and inactive. The problem is that
under certain circumstances the end date value from the previously-viewed
group was not being cleared, resulting in a new start date that made the form
invalid and the Next button inoperative.
Resolution: The code is modified to clear the minValue and maxValue for the
start date prior to loading the new record.
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Case ID

Case/Defect Description

110316000260

Product/Feature: Expense/Itemizations

110401000747

Description: A user using Internet Explorer v. 8.0 who has fully itemized the
room rate expense is not correctly returned to the Add New Expense tab;
instead, the system incorrectly determines that they need to continue
itemizing the room rate itemization and returns them to the Add Itemization
tab.
Resolution: The code is modified to correct a timing issue specific to this
browser that results in skipping the logic that would cause the system to
return the user to the Add Itemization tab.

110404000403

Product/Feature: Expense/Smart Expenses
Description: Smart Expense is not allowing import of charges under Internet
Explorer v8.0. The problem is a character, "<", that is incompatible with the
grid creation and results in the inability to select the specific trip and, when
selecting the segment, results in a javascript error.
Resolution: The code is modified to now correctly parse any Trip Name value
that includes the "<" character.

110330000669

Product/Feature: Expense/Tax Administrator
Description: The Tax Administrator (Restricted) role is unavailable in the new
interface - it was available in the classic user interface.
Resolution: Clients are advised to submit a Service Request that a Role
Builder role be created for their entity that includes the specific attributes of
this role. This role will not be available as an assignable role - it must be
created specifically for the client.

110406000295

Product/Feature: Expense/Audit Rules
Description: Attempting to save an expense report entry that lacks a
transaction date at a site using the Duplicate Transaction audit rule results in
an error message.
Resolution: The code is modified to fix the cache key logic within the
getEntriesForComparison method so that it will now handle dates with a NULL
value and cause the expected Required Fields error to display instead.

110413000029

Product/Feature: Expense/Test User
Description: The Test User transaction purge action is not working.
Resolution: The code is modified to now correct a problem with removing
test data from attendee group tables.

110329001027

Product/Feature: Expense/Car Mileage
Description: Deleting a single personal car waypoint entry results in all
waypoint entries being deleted from the database for that personal car.
Resolution: The code is modified to now delete only the waypoint record
belonging to the specific entry, and not all records that belong to the report
itself.

110419000032

Product/Feature: Expense/Company Car
Description: The Next button is incorrectly greyed out and unavailable when
setting a single rate for a personal car.
Resolution: The code is modified to remove a call that was causing disabled
fields in the current page to be re-enabled, thereby causing the Next button
to become inactive until the disabled fields were provided with a value.
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Case ID

Case/Defect Description

110414001156

Product/Feature: Expense/Delegates
Description: An error message is generated when attempting to select the
Receives Approval Emails check box for a new or existing delegate.
Resolution: The code is modified to correct an undefined check box object
issue by adding a variable.

110418000634

Product/Feature: Expense/Test User
Description: A Test User admin can see non-test cash advance requests,
while regular users can see cash advance test data as well.
Resolution: The code is modified to now restrict both test and non-test Cash
Advance users from seeing each other's data.

110418001322

Product/Feature: Expense/Printed Reports
Description: The Show Itemizations check box is not appearing when
selecting Print Page from the Final Review window. This window appears
when submitting the expense report and attempting to print the detailed
report type.
Resolution: The code is modified to now pass the required parameters
correctly to the Final Review window.

110418000090

Product/Feature: Expense/Workflow
Description: A user prompted for workflow after submitting their expense
report (claim) sees that the Per Diem value is reset to the amount of zero
("0").
Resolution: The code is modified to now use the correct amount column
when updating the parent entry icons and fields on submission of the report.

110413001062

Product/Feature: Expense/Credit Cards
Description: Saving a payment type of CBCP is causing the database to flip
the offsets to ON even after the client has turned offsets to OFF. As a rule,
Expense does not support CVCP without offsets.
Resolution: The code is modified to prevent the offset change for payment
types of CBCP, IBCO, or COPD. However, the client creating these payment
types will need to contact Concur to request a feature request that supports
CVCP without offsets.

110411000239

Product/Feature: Expense/Localization - Chinese
Description: Selected Chinese translations are not displayed in the Profile
user interface - these reside in the database and were not included in the last
update.
Resolution: These translations will be included in this release.

110418001288

Product/Feature: Expense/User Administration
Description: Expense assigned roles and other attributes are not saved to a
new user when saving and reopening the user for additional modifications.
Resolution: The code is modified to fix the order in which parameters are
called - this will now match the function parameters that insert and retain
attributes for the new or modified user.
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Case ID

Case/Defect Description

110425000216

Product/Feature: Expense/Processor
Description: The Has Comments icon is not appearing for expense reports
marked by the Processor as Requires Review and Review Complete - the icon
should be appearing under these conditions.
Resolution: The code is modified to now show the icon by ensuring the
report has at least one comment with is_latest = Y. The tooltip will show this
last comment if hovered over using the mouse.

110426000273

Product/Feature: Expense/Attendees
Description: An Unexpected Software Error (UE) is generated when
attempting to reduce the approval amount on an authorization request.
Resolution: The code is modified to update the Authorization Request
Administrator for the
Attendee History feature - this was not done when the feature was released.

110421000321

Product/Feature: Expense/Delegates
Description: The Delete inactive delegates/delegators button is
nonresponsive and does not appear to remove inactive delegates and
delegators from the list of available delegates.
Resolution: The code is modified to no longer lock delegates from selection
and to add a timer so that the user knows the system is busy performing the
task.

110420000307

Product/Feature: Expense/Processor
Description: Random display of buttons, such as OK and Close, is shown
when processing an expense report.
Resolution: The code is modified to no longer use the same code
identification for a button across different dialog boxes in order to prevent the
buttons from random display based on what dialog box the system is
displaying.

110501000002

Product/Feature: Expense/Lists
Description: Performing a List import causes an Unexpected Software Error
(UE); however, the list is successfully uploaded.
Resolution: The code is modified to change the error index so that the final
record in the import will no longer throw a UE based on an index out of range
error.

110414000908

Product/Feature: Expense/Audit Rules
Description: A disproportionate number of expense reports are being flagged
for random audit if the client has Prompt For Approval workflow and Random
Audit Event = Submit. When the user is prompted for an approver and clicks
Submit, the random audit evaluation is triggered, causing a second random
audit evaluation.
Resolution: The code is modified to randomly flag the report for audit based
on the initial submit event and to ignore any subsequent submit events
associated with prompt for approver functionality.
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Case ID

Case/Defect Description

110407000395

Product/Feature: Expense/Printed Reports
Description: The incorrect currency is displayed for the credit card
transaction currency.
Resolution: The code is modified to show the correct credit card transaction
currency.
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Section 2: Documentation Updates
The following documentation changes are included in this service release.

Release Notes Now Available in Product-Specific Documents
Overview
Business Purpose
With this release the client can now
choose from product-specific release
Administrators can now build the set of
notes, each document or group of
release notes they need for their site
documents matching a specific Concur
without sorting through unnecessary
offering. Now, if one administrator is
material.
tasked with reviewing resolved issues,
they can download a document with only case information in it. The Invoice user can
download either Invoice release notes, or both Invoice and Mobile if that solution
applies to the client site.
How It Works - Concur Client Central
Beginning in April a table will now be displayed when the user logs in to Concur and
proceeds to Release Documentation > Release Notes using the Resources menu.
The design of the table allows the client to use the uppermost row of the table to
quickly identify their Concur product and what notes are applicable to their solutions:
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Each set of release notes include descriptions on the cover detailing what supporting
products can be found within the document. For example, the client who reviews
Expense Pay changes does so by downloading the Expense - Professional/Premium
release notes.
Help System Updates
The Concur administrative Help systems now include links to release notes as well.
When the user opens administrative Help (only), the leftside navigational area now
features the What's New link for the product release notes, plus additional links to
Mobile if that product is applicable to the solutions at the client site.

With this update the administrator can now avoid logging in to Concur Client Central
to view the release notes for their product(s).
Restrictions
To ensure security and "no see" restrictions, only the administrative Help systems
(Expense Tools; Expense Admin; Invoice Admin, etc.) contain the release note links no End User Help system allows viewing of the notes.

Configuration
No additional configuration is required to use this feature.
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Legal Notice
This document contains proprietary information and data that is the exclusive
property of Concur Technologies, Inc., Redmond, Washington. No part of this
document may be reproduced, transmitted, stored in a retrievable system,
translated into any language, or otherwise used in any form or by any means,
electronic or mechanical, for any purpose, without the prior written consent of
Concur Technologies, Inc.
Information contained in this document applies to the following products in effect at
the time of this document's publication:

Travel & Expense, May 2011

The above product(s) and information contained in this document are subject to
change without notice. Accordingly, Concur Technologies, Inc. disclaims any
warranties, express or implied, with respect to the information contained in this
document, and assumes no liability for damages incurred directly or indirectly from
any error, omission, or discrepancy between the above product(s) and the
information contained in this document.
© 2004 – 2011 Concur Technologies, Inc., Redmond, Washington. All rights
reserved.
Concur® is the trademark of Concur Technologies, Inc. All other company and
product names are the property of their respective owners.
Published by Concur Technologies, Inc.
18400 NE Union Hill Road
Redmond, Washington 98052
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Release Notes – June 2011
Finding Additional Product Release Notes
For Travel release notes, log in to Concur Client Central, then click Resources >
Document Library > Travel and then either TMC Partner or Direct Customers.
For all other products, log in to Concur Client Central, then click Resources >
Release Documentation > Release Notes to select and download additional
product-specific release notes matching your Concur solution(s):

Section 1: Please Note the Following Alerts
Administration Functions at Parity to be Retired from Classic UI
Retired With the June Release
Beginning with the June release (June 17, 2011), functions at parity in the current UI
(listed below) will be retired from the classic UI.

VALIDATION RULES
Validation Rules for Expense Admin – now available in the current release.

Retired With the July Release
Beginning with the July release (July 22, 2011), functions at parity in the current UI
(listed below) will be retired from the classic UI.

LOCALIZATION EXPORT & IMPORT
Localization for Expense Admin – now available in the current release.
Release Notes
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CASH ADVANCE ADMINISTRATOR
Cash Advance Administrator - now available in the current release

July Release Preview: French Language Review and Update
Concur is reviewing all French language translations and updated string changes will
be introduced in the July service release (SU69).

July Release Preview: Japanese Language Review and Update
Concur is reviewing all Japanese language translations and updated string changes
will be introduced in the July service release (SU69).
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Section 2: Enhancements From Client Suggestions Forum
The following features were submitted using Concur's Suggestion service, available
via Concur's forums. They are now included in this service release.
•

Show Total Amount of Available Card Charges Per Card
A new row is now included in Card Registration and Charges that displays
in My Concur - this row details the total (aggregate) amount of charges on a
company card issued to the user.

•

Add a Line Break to an Expense Form
The user can now specify that a form field include a thin grey line directly
beneath it to separate elements of the form appearance.

•

Bank Account Number Field No Longer Forces Data Entry
On the Expense Pay, Employee Bank Information page found in My Profile
the Bank Account Number field will no longer cause the user to have to reenter the bank account number if any field other than this field is changed on
the form.

•

Darken the Highlighted Row Color
To provide clarity to the user interface, the color is now darkened for both
the Expense entry list and the Expense entry panel background
Each of the features in this section is described in brief here, and in more
detail in their respective sections within this document - if you need additional
information please refer to these sections.
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Section 3: Expense
The following features are included in this service release.

Integrated Users: Japanese Language Now Available in Travel
Overview
With this release, the Japanese
language is now supported in Travel.
A client who has set their language
to Japanese and is using both the
Expense and Travel (Integrated)
solutions will see all text in Japanese
across both products.

Business Purpose
This enhancement allows the user to work
with Concur products in the language of
their choice.

Configuration
Other than setting the language to Japanese, no additional configuration is required
to use this feature.

Optional Concur End User Feedback Survey
Overview

Business Purpose
Beginning this month, administrators
This enhancement allows Concur to use
are notified that a feedback
customer feedback to improve our
questionnaire can now be included in
products.
the Report Totals page that is
displayed when their users submit their
expense report. Participation is optional - the user does not need to respond.

Why Are We Doing This?
The inclusion of this feedback section lets the user provide feedback directly to
Concur at the time at which issues are clearest to them, and the task point at which
they are most likely to comment. No client information is gathered using this
questionnaire - it is for the sole purpose of improving the product and no client
information is shared outside of Concur whatsoever.

What the Administrator Sees
Following this service release, when the Expense Configuration administrator or
Expense Configuration (Restricted) administrator roles first log in they will see a pop
up message explaining the feedback survey and how they can participate (this is
shown in the figure below):
Release Notes
June 2011
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The administrator can choose between three options:
•

Yes: The feature is activated so that the survey will display for the end user,
and both the popup and the Concur Feedback link are removed

•

Maybe Later: The feature is not activated and the system will display the
popup again when the administrator next logs in

•

No: The feature is not activated and the pop up is permanently dismissed,
but the Concur Feedback link remains, allowing the administrator to
activate the feature at a future date

What the User Sees
When activated, the user submitting their expense report has the choice to
participate or not. They are first presented with the Report Totals page with a
Close button, allowing the user to simply ignore the survey and acknowledge the
report information:
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When the user decides to participate, and clicks any survey control button, the
window refreshes to instead show a Rate & Close button - again, the user simply
clicks the button to acknowledge the information - the system gathers the survey
information in the background and the user can immediately return to work:

Rollout and Communication Plan
Clients have been notified that this would be a mandatory feature through the April
and May client-facing release notes and client webinars. Since that time we have
decided to rollout the feature more slowly and allow clients to opt-in. This message
will be posted on the forums and in the client facing June release notes.

Configuration
Other than activating the feature, no additional configuration is required to use this
feature. However, the client will need to submit a Service Request if they wish to
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deactivate the feature should they have activated it using the Yes button and now
wish to reverse that decision.

TripIt Integration with Expense
With the June release, we are very pleased to announce the integration of TripIt Pro
with Concur Expense!

TRIPIT AND TRIPIT PRO
TripIt helps travelers organize all aspects of their travel – air, car, hotel, dining
reservations, activities, events, and more – and turn it into a single master itinerary.
TripIt Pro (available for purchase) does that plus automatically monitors travel
itineraries, providing mobile alerts, alternate flight options, airfare monitoring and
notification, frequent traveler point tracking, and automated trip sharing.
If an Expense client has purchased the Enterprise (company level) TripIt Pro, its
Expense users can then use One-Click or expense import to bring the TripIt Pro
itinerary into an expense report – automatically creating the appropriate expenses.

AVAILABLE TO ALL EXPENSE USERS
The integration is available if:
•

The client has any of the Expense offerings – (Premier/Premium, Standard, or
Breeze) – either standalone Expense or integrated Travel & Expense
– and –

•

The client purchases the enterprise version of TripIt Pro.

MORE INFORMATION ABOUT TRIPIT AND TRIPIT PRO
Additional information is available at http://www.tripit.com.

What the User Sees
Upon login after June 17, the user will see an alert on the top of the My Concur
page.
For integrated Travel & Expense users:
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For standalone Expense users:

If a user already has a TripIt account, the user clicks Sign-in:

NOTE: Users who are already linked to TripIt will receive TripIt Pro during their next
login.
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If the user does not have a TripIt account, the user clicks Sign-up. The user will be
sent a confirmation email with a link to validate the connection.

Then, after the user has created a TripIt itinerary, Expense will attempt to automatch the TripIt Pro itinerary information with existing card transactions (this does
not include e-receipts) using the Smart Expense logic. If a match is found, the user
will see the same Smart Expense confirmation he/she sees in Expense today. The
user can either confirm or decline the match.
The trip in the Trip List will show the TripIt logo:

Configuration
Clients who want to integrate Expense with TripIt will contact their Concur account
managers to purchase TripIt Pro.
When Concur receives the sales order, Concur will complete the activation.

Forms & Fields: Add a Line Break Divider After a Form Field
Overview
Business Purpose
One or more thin gray divider lines can
now be inserted within an expense
This enhancement allows customization
report header or expense entry form to
of the Expense forms.
separate areas of the form. This is done
by specifying that a line be included after a form field when configuring that field.
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Adding this line causes fields above and below to flow and resize together, but
prevents mixing of the fields when resizing the form.

Configuring the Form Field to Insert the Divider
To include a dividing line, the Expense Configuration administrator uses the Forms &
Fields tool in Expense Admin to select either the header or entry form under Form
Type. Opening the form displays the fields, any one of which can be selected and
configured for a line break:

Selecting the field for configuration (click Modify Form Fields) opens the Modify
Form Fields page, where the administrator selects the Has Line Separator After
This Field check box to include the dividing line immediately after the field:

The result of adding a line after Report Name on the Expense Header Form appears
as shown in the figure below:
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Refer to the Expense Forms and Fields Setup Guide for additional information.

Allow a Deleted Card Account to be Restored by the Card Admin
Overview
Business Purpose
The administrator can now elect to
restore a card account that they had
This enhancement grants the Card
previously deleted. This feature frees
admin greater control over the deletion
the administrator from having to contact
and restoration of their card accounts.
Concur to restore the soft-deleted
account, allowing sites that enable the Allow card accounts to be deleted setting
greater control over their card accounts.
NOTE: The Allow card accounts to be deleted checkbox setting on the Settings
tab must be selected for deletion and restoration functionality to be enabled.

Restoring a Card Account - How and What Happens
To restore a deleted card account the administrator first searches for the account(s)
to be restored. This is done by selecting the new Include Deleted Accounts check
box to ensure these account types are returned with the search query:

Once the query results are returned, confirmation of the card account status is noted
under the new Deleted? column in the account row:

The administrator will now select one or more accounts to be restored by clicking
them directly, then clicking Restore:

A confirmation dialog box appears - clicking Yes completes restoration:
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The account is now restored and is visible to either the assigned employee or as an
unassigned account to the administrator for future assignment.
In addition:
•

The existing values for Transaction Release Period are in effect if the card is
assigned to a user

•

Cash advance records (if applicable) are automatically created for cash
advance transactions existing at the time of deletion

Best Practice - Assigned Accounts and Transaction Date Assignment
To avoid inheriting existing card account transaction period dates that control what
transactions will now appear to the assigned user, consider unassigning the deleted
account prior to restoring it - this removes these date restrictions and associated
(re)creation of cash advances, allowing the administrator to reset these dates.
Refer to the Expense: Company Card Administrator User Guide for more
information.

Configuration
No additional configuration is required to use this feature.

Tax Administration: New Tax Configuration Options
Overview
The Tax Administration page in
Expense Admin has been enhanced with
the additional features to support
enhanced VAT tracking and reclaim.
These features support the Canadian
VAT and RITC requirements. The following

Business Purpose
These enhancements support more
VAT configuration options, including
Canadian VAT and RITC.
features have been added:

TAX AUTHORITIES
A new Tax Rate Type is now available, labeled Full. This tax rate type is used for
expense types that are intended to capture a separate VAT line item during
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itemization. Any expense types using this tax rate default to a 100% reclaim rate,
and the expense amount is used as the tax transaction amount for tax calculations.

The Tax Rate field now accepts negative values. This supports the Canadian RITC
tax refund, which allows users in British Colombia and Ontario to reverse part of the
HTC tax.

TAX & RECLAIM GROUPS
The Reclaim Extraction Factor field now allows a negative number. This supports
the Canadian RITC tax refund, which allows users in British Colombia and Ontario to
reverse part of the HTC tax.
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EMPLOYEE RELATED CONFIGURATIONS
The Extraction Factors column can now be used to select from the following three
options:
•

Not Used – Extraction factors are not used by this group.

•

Tax and Reclaim Amounts – Extraction factors are used to calculate tax
and reclaim amounts.

•

Reclaim Amount Only – Extraction factors are used to calculate reclaim
amounts, but are not used when calculating tax amounts.

Configuration
No additional configuration is required to use this feature.
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Total Amount for Company Card Added as a Row to My Concur
Overview
Business Purpose
When the user now logs in to Concur
and views My Concur, they will see a
This enhancement makes available
new row added to the Available
another view for card charges.
Company Card Charges section. This
row shows the total amount of available
charges that can still be added to the expense report (that is, not the balance due).

NOTE: One line is shown for each card issued to the user.

Configuration
No additional configuration is required to use this feature.

Audit Log Entry Created on Change of Approver
Overview
An Audit Trail event is now logged when
the default Approver is changed via
User Admin or Profile for expense
reports, cash advances, and invoice and
travel requests.

Business Purpose
This enhancement provides a historical
view of the approval actions.

This update lets the administrator view this activity by viewing the audit trail in the
system log under Integration Administrator.

Configuration
No additional configuration is required to use this feature.

Localization Export and Import Now Available in Current Interface
Overview
With this service release all functionality
for localizing Concur products is now
included in the new Current interface.
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Configuration
No additional configuration is required to use this feature.
Refer to Shared: Localization Setup Guide for more information.

Russian Printed Reports Changes
Overview

Business Purpose

Several changes requested by clients
are now implemented in the Russian
Printed Report feature.

This enhancement refines the
appearance of this printed report type.

These include:
•

Total Report Amount Claimed now appears 3rd line up from the bottom of the
first page

•

Total of all cash advances associated with the report now appear instead of
simply the utilized cash advance amount

•

The custom field generating Russian Name is now displayed (a site setting
determines which field the system looks to for this name)

•

The report key now appears on the first page

•

The approval date replaces report date

•

Cash Advance Return amount is moved from the Expense Entry section

Configuration
No additional configuration is required to use this feature.
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Condition Editor Operators
Overview

Business Purpose
Two weekday-related operators are
This enhancement expands the
now available in the condition editor
information available to administrators
for audit rules, workflow rules, and
when creating conditions.
email reminder rules. The Is On This
Day and Is Not On This Day
operators can be used to create rules about specific days of the week.

Configuration
No additional configuration is required to use this feature.
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Section 4: Expense Pay
The following features are included in this service release.

Payment Manager: Funding Account Page Updated
Overview
The Funding Account page in Payment
Manager has been updated to provide
some additional instruction to the
administrator:

Business Purpose
This enhancement provides more
guidance to the administrator when
creating a funding account.

Configuration
No additional configuration is required to use this feature.
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New Card Program Support
Overview
Expense Pay has been enhanced to
support the following card programs:

Business Purpose
This enhancement allows Expense Pay
to pay addition card program types.

•

Fifth Third Bank MasterCard US

•

JP Morgan Chase MasterCard
Euro

•

JP Morgan Chase MasterCard Switzerland

•

JP Morgan Chase MasterCard UK

•

Silicon Valley Bank MasterCard US
Refer to the Expense Pay – Professional Implementation User Guide for more
information.

Configuration
No additional configuration is required to use this feature.

Section 5: Documentation Updates
The following documentation changes are included in this service release.

Release Notes Now Available in Product-Specific Documents
Overview
Business Purpose
With this release the client can now
choose from product-specific release
Administrators can now build the set of
notes, each document or group of
release notes they need for their site
documents matching a specific Concur
without sorting through unnecessary
offering. Now, if one administrator is
material.
tasked with reviewing resolved issues,
they can download a document with only case information in it. The Invoice user can
download either Invoice release notes, or both Invoice and Mobile if that solution
applies to the client site.
How It Works - Concur Client Central
Beginning in April a table will now be displayed when the user logs in to Concur and
proceeds to Release Documentation > Release Notes using the Resources menu.
The design of the table allows the client to use the uppermost row of the table to
quickly identify their Concur product and what notes are applicable to their solutions:
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Each set of release notes include descriptions on the cover detailing what supporting
products can be found within the document. For example, the client who reviews
Expense Pay changes does so by downloading the Expense - Professional/Premium
release notes.
Help System Updates
The Concur administrative Help systems now include links to release notes as well.
When the user opens administrative Help (only), the leftside navigational area now
features the What's New link for the product release notes, plus additional links to
Mobile if that product is applicable to the solutions at the client site.
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With this update the administrator can now avoid logging in to Concur Client Central
to view the release notes for their product(s).
Restrictions
To ensure security and "no see" restrictions, only the administrative Help systems
(Expense Tools; Expense Admin; Invoice Admin, etc.) contain the release note links no End User Help system allows viewing of the notes.

Configuration
No additional configuration is required to use this feature.
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Section 6: Supported Configurations
The following configurations are either supported or no longer supported with this
service release.

Certifications for This Release
Support for Google Chrome Version 12.0
Support for Google Chrome version 12.0 under both the Mac OS X and Microsoft
Windows operating systems is certified for this release.

Support for Google Chrome Version 11.0
Support for Google Chrome version 11.0 under both the Mac OS X and Microsoft
Windows operating systems is certified for this release.

Upcoming Certifications
Support for Mac OS X Lion
Support for Mac OS X Lion (version 10.7) will be included in an upcoming release.

Support for Firefox v. 5.0
Support for Firefox 5.0 will be included in an upcoming release.
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Legal Notice
This document contains proprietary information and data that is the exclusive
property of Concur Technologies, Inc., Redmond, Washington. No part of this
document may be reproduced, transmitted, stored in a retrievable system,
translated into any language, or otherwise used in any form or by any means,
electronic or mechanical, for any purpose, without the prior written consent of
Concur Technologies, Inc.
Information contained in this document applies to the following products in effect at
the time of this document's publication:
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The above product(s) and information contained in this document are subject to
change without notice. Accordingly, Concur Technologies, Inc. disclaims any
warranties, express or implied, with respect to the information contained in this
document, and assumes no liability for damages incurred directly or indirectly from
any error, omission, or discrepancy between the above product(s) and the
information contained in this document.
© 2004 – 2011 Concur Technologies, Inc., Redmond, Washington. All rights
reserved.
Concur® is the trademark of Concur Technologies, Inc. All other company and
product names are the property of their respective owners.
Published by Concur Technologies, Inc.
18400 NE Union Hill Road
Redmond, Washington 98052
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Finding Additional Product Release Notes
For Travel release notes, log in to Concur Client Central, then click Resources >
Document Library > Travel and then either TMC Partner or Direct Customers.
For all other products, log in to Concur Client Central, then click Resources >
Release Documentation > Release Notes to select and download additional
product-specific release notes matching your Concur solution(s):
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Section 1: Resolved Issues - Expense
Case ID

Case/Defect Description

110112000981

Product/Feature: Expense/Delegates
Description: A security breach error message displays in the credit card
window of personal profile when a delegate chooses an Expense-only user to
delegate for.
Resolution: The fix for this issue is to continue to show the credit card
window for Travel users but no longer base the display on the module
property.

110316000039

Product/Feature: Expense/Audit Rules
Description: The values appearing in the Audit Rules Condition Editor are
rendered as "Y" and "N" instead of Yes and No respectively.
Resolution: The logic in the midtier module is modified to match what is used
in the Expression Editor to correctly render the correct Yes or No value for the
data type.

110318000012

Product/Feature: Expense/
Description: Attempting to create an international single-day itinerary results
in an error message that includes a border crossing stipulation not relevant to
this interlinear type.
Resolution: The code is modified to set border crossing times to Back at
Origin for a single day itinerary's return journey leg.

110411000879

Product/Feature: Expense/Processor
Description: The Processor is prevented from bulk-approving expense
reports in Approved & in Accounting Review status when some of the reports
employ standard processor workflow steps and others use ad-hoc processor
steps.
Resolution: Bulk approval is now supported if all of the selected expense
reports are in the same step or all are in a Processor step. To do this, the
Change Status window will now filter by approval status to sort common
reports.

110419000126

Product/Feature: Expense/Locations
Description: The system does not allow the administrator to edit the state or
province for a location after that location has been saved without a state or
province value.
Resolution: Changed the code to now use a query to determine if these fields
can be edited instead of the record values.

110420000361

Product/Feature: Expense/Localization
Description: Italian language translations are incorrect or mixed with English
language.
Resolution: The corrected Italian language strings are now imported into the
product.
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Case ID

Case/Defect Description

110425000214

Product/Feature: Expense/Delegates
Description: A delegate with approve and view images privileges cannot
access the Expense tab - it is not displayed.
Resolution: A fix in a prior release resulted in the Expense tab appearing
only for the Traveler role. The system now considers both Traveler and
Manager roles for the delegate in order to display the Expense menu.

110425000826

Product/Feature: Expense/Attendees
Description: The Attendee title field is not cleared after performing a search
for a specific attendee type that includes choosing the attendee title.
Resolution: The code is modified to now clear the list field if the target form
has the same field but is loading a different list key.

110426000553

Product/Feature: Expense/Configuration Report
Description: The configuration report is freezing and does not time out or
display an error message about its condition.
Resolution: An upper cap of the number of items to return is now set in the
system. That cap is 500.

110429000921

Product/Feature: Expense/Workflows
Description: An Unexpected Software Error (UE) is generated when
attempting to change Department Code and Allocation Code in the report
header.
Resolution: This issue was caused by a validation that was falsely detecting a
change in approval status. The validation now prepares the approval status
keys before comparing them to determine if a change has occurred.

110503000502

Product/Feature: Expense/Proxy
Description: A Proxy search results in no returned values and the Site
Settings link opens an error page.
Resolution: The issue is resolved by preventing the search criteria from
being set to the default employee ID.

110503000878

Product/Feature: Expense/Configuration Report
Description: Running Configuration Reports causes the system to become
nonresponsive and then log the administrator out of the application.
Resolution: This issues was caused by a trailing blank character in the
Condition table. This is now corrected.

110505000094

Product/Feature: Expense/Personal Car
Description: A deleted personal car variable rate is incorrectly still available
for use in report entries and in User Profile.
Resolution: The code is changed so that a link within the system must exist
for the car before the associated rate can be displayed.

110509001154

Product/Feature: Expense/Imaging
Description: A PDF containing a large number of receipt images cannot be
downloaded or emailed by the Processor.
Resolution: If the system encounters receipt images that collectively exceed
15MB in size an error message will now appear stating that the receipt images
could not be included in the PDF file.
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Case ID

Case/Defect Description

110509001309

Product/Feature: Expense/Expense Types
Description: After removing an expense type in Expense Types admin, the
removed expense type still appears in Accounting Administration as a valid
expense type for account code assignment.
Resolution: The code is modified to filter removed expense types from
Accounting Administration.

110509001309

Product/Feature: Expense/Expense Types
Description: An expense type that has been removed from the product still
appears in Account Admin.
Resolution: The code is modified to filter removed expense types from
Accounting Administration.

110510000790

Product/Feature: Expense/Forms & Fields
Description: A tooltip added to the Amount field in the Airfare module of the
Expense Entry form does not appear at all when using the form.
Resolution: The display of tooltips was not configured for this field - this is
now corrected.

110515000109

Product/Feature: Expense/Cash Advance
Description: Journal entries on a submitted report do not balance to the
approved amount for the entry made up of two cash advances. No offsets are
being created for the journal entries.
Resolution: This issue is resolved by not allowing the Cash Advance Return
and Currency Gain Loss entries to be mapped to IBCP cash advances, instead
mapping them to the next available cash advance.

110516000441
110518000210

110523000165

Product/Feature: Expense/Locations
Description: The country of Panama is showing up twice in the Country list
when creating an audit rule and using the helper pane to select a country.
Resolution: A reference in the Currency table to both PAB and USD was
causing the country to appear twice - the PAB is now removed.
Product/Feature: Expense/Printed Reports
Description: The printed report shows the incorrect amount on the printed
report if the employee is due a zero amount.
Resolution: The comparison code that checks the sum of expense entries
from the journals table was using wrong API when comparing. Fixed the code
so that the comparison is correct.

110523001344
110524000827

Product/Feature: Expense/Receipt Store
Description: Attempting to upload a file over 5MB to Receipt Store does not
generate an error message that the file exceeds file size restriction as
expected. Instead, the system cycles and no response is generated.
Resolution: The code is modified to now alert the user if the file exceeds the
5MB size limit.

110524000832

Product/Feature: Expense/Comments
Description: The Comment icon and associated text are not displayed to the
Approver.
Resolution: A fix to the comment report list query resolves this issue.
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Case ID

Case/Defect Description

110525000036

Product/Feature: Expense/Authorized Approver
Description: The Save button incorrectly remains inactive unless the user
selects either Exception Approval or Specify Approval Limit and the associated
currency.
Resolution: To allow the save of a zero limit the code is modified for the
Authorized Approver admin role to set this limit.

110525000635
110427000074
110525001421

Product/Feature: Expense/Printed Reports
Description: Detailed ListData output does not appear in the printed report if
certain fields are included in the report.
Resolution: The code is modified to correct the ListData output type.
Product/Feature: Expense/Authorized Request
Description: The system is not recognizing and saving the Authorization
Request value for an itemized hotel entry on a report that has multiple
authorization requests attached to it.
Resolution: Code checked in for the copy down functionality was not working
for older authorization requests. The logic for the copy down is now corrected.

110525001587

Product/Feature: Expense/Receipt Store
Description: Attempting to send any email address for verification that
includes an apostrophe results in an error message stating that the email
address is invalid.
Resolution: The apostrophe is now added as a valid character for any email
address submitted to Receipt Store for verification.

110527000484

Product/Feature: Expense/Cash Advance
Description: The system incorrectly disallows the use of locale-specific
decimal marks (in this case, the comma ",") for exchange rates in Cash
Advance admin.
Resolution: The system will now unformat the entered exchange rate in
order to evaluate it.
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Section 2: Resolved Issues - Jobs
Case ID

Case/Defect Description

110414000143

Product/Feature: Expense/Company Card Import
Description: Diverted transactions are visible to the employee prior to the
date the transactions are set to become visible to the employee.
Resolution: The code was modified so that the transaction status is based
on the effective date of the individual card account rather than the effective
date of the diversion account. This allows for improved ability to stage the
roll-out of card accounts and set the effective date for the cards into the
future.

110429000757

Product/Feature: Expense/Travel Integration
Description: Employee Export to Travel fails when mapped fields contain
invalid characters.
Resolution: The Employee Import was modified to log a warning if any
CUSTOM field contains characters that are invalid for Travel; the data is still
imported. The Employee Export to Travel was modified to not export CUSTOM
fields if they contain invalid characters; instead, a warning is logged.
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Section 3: Documentation Updates
The following documentation changes are included in this service release.

Release Notes Now Available in Product-Specific Documents
Overview
Business Purpose
With this release the client can now
choose from product-specific release
Administrators can now build the set of
notes, each document or group of
release notes they need for their site
documents matching a specific Concur
without sorting through unnecessary
offering. Now, if one administrator is
material.
tasked with reviewing resolved issues,
they can download a document with only case information in it. The Invoice user can
download either Invoice release notes, or both Invoice and Mobile if that solution
applies to the client site.
How It Works - Concur Client Central
Beginning in April a table will now be displayed when the user logs in to Concur and
proceeds to Release Documentation > Release Notes using the Resources menu.
The design of the table allows the client to use the uppermost row of the table to
quickly identify their Concur product and what notes are applicable to their solutions:
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Each set of release notes include descriptions on the cover detailing what supporting
products can be found within the document. For example, the client who reviews
Expense Pay changes does so by downloading the Expense - Professional/Premium
release notes.
Help System Updates
The Concur administrative Help systems now include links to release notes as well.
When the user opens administrative Help (only), the leftside navigational area now
features the What's New link for the product release notes, plus additional links to
Mobile if that product is applicable to the solutions at the client site.

With this update the administrator can now avoid logging in to Concur Client Central
to view the release notes for their product(s).
Restrictions
To ensure security and "no see" restrictions, only the administrative Help systems
(Expense Tools; Expense Admin; Invoice Admin, etc.) contain the release note links no End User Help system allows viewing of the notes.

Configuration
No additional configuration is required to use this feature.
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Release Notes – July 2011
Finding Additional Product Release Notes
For Travel release notes, log in to Concur Client Central, then click Resources >
Document Library > Travel and then either TMC Partner or Direct Customers.
For all other products, log in to Concur Client Central, then click Resources >
Release Documentation > Release Notes to select and download additional
product-specific release notes matching your Concur solution(s):

Section 1: Please Note the Following Alerts
Administration Functions at Parity to be Retired from Classic UI
Retired With the July Release
Beginning with the July release (July 22, 2011), functions at parity in the current UI
(listed below) will be retired from the classic UI.

LOCALIZATION EXPORT & IMPORT
Localization for Expense Admin – now available in the current release.

CASH ADVANCE ADMIN
Cash Advance Administrator for Expense Admin – now available in the current
release.
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July Release Update: French Language Review and Update
Concur reviewed all French language translations and updated string changes will be
introduced in the July service release (SU69).

July Mid-Release Update: Japanese Language Review and Update
Concur reviewed all Japanese language translations and updated string changes will
be introduced in an update following the July service release (SU69).

Release Notes
July 2011

Page 4

Concur Travel & Expense
Client-Facing

Section 2: Enhancements From Client Suggestions Forum
The following features were submitted using Concur's Suggestion service, available
via Concur's forums. They are now included in this service release.
•

Authorized Approver Filter for Insertion Within Workflow
Using an numeric level number, a user is now provided with a filtered set of
Authorized Approvers for insertion into workflow using this optional feature.

•

Canadian Tax Administration Enhancements
Two enhancements, negative tax support and a fully taxed rate, allows entry
of tax as an itemization.

•

Travel Allowance Usability Enhancements
Many enhancements were made to the Travel Allowance module of Expense refer to each enhancement below for more information.

•

Include the Middle Initial in Assign Account
The middle name, or initial, is now displayed in its own column when
assigning a card to an employee using the Assign Account with Name on
Card dialog box.

•

New User Admin Role Allows Editing But Prevents New User Creation
This new role is ideal for sites preferring that users performing ongoing
changes to employee permissions be secured from actually creating a new
user account.
Each of the features in this section is described in brief here, and in more
detail in their respective sections within this document - if you need additional
information please refer to these sections.
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Section 3: Expense
The following features are included in this service release.

New User/Employee Maintenance Role
Overview
Business Purpose
A new role is now available that allows a
user assigned the role to view and edit
This enhancement provides additional
existing user accounts, but not create a
security, control, and separation of
new user account. This new role is ideal
duties for user maintenance.
for sites seeking tighter fraud control.
With this change, the user is permitted to edit existing user accounts, but is secured
from creating a new user account.
This role is called Employee Maintenance as shown in the figure below:

What the User Sees
The user granted this role is prevented from viewing or using the Add New User or
Import Users links on the User Administration page, or the Save and New
button when working with existing user configuration data - they may change and
save the changes, but not add a new user.
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Special Handling - Overlapping Role Capabilities
A user granted the Employee Maintenance role and any role allowing broader user
changes, such as Employee administrator, will always have the broader privileges
available to them, and will not be restricted to the lesser role.
Refer to Shared: User Administration or Shared: User Import User Guides for
more information.

Middle Name or Initial Included in Assign Account Dialog Box
Overview
A new sortable column, Middle
Name, now displays either the
middle name or initial of the
employee to whom a card account is
being assigned.

Business Purpose
This enhancement provides additional
details of the employee which helps
accurate identification and reduces errors.

This addition to the Assign
Account with Name on Card dialog box ensures that the account is being assigned
to the correct employee by adding another variable to the identification process.

Release Notes
July 2011

Page 7

Concur Travel & Expense
Client-Facing

Configuration
No additional configuration is required to use this feature.

Card Import: Fleet Information Enhancements
Overview
The following additions for Fleet
Information data captured in the
card feed (where available) are
included in this service release:

Business Purpose
These enhancements leverage data that
can be extracted from the card feed for
the benefit of the user.

•

Fleet information (when
available) is now imported into Expense via the American Express GL 1025
card feed

•

When imported, Fleet information is grouped by currency code under
Identified Fleet Transactions and is available for review in the View Import
Log feature of the Import Run Summary page

•

A Level 3 pop up with Fleet data now appears with the Vehicle ID, Driver ID,
and Odometer data displayed in rows

Configuration
Some configuration may be required - consult your Concur administrator.

Additional Items Added to Flight Fee Type Selections
Overview
The user can now draw on additional
fee types when selecting the fee
from the Flight Fee Type dropdown
list. The additions are:
•

Ticket Change Fee

•

Onboard Entertainment

•

Priority Access

Business Purpose
This enhancement allows the user to be
more specific about the airline fee type
they include in their expense report.

The Airline Fee Type field is added to the entry header, and the field is available for
selection of the additional airline fee(s) encountered when selecting the Airfare
expense type. The user selects the fee directly from the field when creating the new
expense type as shown in the figure below:
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Configuration
No additional configuration is required to use this feature.

Receipt Store: Allow Delete and Attach in Magnified View
Overview
The Receipt Store now allows the
user to attach or delete an image in
the Receipt Store Gallery when the
image is opened in magnified
"zoom" mode. This is done using the

Business Purpose
This enhancement provides additional
flexibility when working with Receipt
Store Gallery images.

attach icon ( ) or the Delete link
as shown in the figure below:
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Configuration
No additional configuration is required to use this feature.

Authorized Approver – Filter by Workflow Step
Overview

Business Purpose
Currently, the system determines
This enhancement provides a simple way
the available authorized approvers
to limit the approvers available to a
based on criteria such as the
workflow step.
authorized approver hierarchy, the
limit assigned to the approver, the
range of rule exceptions, and workflow rule conditions. With this release, the
administrator can filter the available authorized approvers based on the workflow
approval step. For example, the company may want certain approvers at the first
approval step in the workflow but not at the remaining approval steps.

With this new filter, the company can assign a "level" number to a workflow step and
assign that same "level" number to an authorized approver. So, if the company
assigns level 1 to the first workflow approval step and assigns level 1 to each line
manager, then line managers are available as authorized approvers only for the first
approval step.
Administrators can use the new filter to enhance the company's existing
configuration or in lieu of the existing configuration. This new feature is simply a
filter that can be added at any workflow approval step.
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Example
As noted previously, Expense evaluates the hierarchy, all workflow conditions,
approver limits, and all other criteria to determine the appropriate approver. If there
is more than one matching approver, then the user selects between the available
approvers.
Now assume that instead of creating complicated workflows with intricate conditions
and other criteria, the company simply assigns levels to the workflow steps and to
the authorized approvers.
For example, the company assigns these levels to these workflow approval steps:

The company assigns these levels to the approvers:
Name

Level

John (default approver)

1

Fred

1

Crystal

2

Susan

3

Terry
Vic

3

In this case:
•

For the Line Manager step (1), both John and Fred can approve at level 1 but
since John is the default approver, then John is automatically selected as the
approver.

•

For the Country Manager step (2), Crystal is the only option.

•

For the HR Manager step (3), the user selects between Susan and Vic.

•

Since Terry is not assigned a level, then Terry will never be used in this
workflow.

Note the following:
•

Release Notes
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Not all workflow steps must be assigned a level. However, note that all
authorized approvers will be available for those steps not assigned a level
(assuming there is no other criteria to exclude the approver like limit,
exception, hierarchy, etc.). For example, if the final workflow step above (HR
Approver) was not assigned a level, then all approvers would be available.
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In summary:

•

♦

Approvers assigned a level can approve at the level they match.

♦

If every approval step is assigned a level but an approver is not assigned
a level or does not match any level, then that approver will not be
available in that workflow.

♦

If any approval step is not assigned a level, all approvers are available regardless of the level assigned to the approver (assuming there is no
other excluding criteria).

If an authorized approver must be available for more than one level (like
levels 1 and 2), then there must be two records for that approver – one for
each level.
IMPORTANT:
♦

Each section of the authorized approver hierarchy will accept only one
level per user, so each level must be assigned at different sections of the
hierarchy.

♦

The levels can be added to users via the Employee Import or the
Authorized Approver list (Administration > Expense Admin > Workflows >
Authorized Approver tab).

♦

Levels cannot be added to approvers via User Administration.

Configuration
If the client is interested in using this feature, the client can contact Concur Client
Support for assistance.
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Tax Administration Enhancements
Overview

Business Purpose

Two new options have been added to
tax administration to extend the
functionality. These changes are
primarily targeted at the tax tracking
requirements for Canada, though they
are not restricted for use only in Canada.

This enhancement brings additional
flexibility to the Canadian value-added
tax tracking.

NOTE: Clients with restricted or no access to the Tax Configuration module will need
to submit a change request to Concur Support to configure these new tax
options.

Negative Tax Rate (RITC)
The application now supports a negative rate and negative extraction factor. This is
intended to allow for calculation of RITC in the British Columbia and Ontario
provinces of Canada. The example below shows the resulting tax data for a gross
expense amount of $127.58 with 12% HST and RITC (former BC PST) of -7%:
•

HST = $13.67

•

RITC = ($3.99)

Negative rates are ignored in the calculation of the net expense amount of GROSS *
1/(1+sum of rates).

Configuration
1.
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On the Tax Authorities page under Expense Admin > Tax Administration,
add new tax authority and click Next.
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2.

Add a rate type of RITC for Tax Rate Type Name, and Percentage for
Calculation Method, then click Save.

3.

Add the rate of negative percent, then click Save to complete the tax
authority.

4.

On the Tax & Reclaim Groups tab, add a new tax group for the RITC tax
under Group Name. If extraction factors will be used, enter the factor as a
negative number, then click Next.

5.

Select the applicable expense types under Available Expense Types for this
tax group and then click Next.
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6.

Enter needed information for step 3, Tax Rates, selecting the rate type
created in step 2 (Expense Types).

7.

Complete the process with any needed conditions or codes for the final step
and then click Done.

NOTE: Validate that the financial system receiving this data from Concur is prepared
to handle the new RITC tax output rows.
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Fully (100%) Taxed Rate
The application now supports a fully taxed rate of 100%, which allows entry of the
tax as an itemization. This enables the new Hotel Wizard handling options as shown
in the figure below:

The result from the Hotel Wizard under this configuration is an itemized entry for
each date for the room rate, GST, QST, and the combined values of the other room
tax amounts.

Configuration
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1.

Add new expense type to use for tax itemizations (for this example, we have
added an expense type titled QST).

2.

Add new rate type to applicable tax authority and select the Calculation
Method value of Full.
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3.

Add a rate for the new rate type (the tax rate will automatically be set to
100%).

4.

On the Tax & Reclaim Groups tab, add new tax group under Group Name.

5.

Select the expense type created in step 1
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6.

Set any applicable conditions and set the rate type to the one created in Step
2.

7.

Set any applicable reclaim conditions and codes, and select Done.

8.

Verify that the room rate and room tax expense types are not configured to
calculate tax.

NOTE: Validate that the financial application receiving data from Concur is prepared
to handle the itemization rows and tax data for these new expense types.
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Audit Rules Enhancements
The following features are enhancements for the Audit Rules feature.

Booking Origin Entry Data Object
OVERVIEW
In order to determine what the
booking source was for a trip a new
Audit Rules entry data object,
Booking Origin, can be used.

Business Purpose
This enhancement expands the
information available to administrators
when creating conditions.

The example below will cause the
audit rule to fire if the trip was booked under TripIt:

CONFIGURATION
No additional configuration is required to use this feature.

Has Travel Request Entry Data Object
OVERVIEW
In order to determine if the expense
entry in an expense report is linked
to a travel request a new Audit
Rules entry data object, Has Travel
Request, can be used.

Business Purpose
This enhancement expands the
information available to administrators
when creating conditions.

The example below will cause the
audit rule to fire on save of the entry if the report includes an approved request that
was added to the report:
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CONFIGURATION
The Travel Request field must be added to the expense report header form - consult
your Concur administrator for additional information.
Refer to the Expense: Audit Rules Setup Guide for more information.

Travel Allowance Enhancements
The following features are enhancements for the Travel Allowance feature.

Lock Icon Helper Text Explains Edit Restriction
OVERVIEW
The lock icon that displays beside an
itinerary row and the Expenses &
Adjustments date row now features
a tooltip hover message that
explains its appearance. For users
unsure why they row is locked, the
text explains in detail the restriction the
expenses that are currently submitted.

Business Purpose
This enhancement helps clarify the reason
why an itinerary row is locked.
system places on itineraries with associated

The tooltip text appears in the Expenses & Adjustments step when viewing or
modifying data:
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...and in the Edit Itinerary or Available Itinerary pages as well:

Add URL and Tooltip Text to Travel Allowance Itinerary Header Form
OVERVIEW
The Expense Admin can now elect to
Business Purpose
add a client-specific URL and
matching link label to the Travel
This enhancement allows a company to
Allowance Itinerary header. This
provide site-specific advice, tips, or
allows the administrator to guide
training materials to the user.
their users to a custom web page
with site-specific information, such as portal-based guidelines or travel advisories as
examples.

HOW IT WORKS
To add the URL and associated label text, the administrator clicks Travel Allowance
under Expense Admin and opens an existing travel allowance configuration on the
Configurations tab. The External URL and External URL's Text options are
included in the Modify Travel Allowance Configuration window - these are used
to enter the client URL and label text for the URL as shown in the figure below:
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After configuring the URL and label, the user will see the additions when creating
their itineraries:

Please note the following when using this feature:
•

The URL is provided in http://www.yourdomain.com format

•

Clicking the link opens a new window and does not navigate the user away
from Expense

•

The URL appears only for the TA configuration assigned to the hierarchy - if
the user chooses a different hierarchy that does not have these options they
will not appear

Single Day Quick Entry Itinerary Now Shows 7 Days
OVERVIEW
With this release the weekly
Business Purpose
calendar that appears on the Single
Day Itineraries page now shows a
This enhancement lets the user see an
full week of 7 days instead of the
entire week at once for greater context
previous (default) Monday through
and speed of entry.
Friday 5-day span. The user can
elect to change the starting date using the Choose start date calendar option just
as before - only the number of rows representing the week has changed
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NOTE: This change does not alter the default starting date logic.

Highlight Already-Used Days When Creating Itinerary Rows
OVERVIEW
When a user creates an itinerary,
they select the dates of the itinerary
using a calendar view and the
system populates the itinerary
according to the date choice.

Business Purpose
This enhancement gives the user
graphical feedback on the dates available
for their itineraries.

With this release, as the user
creates their itinerary, each day already accounted for in an itinerary will now be
highlighted in the calendar view. This allows the user to quickly note what days have
been used and what days remain available.

User is Prompted to Delete Itinerary Linked to Expense Report
OVERVIEW
It is often forgotten that an itinerary
linked to an expense report being
deleted can be reused in a new
expense report. This can result in
locked dates for the user for those
dates set aside for the now-deleted
report.
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feedback that aids the user in
understanding how to work with Expense.

Concur Travel & Expense
Client-Facing

For this reason the user deleting the report will now see a prompt asking them if
they also wish to delete the itinerary linked to the report as shown in the figure
below:

Doing this forces the user to consider if they wish to save the itinerary for use in a
new report or elect to delete both report and itinerary. This change also reinforces to
the user that itineraries are separate items that can span several expense reports.

Informational Message Queries and Confirms on Long Itinerary Leg
OVERVIEW
When a user creating a single leg of
an itinerary enters departure and
arrival dates that span more than
four days, an informational message
will now appear as shown in the
figure below:

Business Purpose
This enhancement encourages the user to
check their work, preventing issues once
the report is submitted.

A typical business trip would not have the user in transit from one location to
another for more than 4 calendar dates. This type of error – either creating one row
to represent the entire trip or inadvertent use of the wrong year – is the most
common user error that results in locked or unavailable dates for future itineraries.
NOTE: This message will not appear if the company has disabled the single row
itinerary check, allowing their users to enter one row representing the entire
trip. (This option is not supported for all countries – please consult the
applicable travel allowance country configuration guide.)
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CONFIGURATION
For the Travel Allowance features described above, Travel Allowance must be
configured. Some features may require additional configuration - consult with your
Expense administrator for more information.
Refer to the Expense: Travel Allowance Setup Guide for more information
about the features described above.
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Section 4: Expense Pay
The following features are included in this service release.

Expense Pay Sweden Now Available
Overview
The Expense Pay product is now
available for clients in Sweden. This
release includes the following features:

Business Purpose
This enhancement expands the
European marketplace for Expense
Pay.

•

Localized Funding Account Bank
page

•

Localized Employee Bank Information page

•

The Excel Employee Import supports importing Swedish user bank accounts

•

The 810 record of the Employee Import supports importing Swedish user
bank accounts

•

Support for the following Swedish card programs:

•

♦

American Express SEK

♦

Citibank MasterCard SEK

♦

Citibank Visa SEK

Support for the following Swedish funding banks:
♦

Svenska Handelsbanken

♦

Danske Bank

Configuration
Client must contract for Expense Pay EMEA in order to be able to use Expense Pay in
Sweden.

Reimbursement Manager: Daily Funding Amount Page Change
Overview
Business Purpose
The Daily Funding and Returned
Amounts page has been modified to
This enhancement improves the page
improve performance. The Extracted
performance.
Amount and Not Extracted Amount
columns have been removed from the page. The data in those columns is available
by clicking the amount link in the Total Funding Amount and Returned columns.
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Configuration
No additional configuration is required to use this feature.

User Bank Account and Report Currency Must Match
Overview
Business Purpose
A new system audit rule has been
added that prevents report submission
This enhancement helps ensure that
if the Expense Pay user’s bank account
reports are paid by Expense Pay when
currency does not match the report
users change countries.
currency. This scenario can occur when
the Expense Pay user moves to another
country and submits a report in the new currency while the bank account in the old
currency is still active. This audit rule prevents report submission and prompts the
user to contact their Expense approvers to verify that all submitted reports in the old
currency have been processed before they deactivate the old account.

Configuration
No additional configuration is required to use this feature.

Reimbursement Manager: Retired Support for UK Funding Accounts
Overview
The support for UK funding accounts
has been retired from the
Reimbursement Manager tool in the
classic user interface. All funding
accounts should now be managed
within Payment Manager in the current
user interface.

Business Purpose
This change supports the Payment
Manager tool as the only location for
funding account information for UK
clients.

Configuration
No additional configuration is required to use this feature.
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Section 5: Documentation Updates
The following documentation changes are included in this service release.

Release Notes Now Available in Product-Specific Documents
Overview
Business Purpose
With this release the client can now
choose from product-specific release
Administrators can now build the set of
notes, each document or group of
release notes they need for their site
documents matching a specific Concur
without sorting through unnecessary
offering. Now, if one administrator is
material.
tasked with reviewing resolved issues,
they can download a document with only case information in it. The Invoice user can
download either Invoice release notes, or both Invoice and Mobile if that solution
applies to the client site.
How It Works - Concur Client Central
Beginning in April a table will now be displayed when the user logs in to Concur and
proceeds to Release Documentation > Release Notes using the Resources menu.
The design of the table allows the client to use the uppermost row of the table to
quickly identify their Concur product and what notes are applicable to their solutions:
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Each set of release notes include descriptions on the cover detailing what supporting
products can be found within the document. For example, the client who reviews
Expense Pay changes does so by downloading the Expense - Professional/Premium
release notes.
Help System Updates
The Concur administrative Help systems now include links to release notes as well.
When the user opens administrative Help (only), the leftside navigational area now
features the What's New link for the product release notes, plus additional links to
Mobile if that product is applicable to the solutions at the client site.

With this update the administrator can now avoid logging in to Concur Client Central
to view the release notes for their product(s).
Restrictions
To ensure security and "no see" restrictions, only the administrative Help systems
(Expense Tools; Expense Admin; Invoice Admin, etc.) contain the release note links no End User Help system allows viewing of the notes.

Configuration
No additional configuration is required to use this feature.
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Section 6: Supported Configurations
The following configurations are either supported or no longer supported with this
service release.

Certifications for This Release
Support for Google Chrome Version 12.0
Support for Google Chrome version 12.0 under both the Mac OS X and Microsoft
Windows operating systems is certified for this release.

Support for Google Chrome Version 11.0
Support for Google Chrome version 11.0 under both the Mac OS X and Microsoft
Windows operating systems is certified for this release.

Upcoming Certifications
Support for Safari 5.1
Support for Safari 5.1 under Mac OS X Lion (version 10.7) will be included in an
upcoming release.

Support for Mac OS X Lion
Support for Mac OS X Lion (version 10.7) will be included in an upcoming release.

Support for Firefox v. 5.0 and v.6.0
Support for Firefox 5.0 and 6.0 will be included in an upcoming release.
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Legal Notice
This document contains proprietary information and data that is the exclusive
property of Concur Technologies, Inc., Redmond, Washington. No part of this
document may be reproduced, transmitted, stored in a retrievable system,
translated into any language, or otherwise used in any form or by any means,
electronic or mechanical, for any purpose, without the prior written consent of
Concur Technologies, Inc.
Information contained in this document applies to the following products in effect at
the time of this document's publication:
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The above product(s) and information contained in this document are subject to
change without notice. Accordingly, Concur Technologies, Inc. disclaims any
warranties, express or implied, with respect to the information contained in this
document, and assumes no liability for damages incurred directly or indirectly from
any error, omission, or discrepancy between the above product(s) and the
information contained in this document.
© 2004 – 2011 Concur Technologies, Inc., Redmond, Washington. All rights
reserved.
Concur® is the trademark of Concur Technologies, Inc. All other company and
product names are the property of their respective owners.
Published by Concur Technologies, Inc.
18400 NE Union Hill Road
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Release Notes – July 2011
FOR CONCUR INTERNAL USE ONLY – DO NOT DISTRIBUTE OUTSIDE CONCUR

Finding Additional Product Release Notes
For Travel release notes, log in to Concur Client Central, then click Resources >
Document Library > Travel and then either TMC Partner or Direct Customers.
For all other products, log in to Concur Client Central, then click Resources >
Release Documentation > Release Notes to select and download additional
product-specific release notes matching your Concur solution(s):
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Section 1: Resolved Issues - Expense
Case ID

Case/Defect Description

110117000056

Product/Feature: Expense/Validation Rules
Description: A Custom field type updated to a Date type field results in the
incorrect format in the database. The extract can then fail on export, causing
issues when attempting to display the field.
Resolution: The code is modified to now note if the source field is a date field
and if it is to format into the custom date field format before updating.

110318000012

Product/Feature: Expense/Travel Allowance
Description: An error message appears when attempting to create an
international single day itinerary in the Single Day Itinerary page. The page
does not have the border cross time field to change, resulting in the user
being unable to create the itinerary.
Resolution: The border crossing was being converted to the arrival location.
The code is modified to set the border crossing time to Back at Origin for the
return journey.

110401000747
110316000260

Product/Feature: Expense/Itemizations
Description: The Add Itemization tab is incorrectly displaying when the
Add New Expense tab should instead appear. This is happening when
finalizing an overall itemization in the Hotel wizard that has up to 24 different
itemizations.
Resolution: The correct tab is now displayed based on full itemization of the
parent entry.

110408000032

Product/Feature: Expense/Localization
Description: User is prevented from changing the field names of fields whose
field names have not yet been changed (that is, have a value of NULL in the
table).
Resolution: The code is modified to now fall back to the column metadata
when querying form field labels to display whenever a NULL value is
encountered for the _lang value.

110411000334

Product/Feature: Expense/Cliqbook Integration
Description: The Travel Manager is not being included in Authorized
Approver workflow when that manager has been changed using options in the
classic interface.
Resolution: The code is modified to ignore changes made to the manager in
the classic interface on extract (Cliqbook User Sync service) - this retains the
Travel Manager in the user's workflow.

110415000755

Product/Feature: Expense/Forms & Fields
Description: User cannot save a change to a field name on the Field tab - it
does not "take" and the original value remains.
Resolution: The code is modified to allow changing of an existing field that is
over 64 characters with a new string. Restricted input of any new value that
exceeds 64 characters.
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Case ID

Case/Defect Description

110504000726

Product/Feature: Expense/User Interface
Description: Under the Google Chrome browser, selected page views are not
properly aligned in the user interface. Issues include:
•

Proxy logon results appear out of the page, with a scroll bar appearing
where, in other browser, this displays correctly

•

Roles assigned to a user do not appear with the entire result box visible

Resolution: The code is modified to force the popup into the visible page
area for all menu types, not just a right-click context menu.
110519000226

Product/Feature: Expense/Workflow
Description: The value under the Editable by Group(s) column for Auto
Approved is appearing twice, as "Global Global" where all others appear
correctly (that is, once).
Resolution: The column was including both the Expense and Invoice values,
resulting in two displayed names. The approval status group query is now
changed to correct this issue.

110523001616

Product/Feature: Expense/Feature Hierarchies
Description: The administrator searching for hierarchies using the Feature
Hierarchy link is provided no indication the system is searching, and usually
browses away from the page as the system is returning the list. There is no
visual indicator that lets the admin know the system is collating the result set.
Resolution: A loading wheel (spinning icon) is now added to the interface as
an indicator that the system is working on returning the result set for the
hierarchies.

110526000512

Product/Feature: Expense/Attendees
Description: The system is performing a required fields check that is
incorrectly including the Created By fields - these fields should never be
considered in this system check.
Resolution: The "Created By (Private List)" Attendee field types are now
excluded from the Required Fields system check.

110527000968

Product/Feature: Expense/Audit Rules
Description: The system is incorrectly limiting comparison against the value
in the Receipt Status entry field to Field Validation Flag fields - all others are
ignored.
Resolution: An additional, third value is now compared in validation for the
entry/receipt status for the expense report.

110527000981

Product/Feature: Expense/Attendees
Description: A user is not being added as the default attendee even when
Include user as an attendee by default is set to True and the global setting
Attendees > Allow automatic creation of employee as attendee is selected.
Resolution: The code is modified to now retain system attendee type values
that were being deleted and causing this issue. Migration will resolve the two
attendee types deleted from the Config table for any databases with this
condition.
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Case ID

Case/Defect Description

110527001215

Product/Feature: Expense/Test User

110613000611
110620001500
110531000368

Description: The Test User feature does not allow Authorized Approvers to
be added to the system.
Resolution: The code is modified to allow Authorized Approver view, edit,
and create without regard to the Test User database attribute.
Product/Feature: Expense/Attendee Import
Description: The Attendee import function is slow to respond. It appears to
be building a list for the administrative role even though the user does not
have that role assigned to them.
Resolution: The code is modified to create this list without regard to role.

110531000826

Product/Feature: Expense/Attendees
Description: A submitted expense report in workflow is being flagged for
missing a required field when the change to make that field required occurred
after the report was submitted. In this case, the change to the field should not
be extended to those reports already submitted.
Resolution: The code is modified to now skip the required field check if the
expense report is already submitted.

110531001422
110602000441

110601001677

Product/Feature: Expense/Workflow
Description: The list returned for the list of Authorized Approvers causes the
browser to become unresponsive.
Resolution: The code is modified to cap the return number is now set to 500,
and an additional filter is added to help the user narrow down the list set.
Product/Feature: Expense/Authorization Request
Description: The system does not appear to be saving and recognizing the
Authorization Request value for an itemized hotel entry on a report that has
multiple authorization requests attached to it. This is preventing users from
attaching multiple authorization requests to an expense report when there are
itemized expenses within the report.
Resolution: The copy down code was not working for older authorization
requests. This logic is now corrected to resolve the issue.

110603000046

Product/Feature: Expense/Car Mileage - Text
Description: Incorrect user interface text "This page displays all the personal
cars that have been registered" in the Company Car Registration page is
causing confusion as company cars should be included in the text.
Resolution: The text for each car option, personal or company, is now
displayed on the respective page.

110604000060

Product/Feature: Expense/Workflow
Description: An Unexpected Software Error (UE) is generated when the
Processor clicks the Approve link for an expense report with Cost Object
workflow.
Resolution: The report was prevented from moving forward in workflow due
to cost objects that had been soft deleted. The issue is resolved by creating a
specialized version of the system validation that allows soft deleted hierarchy
nodes to be maintained if the hierarchy is an expense cost object type of
hierarchy.
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Case ID

Case/Defect Description

110609000854

Product/Feature: Expense/Workflow (Admin)
Description: Changes to a workflow step rule made in the Copy Workflow
wizard are incorrectly being applied to the original workflow as well as the
new copy of the workflow. Changes should only apply to the new, copied,
version.
Resolution: The midtier logic is now changed to skip deleting rules and
actions when saving a copied workflow.

110610000604

Product/Feature: Expense/Authorization Requests
Description: Hotel tax itemizations created on copy down from a hotel
expense tied to an Authorization Request do not have the Authorization
Request field filled in.
Resolution: The code is modified to now force the copy down action of the
Authorization Request to child entries for all entries created using the Hotel
wizard.

110610000672

Product/Feature: Expense/User Admin
Description: The system cannot search for a user with an apostrophe in their
full name.
Resolution: The search function is modified to now prevent a search only on
those names with a trailing space - apostrophes are now searchable.

110610001073
110622000651

110616000434

Product/Feature: Expense/Printed Reports
Description: An Unexpected Software Error (UE) is generated when
attempting to copy an existing Print Format or create a new print format.
Resolution: A corruption of the NEXT_ID is responsible for this condition.
Preventative code is now checked in to prevent this situation by resolving it
when the new print format is initially saved.
Product/Feature: Expense/Cost Object Workflow
Description: The Employee administrator is prevented from modifying the
approval limits for a user from User Administrator or Authorized Approver
Limits - all controls are inactive to perform this task.
Resolution: The code is modified to allow the Restricted Configuration admin
roles (Expense, Invoice, and Travel) to edit the authorized approver for
approval limits.

110617000005

Product/Feature: Expense/Company Cards
Description: Unprintable characters in the XML file cannot be rendered for
display in the Manage Account and Manage Transactions pages.
Resolution: To resolve this issue the "?" character is used to replace the
unprintable characters and is then translated prior to display in the user
interface.

110624001141

Product/Feature: Expense/Company Cards
Description: An Unexpected Software Error (UE) is generated when
attempting to import a foreign credit card for which there are no country sub
codes for an expense report whose form has hidden these same fields. What
is happening is that, instead of a NULL value, the system is inputting
"undefined" and the UE is generated.
Resolution: The code is modified to add a check to ensure the system is not
passing NULL or empty strings when no country sub code exists.

Concur Release Notes
July 2011

Page 6

Resolved and Known Issues Case List
Concur Clients

Case ID

Case/Defect Description

110630001081

Product/Feature: Expense/Delegates & Proxy
Description: A Proxy is shown the identical expense reports listed in two
rows in the report list window on the home page. When navigating to the
Report List page, only one expense report appears.
Resolution: A join was resulting in a duplicate report return and display. The
code is modified to add a select max clause on the auditor billing comments
table to prevent this join.
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Section 2: Resolved Issues - Jobs
Case ID

Case/Defect Description

110427000071

Product/Feature: Jobs/Company Card Import
Description: Certain Bank of Scotland Cash Advance Fees are hidden upon
import.
Resolution: Modified the MasterCard CDF 3.0 importer to recognize
AdjustmentReasonCode value of 803380 as a Cash and Check Fee. The
visibility of these charges will be based on the card’s configuration.

110622000610

Product/Feature: Jobs/Company Card Import
Description: Card transactions with Purchasing addenda data are not
qualifying as having Rich Data when expected.
Resolution: Modified the code to include the Total Line Item Amount rather
than Extended Line Item Amount for the definition of Rich Data for purchase
transactions.

110330001194

Product/Feature: Jobs/Extracts
Description: Month in USD custom extract is sometimes converting the
Month (MON format) to German.
Resolution: Modified the extract code to use the language selected on the
Add/Edit Extract Definition when formatting dates, rather than the default
language configured on the batch server.

110420000119

Product/Feature: Jobs/Employee Import
Description: The link provided in the employee import email notification that
should take the user to the job detail information in Integration Administrator
does not work.
Resolution: Removed code that was preventing URL parameters from being
added for SSO.

110422000220
110608000421

110518000758

Product/Feature: Jobs/Extracts
Description: The extract output included a list item key rather than the list
item value.
Resolution: The code was modified to retrieve the list item value directly
from the database rather than a current cache. The code was also changed to
report an error if the list item is invalid.
Product/Feature: Jobs/Company Card Admin
Description: Unprintable characters in card account name prevent display in
Manage Accounts.
Resolution: Unprintable characters are replaced with a ‘?’ before displaying
the string

110523001238

Product/Feature: Jobs/Company Card Import
Description: Certain Bank of America Cash Advance Fees are hidden upon
import
Resolution: Modified the MasterCard CDF 3.0 importer to recognize
AdjustmentReasonCode value of 0821 as an Annual Fee. The visibility of these
charges will be based on the card’s configuration.
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Case ID

Case/Defect Description

110617000065

Product/Feature: Jobs/Company Card Import
Description: Card import incorrectly reports card accounts that cannot be
assigned due to missing employee ID.
Resolution: Modified the card import logic to not report the warning for card
accounts that are not individual accounts and therefore expected to remain
unassigned.
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Section 3: Documentation Updates
The following documentation changes are included in this service release.

Release Notes Now Available in Product-Specific Documents
Overview
Business Purpose
With this release the client can now
choose from product-specific release
Administrators can now build the set of
notes, each document or group of
release notes they need for their site
documents matching a specific Concur
without sorting through unnecessary
offering. Now, if one administrator is
material.
tasked with reviewing resolved issues,
they can download a document with only case information in it. The Invoice user can
download either Invoice release notes, or both Invoice and Mobile if that solution
applies to the client site.
How It Works - Concur Client Central
Beginning in April a table will now be displayed when the user logs in to Concur and
proceeds to Release Documentation > Release Notes using the Resources menu.
The design of the table allows the client to use the uppermost row of the table to
quickly identify their Concur product and what notes are applicable to their solutions:
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Each set of release notes include descriptions on the cover detailing what supporting
products can be found within the document. For example, the client who reviews
Expense Pay changes does so by downloading the Expense - Professional/Premium
release notes.
Help System Updates
The Concur administrative Help systems now include links to release notes as well.
When the user opens administrative Help (only), the leftside navigational area now
features the What's New link for the product release notes, plus additional links to
Mobile if that product is applicable to the solutions at the client site.

With this update the administrator can now avoid logging in to Concur Client Central
to view the release notes for their product(s).
Restrictions
To ensure security and "no see" restrictions, only the administrative Help systems
(Expense Tools; Expense Admin; Invoice Admin, etc.) contain the release note links no End User Help system allows viewing of the notes.

Configuration
No additional configuration is required to use this feature.
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Legal Notice
This document contains proprietary information and data that is the exclusive
property of Concur Technologies, Inc., Redmond, Washington. No part of this
document may be reproduced, transmitted, stored in a retrievable system,
translated into any language, or otherwise used in any form or by any means,
electronic or mechanical, for any purpose, without the prior written consent of
Concur Technologies, Inc.
Information contained in this document applies to the following products in effect at
the time of this document's publication:

Travel & Expense, July 2011

The above product(s) and information contained in this document are subject to
change without notice. Accordingly, Concur Technologies, Inc. disclaims any
warranties, express or implied, with respect to the information contained in this
document, and assumes no liability for damages incurred directly or indirectly from
any error, omission, or discrepancy between the above product(s) and the
information contained in this document.
© 2004 – 2011 Concur Technologies, Inc., Redmond, Washington. All rights
reserved.
Concur® is the trademark of Concur Technologies, Inc. All other company and
product names are the property of their respective owners.
Published by Concur Technologies, Inc.
18400 NE Union Hill Road
Redmond, Washington 98052
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Release Notes – August 2011
Finding Additional Product Release Notes
For Travel release notes, log in to Concur Client Central, then click Resources >
Document Library > Travel and then either TMC Partner or Direct Customers.
For all other products, log in to Concur Client Central, then click Resources >
Release Documentation > Release Notes to select and download additional
product-specific release notes matching your Concur solution(s):
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Section 1: Please Note the Following Alerts
August Release Update: Japanese Language Review and Update
Concur reviewed all Japanese language translations and updated string changes are
introduced in this service release (August / SU70). Concur will continue to review
and include updated translations in upcoming service releases.

Concur Release Notes
August 2011

Page 3

Expense Professional / Premium
Concur Clients

Section 2: Enhancements From Client Suggestions Forum
The following features were submitted using Concur's Suggestion service, available
via Concur's forums. They are now included in this service release.
•

Austrian Travel Allowance Update
Enhancements for Austrian TA are included in the August service release.

•

Travel Allowance Itinerary Import
When creating an itinerary that includes hotel data in the receipt, the system
will now auto-create the hotel row for the user.

•

Add Request ID as FormData Content for Printed Reports
The Request ID can now be added to the Title section as FormData in the
Printed Reports feature.

•

Personal Expense Icon Color is Changed to Prevent Confusion
The Personal Expense icon color is now changed to prevent any confusion
between it and the Receipt Received icon.

•

Japanese Users: Order of Address Display in Profile
Japanese users will now see their address order in Profile as Country, Zip,
State, City, and Street.

•

Image Type Icons and Hover Text Changed to Clarify Image Required
Reports requiring images now display colored icons that identify if the receipts
required are attached or still require attachment, and the hover text now
indicates if the required receipts are of the image or paper type.
Each of the features in this section is described in brief here, and in more
detail in their respective sections within this document - if you need additional
information please refer to these sections.
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Section 3: Expense
The following features are included in this service release.

Audit Log Entry Created on Change of Approver
Overview
An Audit Trail event is now logged when
the default Approver is changed via
User Admin or Profile for expense
reports, cash advances, invoices, and
travel requests.

Business Purpose
This enhancement provides a historical
view of edits to the employee’s
assigned default Approver.

This update lets the administrator view change activity by viewing the Change Log,
found under Administration > Expense > Change Log.

Configuration
No additional configuration is required to use this feature.

Automatically Create Hotel Reservation Row in Travel Allowance
Itinerary
Overview
Business Purpose
Previously, hotel reservation
information for a trip including both
This enhancement provides ease of entry
hotel and air reservations did not
for sites that base rates on hotel location.
result in a row on the travel
allowance itinerary. With this
release, there is a new configuration setting to optionally create an itinerary row
when this type of travel reservation is imported to the travel allowance itinerary.
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This change aids companies who base their travel allowance rates on the hotel
location to help users in completing the itineraries for their expense reports.

Configuration
This feature is not enabled by default. To enable this feature, the user must clear
(uncheck) the Skip Hotel Itinerary Row when Air is Present in Import
checkbox when editing the travel allowance configuration. The figure below shows
the setting in its default state:

Refer to Expense: Travel Allowance Setup Guide for additional information.
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Austrian Travel Allowance Enhancements
Overview
The following changes are included
in Austrian travel allowance:
•

•

Business Purpose

This enhancement provides additional
flexibility for supporting collective treaty
Optional support for time
agreements with unions in Austrian travel
bands for calculation of the
allowance.
company rate
allowance. Government rates
will continue to use the current calculation
Optional setting to use the meals deductions declared in the rate records and
to not use the special handling for international meals

Configuration
Some configuration is required for this feature - refer to the country-specific guide
for additional information.
Refer to Travel Allowance Configuration Guide - Austria for more information.

Receipt Store: Email Verification and Confirmation Changes
Overview
Business Purpose

The Receipt Store feature uses an
email submission and verification
process to receive, verify, and
confirm a user's email address
before they can begin to send
images to Receipt Store.

This enhancement is intended to direct
users to Receipt Store use by following up
on their actions in a timely manner.

With this release, two changes are made to this process:
•

Reminder Email: A redesigned email is now sent to a user who has
submitted their email address but neglected to input the verification code to
finalize confirmation - this email is sent only twice, on a two-week schedule.
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•

Verification Email: A verification email is now included in the email
notifications for those users who neglected to input the verification code to
finalize confirmation but who are attempting to send an image to Receipt
Store - this email requests that the user input the verification code prior to
attempting to send images to Receipt Store.
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Configuration
No additional configuration is required to use this feature; the user only needs to
follow up on verification using the instructions provided in the email notification.
Refer to Expense: Receipt Handling – Receipt Store & Line Item Receipts
Setup Guide for more information.

Printed Reports: User Can Add the Request ID Field to Detailed Report
Overview
Business Purpose
With this release the Request ID
field is now added as FormData
This enhancement brings additional
content for inclusion in the details of
flexibility to the Printed Reports feature.
the Printed Reports generated by the
user. This change augments the use
of the Request Name field by adding additional information - specifically the
identification number of the request.
When including this field in a detailed report that includes multiple requests, note
that only one request identification number will populate the included Request ID
field - not all request numbers can be included in the printed report FormData
section. This is the same behavior as Request Name, so the same strategy used for
that field should be employed for Request ID where multiple requests are included.
Concur Release Notes
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Configuration
To include this field configuration of the printed report is required.
Refer to Expense: Printed Reports Configuration Setup Guide for more
information.

Group Configuration – New Setting to Enable Yodlee
Overview
The Yodlee personal card import can
now be enabled on a group by group
basis. A new check box has been added
to the Configuration for Group
window:

Business Purpose
This enhancement gives administrators
more control over the Yodlee personal
card import feature.

NOTE: Once the check box has been selected, it cannot be cleared.
The Yodlee personal card import can be enabled along with the standard
company card feeds. Turning on the Yodlee version of personal card support will
replace the existing flat file/OFX/QFX feature.
Concur Release Notes
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Configuration
No additional configuration is required to use this feature.
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Section 4: Expense Pay
The following features are included in this service release.

User Bank Account and Report Currency Must Match
Overview
Business Purpose
A new system audit rule has been
added that prevents report submission
This enhancement helps ensure that
if the Expense Pay user’s bank account
reports are paid by Expense Pay when
currency does not match the report
users change countries.
currency. This scenario can occur when
the Expense Pay user moves to another country and submits a report in the new
currency while the bank account in the old currency is still active. This audit rule
prevents report submission and prompts the user to contact their Expense approvers
to verify that all submitted reports in the old currency have been processed before
they deactivate the old account.

Configuration
No additional configuration is required to use this feature.
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Section 5: Documentation Updates
The following documentation changes are included in this service release.

Release Notes Now Available in Product-Specific Documents
Overview
Business Purpose
With this release the client can now
choose from product-specific release
Administrators can now build the set of
notes, each document or group of
release notes they need for their site
documents matching a specific Concur
without sorting through unnecessary
offering. Now, if one administrator is
material.
tasked with reviewing resolved issues,
they can download a document with only case information in it. The Invoice user can
download either Invoice release notes, or both Invoice and Mobile if that solution
applies to the client site.
How It Works - Concur Client Central
Beginning in April a table will now be displayed when the user logs in to Concur and
proceeds to Release Documentation > Release Notes using the Resources menu.
The design of the table allows the client to use the uppermost row of the table to
quickly identify their Concur product and what notes are applicable to their solutions:
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Each set of release notes include descriptions on the cover detailing what supporting
products can be found within the document. For example, the client who reviews
Expense Pay changes does so by downloading the Expense - Professional/Premium
release notes.
Help System Updates
The Concur administrative Help systems now include links to release notes as well.
When the user opens administrative Help (only), the leftside navigational area now
features the What's New link for the product release notes, plus additional links to
Mobile if that product is applicable to the solutions at the client site.

With this update the administrator can now avoid logging in to Concur Client Central
to view the release notes for their product(s).
Restrictions
To ensure security and "no see" restrictions, only the administrative Help systems
(Expense Tools; Expense Admin; Invoice Admin, etc.) contain the release note links no End User Help system allows viewing of the notes.

Configuration
No additional configuration is required to use this feature.
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Section 6: Supported Configurations
The following configurations are either supported or no longer supported with this
service release.

Certifications for This Release
Support for Google Chrome Version 11.0 and 12.0
Support for Google Chrome version 11.0 and 12.0 under both the Mac OS X and
Microsoft Windows operating systems is certified for this release.

Upcoming Certifications
Support for Google Chrome Version 13.0
Support for Google Chrome version 13.0 under both the Mac OS X and Microsoft
Windows operating systems will be included in an upcoming release.

Support for Safari 5.1
Support for Safari 5.1 under Mac OS X Lion (version 10.7) will be included in an
upcoming release.

Support for Mac OS X Lion
Support for Mac OS X Lion (version 10.7) will be included in an upcoming release.

Support for Firefox v. 5.0 and v.6.0
Support for Firefox 5.0 and 6.0 will be included in an upcoming release.
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Legal Notice
This document contains proprietary information and data that is the exclusive
property of Concur Technologies, Inc., Redmond, Washington. No part of this
document may be reproduced, transmitted, stored in a retrievable system,
translated into any language, or otherwise used in any form or by any means,
electronic or mechanical, for any purpose, without the prior written consent of
Concur Technologies, Inc.
Information contained in this document applies to the following products in effect at
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Release Notes – August 2011
FOR CONCUR INTERNAL USE ONLY – DO NOT DISTRIBUTE OUTSIDE CONCUR

Finding Additional Product Release Notes
For Travel release notes, log in to Concur Client Central, then click Resources >
Document Library > Travel and then either TMC Partner or Direct Customers.
For all other products, log in to Concur Client Central, then click Resources >
Release Documentation > Release Notes to select and download additional
product-specific release notes matching your Concur solution(s):

Concur Release Notes
August 2011

Page 2

Resolved and Known Issues Case List
Concur Clients

Section 1: Resolved Issues - Expense
Case ID

Case/Defect Description

110303000202

Product/Feature: Expense/Allocations
Description: The Allocation choice under Details on Paid Reports with
Allocations cannot be seen.
Resolution: The code for the end user traveler was missing - code to display
the allocation menu item on reports in submitted or higher status is now
added for these users.

110516000451

Product/Feature: Expense/Audit Rules
Description: The Mileage Overage entry is calculated incorrectly when using
the Deducted Commute in the Mileage Calculator.
Resolution: The code is modified to no longer round off the deducted
commute distance before deducting from the business miles.

110516000451

Product/Feature: Expense/Audit Rules
Description: The Mileage Overage Audit Rule entry is incorrectly calculating
when using Deducted Commute factors in the Mileage Calculator.
Resolution: The Deducted Commute distance is now changed to no longer
round up to an integer prior to deducting from the business miles when the
rule object is re-calculating the total distance in the Mileage Calculator prior to
comparing that value to the value for Entered Miles.

110601000203

Product/Feature: Expense/Receipt Store
Description: Request to change the color of the line item level Receipt
Received icon - it is easy to confuse with the green Personal Expense icon.
Resolution: The Personal Expense icon is now changed from green to blue.

110621000348
110706000491
110721001221
110727001470
110621000785

Product/Feature: Expense/Itemizations
Description: The system is incorrectly showing that hotel itemizations do not
require receipts when in fact they do. The user only sees this requirement
when preparing the Fax Cover Page and not as expected in the Required
Receipts page.
Resolution: The code is modified to collect the itemizations for hotels after
they are processed but before sending this data back.

Product/Feature: Expense/Tax Administration
Description: An Unexpected Software Error (UE) is generated when
attempting to remove an expense type from the Tax & Reclaim group.
Resolution: The code is modified so the user can now move tax rate
conditions, and the check for available/unavailable expenses is changed so
that it will now ignore Groups with an end date that is before the start date.
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Case ID

Case/Defect Description

110629000567

Product/Feature: Expense/Attendees - Hotel Itemization
Description: A fully itemized hotel entry results in the system returning the
user to the itemization page even though the remaining balance to itemize is
zero.
Resolution: The code is modified to direct the user to the Create New
Expense function when the parent entry total is fully itemized and a balance of
zero remains.

110630000749

Product/Feature: Expense/Policies
Description: An administrator who renames a policy using admin options
changes to a different locale and sees that the names are not localized to the
locale they are viewing. Instead, they remain in the original language.
Resolution: The code is modified to now update all locales.

110701000537

Product/Feature: Expense/Audit Rules
Description: An Unexpected Software Error (UE) is generated when trying to
save validation rule that uses Account Code 1 or Account Code 2.
Resolution: Corrected the Validation Rule admin code to properly recognize
the Account Code 1 and Account Code 2 fields, so that Validation Rules
containing these fields in conditions would save properly.

110713001063

Product/Feature: Expense/Workflow
Description: Modifying a workflow email notification results in a corrupted
display of the Modify Email Notification page - the page is collapsed and there
is no way to view or access the options on the page.
Resolution: The code for the duplicate name check is rewritten to now use an
iteration function instead of the regular expression to resolve the issue.

110718000789

Product/Feature: Expense/Email Reminders
Description: The system is allowing invalid data to be entered in the Number
of Days and Specific Days fields for email reminders, resulting in an
unhandled exception error.
Resolution: The code is modified to add error messages under these
conditions with correcting text, and to reject the invalid character(s).

110801000397

Product/Feature: Expense/Receipt Handling
Description: Expense Reports are incorrectly being put into a Hold Receipt
Image status even though they have the receipt images attached to them they are not progressing through workflow as a result.
Resolution: A required parameter was missing and is now added to the code.

110801000668
110728001295

Product/Feature: Expense/Processor & Auditor
Description: An Unexpected Software Error (UE) is generated when the
Processor view is changed from a detailed to a customized view. This problem
is due to an empty string being created for formKey instead of a null integer.
Resolution: The code is modifed to convert the formKey string to a nullable
integer.
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Section 2: Resolved Issues - Jobs
Case ID
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Section 3: Documentation Updates
The following documentation changes are included in this service release.

Release Notes Now Available in Product-Specific Documents
Overview
Business Purpose
With this release the client can now
choose from product-specific release
Administrators can now build the set of
notes, each document or group of
release notes they need for their site
documents matching a specific Concur
without sorting through unnecessary
offering. Now, if one administrator is
material.
tasked with reviewing resolved issues,
they can download a document with only case information in it. The Invoice user can
download either Invoice release notes, or both Invoice and Mobile if that solution
applies to the client site.
How It Works - Concur Client Central
Beginning in April a table will now be displayed when the user logs in to Concur and
proceeds to Release Documentation > Release Notes using the Resources menu.
The design of the table allows the client to use the uppermost row of the table to
quickly identify their Concur product and what notes are applicable to their solutions:
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Each set of release notes include descriptions on the cover detailing what supporting
products can be found within the document. For example, the client who reviews
Expense Pay changes does so by downloading the Expense - Professional/Premium
release notes.
Help System Updates
The Concur administrative Help systems now include links to release notes as well.
When the user opens administrative Help (only), the leftside navigational area now
features the What's New link for the product release notes, plus additional links to
Mobile if that product is applicable to the solutions at the client site.

With this update the administrator can now avoid logging in to Concur Client Central
to view the release notes for their product(s).
Restrictions
To ensure security and "no see" restrictions, only the administrative Help systems
(Expense Tools; Expense Admin; Invoice Admin, etc.) contain the release note links no End User Help system allows viewing of the notes.

Configuration
No additional configuration is required to use this feature.
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Release Notes – September 2011
Finding Additional Product Release Notes
For Travel release notes, log in to Concur Client Central, then click Resources >
Document Library > Travel and then either TMC Partner or Direct Customers.
For all other products, log in to Concur Client Central, then click Resources >
Release Documentation > Release Notes to select and download additional
product-specific release notes matching your Concur solution(s):
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Section 1: Enhancements From Client Suggestions Forum
The following features were submitted using Concur's Suggestion service, available
via Concur's forums. They are now included in this service release.
•

Rename to Total Unexpensed in Company Card Charges
To reduce confusion, the Available Company Card Charges window Total
Available column heading is now renamed to Total Unexpensed so the user
will understand that the amount showing is that remaining to be expensed for
the expense report, and not their total spend across all reports.

•

Enhancements to Calculation Formula
Several enhancements that allow the calculation formula to access additional
fields are included in this service release.

•

Restrict Attendee Types by Expense Type
The ability to restrict the display of attendees the user can select to only
those configured for an Expense Type within the overall Policy.

•

Set default Attendee Type
The ability to set a default attendee type for any Expense Type.

•

Japan: Sort Order of Prefecture From North to South
The sort order of prefectures under Japanese display will now display the
prefectures from North to South.
Each of the features in this section is described in brief here, and in more
detail in their respective sections within this document - if you need additional
information please refer to these sections.
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Section 2: Expense
The following features are included in this service release.

Expense Type Formulas Enhanced
Overview
The calculation formulas available on
the Formulas tab of the Expense
Types page of Expense Admin have
been enhanced. The following
enhancements are now available:

Business Purpose
This enhancement provides more
options for the Expense Type
calculation formulas.

•

The calculation formulas can now update the transaction and posted amount
for the expense. Previously they could only reduce the approved amount.

•

The Report Custom Fields 1-20 are available for use in calculations when
configured as an amount, numeric, or integer field.

•

The validation rule Amounts 1 and 2 can be used in the calculations. You
must have a validation rule configured to supply amount values to the
calculation formulas.
Refer to the Expense: Audit Rules (Validation Rules) Setup Guide for
more information.

•

The travel allowance meals, lodging and incidentals rates can be used in
calculations.

Configuration
To use the Travel Allowance rates, a valid travel allowance configuration must be
present. To use the validation rule values, you must configure a validation rule to
supply the values.
Refer to the Expense: Expense Types Setup Guide for more information.

Validation Rules – City, State/Province and Country Fields Now
Available
Overview
The Validation Rules page of Audit
Rules has been enhanced to allow the
use of the Entry City, Entry
State/Province and Entry Country fields
in validations. Note the following about
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supports a simple per-diem validation.
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this feature:
•

Entry City: The location code for the city is used when comparing the city to
the values in the validation table.

•

Entry State/Province: The country sub code is used when comparing the
state/province to the values in the validation table. Validation conditions using
this field must have the validation on the left side of the condition, and the
State/Province field on the right side: Field_validation.ID_1 =
Entry.State/Province.

•

Entry Country: The country code is used when comparing the country to the
values in the validation table.
Refer to the Expense: Audit Rules (Validation Rules) Setup Guide for more
information.

Configuration
To use this feature, you must import the valid location codes for the cities into the
validation import table

Japanese Users: North to South Sort Order of Prefectures
Overview
Business Purpose
Users working or traveling in Japan will
now view and choose from a list that
This enhancement helps the Japanese
orders prefectures from North to South
user by providing a familiar localized
rather than the traditional alpha sorting
presentation.
order. This is the ‘usual’ order that a
Japanese user would expect the information to be displayed in.
This change is available in selected areas of Expense for this service release, such as
the Expense Report entry form and User Profile for the user, and in the
State/Province helper and Locations modules for the administrator. It will be applied
to additional areas such as administrative tools in future service releases.
The figure below shows the sorting order for a user choosing their preferred Country
value of Japan, then choosing the subdivision of State/Province from a sorted
order from North (Hokkaido) to South (Okinawa):
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Configuration
No additional configuration is required to use this feature.

Company Card: Available Company Card Charges Label Change
Overview
With this release the Total Available
field on the Available Company Card
Charges window is now changed to
Total Unexpensed.

Business Purpose
This enhancement helps clarify what
the total calculated is based upon.

This change is meant to clarify the
intent of this field, which is to show the total of remaining credit card expenses that
have not yet been added to an expense report.

Configuration
No additional configuration is required to use this feature.
Concur Release Notes
September 2011
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User Import: Travel User Information Import Available
Overview
The User administrator working in the
integrated Travel and Expense
environment can now import Travel user
information using the User Import
feature available in User Administration.

Business Purpose
This enhancement adds Travel to the
available user types that can be
imported via Excel.

This feature is similar to using the 350
Travel Addendum record type in the employee import to import data for the Travel
user as the template includes the same fields. However, with the User Import feature
these fields are columns in an Excel spreadsheet available by clicking the User
Import Information link.

How It Works
To import Travel data the administrator navigates to the User Administration area
of Company Admin and clicks Import Users, then clicks the User Import
Information template link.
The user then follows the directions available in this window:

Configuration
No additional configuration is required to use this feature.
Refer to Shared: User Import User Guide for more information.
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Restrict Attendee Type Entry Selection by Expense Type
Overview
Business Purpose
The attendees available for selection
when creating entries from within
This enhancement allows greater
Expense can now be filtered by Expense
control over what attendees appear for
Type. Doing this decreases the
a given Expense Type.
possibility of choosing the wrong
attendee and ensures the attendee being chosen conforms to both Group and Policy
attributes.
The attendees available for selection are filtered at the following areas in Expense:
•

New Attendee

•

Attendee Search

•

Attendee Groups

•

Favorite Attendees

•

Attendee Import for Expense Type

•

Does NOT impact Attendee functionality in the My Profile page

Exclusion of Attendees - Special Cases
•

Attendee Groups: At the Attendee Group level, if all attendees are of a type
excluded for the combined Policy and Expense Type, then none will be
available for selection.

•

User Attendee Import: In the Excel-based User Import, these excluded
attendees will import successfully, but each will be flagged and manual
removal is required to ensure successful report submission.

•

Copy from Authorization Request: Those attendees copied from an
Authorization Request will include all attendee types allowed for the users
group and will not exclude based on Expense Type. Attendee types not
allowed for the Expense Type will need to be manually removed prior to
submission.

Configuration
Submit a Change Request case to Concur Support, detailing the Policy, Expense
Type, and attendee types to be excluded for that Expense Type.
Refer to Expense: Attendees Setup Guide for more information.
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Default Attendee Type Selection by Expense Type
Overview
Business Purpose
The administrator may configure a
default attendee type for an Expense
This enhancement allows aids users in
Type. This will automatically set the
making the right choice.
attendee type for the user when adding
a new attendee from within the expense
of this Expense Type, helping them to avoid mistakes in the selection of the attendee
type.

Configuration
Configuration is performed using the Policies tool.

 To set the default attendee type per expense type:
1.

Click Administration > Expense Admin > Policies.

2.

Select a Policy from the row, then click the Expense Types button.

3.

Select an expense type under Expense Type, then click the Modify
Properties button.

4.

Choose the default attendee type (Business Guest in the figure above), then
click Save.

Concur Release Notes
September 2011

Page 9

Expense Professional / Premium
Concur Clients

Refer to Expense:Attendees Setup Guide for more information.

Central Reconciliation - Controlled Release for September
Overview
The Central Reconciliation feature is
now available as a controlled release for
September. The general release is
scheduled for October.

Business Purpose
This enhancement brings a new option
for addressing centrally-billed
expenses.

What Is Central Reconciliation?
Central Reconciliation allows a Processor to now match and compare the invoices
generated by a company Lodge card against the preapproved expenses included in
the Travel Request for the travel incurred by the user associated with this Lodge
card. This centralized method for managing and paying expenses introduces another
option for reviewing and approving spend since they can now use Central
Reconciliation features to perform the matching and analysis of the transaction
charges.
A sample cycle might look like this:
•

The traveler creates the travel request, which generates the email to the
travel agency

•

The booking is paid for using a Lodge card, with the invoice issued by the
card provider within which the Request ID is included in the Passenger Name
Record (PNR)

•

On import to Travel and Expense:
♦

The invoice is created in Expense, and the Request ID from the PNR is
used to link that invoice to the original travel request

♦

The request header provides the Employee ID and allocations for the
invoice
NOTE: The invoice charges are never displayed in an expense report the
employee will create (these charges are separate, between agency
and client via the Lodge card account).

•

The Central Reconciliation Processor user opens Central Reconciliation and
manages the matched and unmatched (Request ID not yet identified)
invoices, approving them

•

Optional: The extract is configured to either include, or exclude, these
charges to the client ERP (they are included by default).
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User Interface
The Central Reconciliation page appears by clicking the Central Reconciliation tab.
When working with matched invoices the user interface appears as in the figure
below:

More Information
Clients
This feature is provided as a controlled release for September. Clients wishing to
participate in an early adopter program in September should contact their Concur
account manager.
Documentation
A configuration fact sheet, and draft version of the Expense: Central Reconciliation
Setup Guide and Expense: Central Reconciliation User Guide will be available in the
early October time frame.
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Section 3: Expense Pay
The following features are included in this service release.

Expanded Card Program Support
Overview
The support for card programs in
Expense Pay has been expanded. The
following card program has been added:
•

Business Purpose
This enhancement expands card
program support for Expense Pay.

Royal Bank of Scotland
MasterCard UK

Configuration
No additional configuration is required to use this feature.

Expense Pay Sweden: New Funding Bank Support
Overview
Expense Pay Sweden now supports the
following funding banks:
•

Citibank Sweden

•

Skandinaviska Enskilda Banken
(SEB)

Business Purpose
This enhancement expands funding
bank options in Sweden.

Configuration
No additional configuration is required to use this feature.
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Section 4: Jobs
The following features are included in this service release.

Update Employee ID or Login ID Values Using New 320-Level Record
Overview
Business Purpose
A new 320-level record set can now be
used to explicitly change the Employee
This enhancement allows the
ID or Login ID values for an employee.
Integration administrator to update
This record set is ideal for integrated
specific values for the employee.
Expense and Travel sites that want to
update only these IDs and have this data pushed to all of their Concur applications.

Configuration
Configuration is limited to setting up the import data file to update the required
values.

! Starting January of 2012, the 320-level record will be the only method of
updating a user's Employee and Login ID values.

Refer to Chapter 4: Employee Import of Expense – Import and Extract
Specifications for more information.
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Section 5: Documentation Updates
The following documentation changes are included in this service release.

Release Notes Now Available in Product-Specific Documents
Overview
Business Purpose
With this release the client can now
choose from product-specific release
Administrators can now build the set of
notes, each document or group of
release notes they need for their site
documents matching a specific Concur
without sorting through unnecessary
offering. Now, if one administrator is
material.
tasked with reviewing resolved issues,
they can download a document with only case information in it. The Invoice user can
download either Invoice release notes, or both Invoice and Mobile if that solution
applies to the client site.
How It Works - Concur Client Central
Beginning in April a table will now be displayed when the user logs in to Concur and
proceeds to Release Documentation > Release Notes using the Resources menu.
The design of the table allows the client to use the uppermost row of the table to
quickly identify their Concur product and what notes are applicable to their solutions:
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Each set of release notes include descriptions on the cover detailing what supporting
products can be found within the document. For example, the client who reviews
Expense Pay changes does so by downloading the Expense - Professional/Premium
release notes.
Help System Updates
The Concur administrative Help systems now include links to release notes as well.
When the user opens administrative Help (only), the leftside navigational area now
features the What's New link for the product release notes, plus additional links to
Mobile if that product is applicable to the solutions at the client site.

With this update the administrator can now avoid logging in to Concur Client Central
to view the release notes for their product(s).
Restrictions
To ensure security and "no see" restrictions, only the administrative Help systems
(Expense Tools; Expense Admin; Invoice Admin, etc.) contain the release note links no End User Help system allows viewing of the notes.

Configuration
No additional configuration is required to use this feature.
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Section 6: Supported Configurations
The following configurations are either supported or no longer supported with this
service release.

Certifications for This Release
Support for Mac OS X Lion
Support for Mac OS X Lion (version 10.7) is certified for this release.

Support for Firefox v. 5.0 and v. 6.0
Support for Firefox versions 5.0 and 6.0 under both the Mac OS X and Microsoft
Windows operating systems is certified for this release.

Support for Safari v. 5.1
Support for Safari 5.1 under Mac OS X Lion (version 10.7) is certified for this release.

Support for Google Chrome v. 12.0 and v. 13.0
Support for Google Chrome versions 12.0 and 13.0 under both the Mac OS X and
Microsoft Windows operating systems is certified for this release.

Upcoming Certifications
Support for Firefox v. 7.0
Support for Firefox 7.0 under both the Mac OS X and Microsoft Windows operating
systems will be included in an upcoming release.
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Legal Notice
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property of Concur Technologies, Inc., Redmond, Washington. No part of this
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Release Notes – September 2011
FOR CONCUR INTERNAL USE ONLY – DO NOT DISTRIBUTE OUTSIDE CONCUR

Finding Additional Product Release Notes
For Travel release notes, log in to Concur Client Central, then click Resources >
Document Library > Travel and then either TMC Partner or Direct Customers.
For all other products, log in to Concur Client Central, then click Resources >
Release Documentation > Release Notes to select and download additional
product-specific release notes matching your Concur solution(s):
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Section 1: Resolved Issues - Expense
Case ID

Case/Defect Description

101008000808

Product/Feature: Expense/Cash Advance
Description: The error message "Missing the required approver for next
workflow step. You may be able to select an approver. Contact your expense
administrator for assistance." appears when attempting to approve a cash
advance whose workflow includes more than one level of approval, and the
cash advance feature is not available for the approver of the cash advance.
Resolution: The code is modified to allow the user to change the cash
advance approver is the user has cash advances pending approval.

110516000987
110506000765

Product/Feature: Expense/Travel Allowance
Description: Journal splitting of a lodging amount under Travel Allowance is
not handled correctly with multiple reports, and is causing the amount to not
balance with the credit card entry. This occurs when there is a credit expense
attributed to the allowance expense type and the expenses for the day’s
allowance occur on multiple reports.
Resolution: The Travel Allowance reimbursable procedure is modified to now
include all credits across all reports linked to a single itinerary and date when
figuring the allowance limit.

110527000056

Product/Feature: Expense/Workflow
Description: The system does not retain the user's choice when changing the
Authorized Approver.
Resolution: An invalid approver in the prior step is causing this issue. The
issue is fixed by displaying a blank field instead of the invalid approver, and
the same for the authorized approval step (if present). The user can then
select the approvers and steps as required.
NOTE: This fix is only applicable to new expense reports, and is not
retroactive to existing expense reports. Existing reports will need to be
identified and adjusted manually.

110617000022

Product/Feature: Expense/Audit Trail
Description: Incorrect information is entered in the Audit Trail when the
Processor changes the Tax Posted Amount field value.
Resolution: The code is modified to ignore the Tax Posted amount update
done post-Save, and instead note changes to properties in the Tax Helper and
write these to the Audit Trail instead.

110717000000
110728000521

Product/Feature: Expense/Audit Rules
Description: An Audit Rule is incorrectly firing when the ticketed amount is
identical to the expensed amount; in the cited rule configuration it should fire
only when the ticketed amount exceeds the expensed amount.
Resolution: The code is modified to now include the Currency and Date
functions in the RuleTravelReservation class to fix this issue.
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Case ID

Case/Defect Description

110720000071

Product/Feature: Expense/Receipt Store
Description: The wrong image is attached to the line item when viewing the
image in enlarged detail view and scrolling through. The image that the user
was previously viewing is the image that is attached, not the one they actually
viewed and selected for attachment.
Resolution: The code is modified to fetch the image being viewed and acted
upon by clearing the cache for the last image viewed.

110721000585

Product/Feature: Expense/Exchange Rates
Description: The exchange rate shown on an expense report that is sent
back is not being updated. Instead, the last known exchange rate is retained
when the date of the expense is changed.
Resolution: The issue is tied to an event handler that was set to change
rates based on Transaction Date for new or submitted reports, but not for
those that had been sent back. The issue is resolved by now including the
Sent Back event as well.

110727000049

Product/Feature: Expense/User Interface
Description: Processor is not able to view the Expense Detail view in any
browser if the entry view list is wider than the viewing area - no scroll bar is
available to move the view for this area.
Resolution: The layout of the Processor view is modified to now limit the
entry list so that it is not wider than the allowable view.

110727001287
110801000439
110817000888
110728000009

Product/Feature: Expense/Workflow
Description: The user is not able to select himself as an add-step Approver in
Workflow.
Resolution: A Processor or Approver may not select himself as an add-step
Approver. Submitters may not select themselves as Approvers.
Product/Feature: Expense/Travel Allowance
Description: Dates that should appear unavailable when creating itinerary
rows are incorrectly appearing as available. These dates should be grayed out
and inactive.
Resolution: Code that was inadvertently removed from another fix is now
reintroduced into the code to fix this feature.

110728000193

Product/Feature: Expense/Localization - Italian
Description: The display is incorrect for Italian users viewing the View
Expense Charges of the company card window.
Resolution: The code is changed to now properly handle (capture)
apostrophes in selected strings on the window - this fix will prevent the
system from encountering JavaScript errors.

110728001366

Product/Feature: Expense/Documentation
Description: Documentation incorrectly indicates that the Processor can clear
exceptions even after the report is approved. This is not correct.
Resolution: The documentation is corrected to show that no exceptions can
be cleared after an expense report is approved.

Concur Release Notes
September 2011

Page 4

Resolved and Known Issues Case List
Concur Clients

Case ID

Case/Defect Description

110802000966

Product/Feature: Expense/Company Cards
Description: A Test user with card administration rights does not see the
Test payment type they have set up in the system. Instead, they only see
Production default payment types and no Test payment types are available.
Resolution: The code is modified to include the check for the Test User
attribute when retrieving payment types for the user.

110804000041

Product/Feature: Expense/Forms & Fields
Description: The Employee Profile City field display is left blank even though
the administrator has selected a city for the user and it should display in the
Employee form. This occurs when the City field is Read-Only for the
Employee.
Resolution: An issue with the user access rights to this field was causing the
problem. Code is now added that will populate the City field for a read-only
location name field type.

110805000081

Product/Feature: Expense/Change Log
Description: The change log is not updated when the Editable By field is
changed. This field should cause an entry in the log when changed.
Resolution: The code is modified to now audit the Editable By field and add
an entry to the log when this field is changed.

110809000100

Product/Feature: Expense/Personal Company Cards
Description: A user who changes the location of an imported personal card
transaction to a non-US. location sees the total reduced to zero. They do not
have rights to change the field since this is a read-only field.
Resolution: The system was not able to update the read-only field with the
original saved amount after the location and resulting currency change. The
issue is resolved by allowing the currency to change and the new amount
displayed if the entry is not a Company or Personal card charge.

110810000568

Product/Feature: Expense/Email Notifications
Description: A Processor's comments are duplicated (shown twice) in email
notifications generated when a report is sent back from an Auditor step.
Resolution: The code is modified to now check for a duplicate comment
under this scenario and remove the duplicate text string if encountered.

110810000727

Product/Feature: Expense/User Interface
Description: An expense report created using Japanese double-byte
characters in the Expense header displays "?? ??" on all itemized Business
Purpose entries on copy down when the text uses double-byte characters.
Resolution: The code is modified so that the procedure used to update the
Expense entry for the copy down action now uses Unicode characters.

110811000845

Product/Feature: Expense/User Interface
Description: The Administration tab link becomes inactive when the user
moves away from the tab to My Concur and then back again in a specific
sequence. Clicking the link a second time results in no action - the link
appears broken.
Resolution: The code has been modified to now correctly resolve the link
URL.
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Case ID

Case/Defect Description

110816000032

Product/Feature: Expense/Employee Maintenance
Description: Expense-only employee maintenance users are incorrectly
allowed access to employees outside of their defined Groups. This issue is
caused by the Travel filters used in User Admin.
Resolution: The code is modified to now determine if the user has a Travel
User Maintenance role and, if not, to prevent that user from viewing the
Travel search.

110816000281

Product/Feature: Expense/User Admin
Description: A search in Travel User Administration for a Russian character
name that exists in the database, such as Смирнов, results in no search
return.
Resolution: An "N" character is added to the query so that the user can now
search for characters beyond the standard ASCII character set.

110826000174

Product/Feature: Expense/Groups
Description: Changing an employee Group configuration in Employee Admin
causes a server error to be generated and displayed.
Resolution: This choice should not be available for users who have a CUUID
in the database. To fix this issue, the Employee Group Configuration
dropdown list is no longer available for users who have a CUUID.

110826000294

Product/Feature: Expense/User Import
Description: A user with the correct role and permissions is not able to
access and use the Import Users link in User Administration.
Resolution: The code is modified to now allow a user with the correct
permissions to access this link no matter what Group they are assigned under.

Concur Release Notes
September 2011

Page 6

Resolved and Known Issues Case List
Concur Clients

Section 2: Resolved Issues - Jobs
Case ID

Case/Defect Description

110603001257

Product/Feature: Jobs/Employee Import
Description: Employee Import changes an employee’s Login IDs but doesn’t
give sufficient information on the impact.
Resolution: The code was modified to provide actionable detail when an
employee’s Login ID is changed, including the recommendation to use the
new 320 record to explicitly change a Login ID.
Refer to Chapter 4: Employee Import of Expense – Import and Extract
Specifications for more information.

110812001080

Product/Feature: Jobs/Email Reminder
Description: Unhandled exception in Email Reminder job.
Resolution: The code was modified to correctly handle email reminders for
Travel Requests.

110816000716

Product/Feature: Jobs/Company Card Import
Description: Sales Tax amount is being imported incorrectly.
Resolution: The MasterCard CDF 3.0 importer was modified to use the
currency exponent provided with the Tax Amount rather than the currency
exponent for the Total Tax Amount.

110822000657

Product/Feature: Jobs/Company Card Import
Description: Unhandled exception during decryption of a card feed.
Resolution: Modified the code to properly handle an empty encrypted file.
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Section 3: Documentation Updates
The following documentation changes are included in this service release.

Release Notes Now Available in Product-Specific Documents
Overview
Business Purpose
With this release the client can now
choose from product-specific release
Administrators can now build the set of
notes, each document or group of
release notes they need for their site
documents matching a specific Concur
without sorting through unnecessary
offering. Now, if one administrator is
material.
tasked with reviewing resolved issues,
they can download a document with only case information in it. The Invoice user can
download either Invoice release notes, or both Invoice and Mobile if that solution
applies to the client site.
How It Works - Concur Client Central
Beginning in April a table will now be displayed when the user logs in to Concur and
proceeds to Release Documentation > Release Notes using the Resources menu.
The design of the table allows the client to use the uppermost row of the table to
quickly identify their Concur product and what notes are applicable to their solutions:
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Each set of release notes include descriptions on the cover detailing what supporting
products can be found within the document. For example, the client who reviews
Expense Pay changes does so by downloading the Expense - Professional/Premium
release notes.
Help System Updates
The Concur administrative Help systems now include links to release notes as well.
When the user opens administrative Help (only), the leftside navigational area now
features the What's New link for the product release notes, plus additional links to
Mobile if that product is applicable to the solutions at the client site.

With this update the administrator can now avoid logging in to Concur Client Central
to view the release notes for their product(s).
Restrictions
To ensure security and "no see" restrictions, only the administrative Help systems
(Expense Tools; Expense Admin; Invoice Admin, etc.) contain the release note links no End User Help system allows viewing of the notes.

Configuration
No additional configuration is required to use this feature.
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Legal Notice
This document contains proprietary information and data that is the exclusive
property of Concur Technologies, Inc., Redmond, Washington. No part of this
document may be reproduced, transmitted, stored in a retrievable system,
translated into any language, or otherwise used in any form or by any means,
electronic or mechanical, for any purpose, without the prior written consent of
Concur Technologies, Inc.
Information contained in this document applies to the following products in effect at
the time of this document's publication:

Travel & Expense, September 2011

The above product(s) and information contained in this document are subject to
change without notice. Accordingly, Concur Technologies, Inc. disclaims any
warranties, express or implied, with respect to the information contained in this
document, and assumes no liability for damages incurred directly or indirectly from
any error, omission, or discrepancy between the above product(s) and the
information contained in this document.
© 2004 – 2011 Concur Technologies, Inc., Redmond, Washington. All rights
reserved.
Concur® is the trademark of Concur Technologies, Inc. All other company and
product names are the property of their respective owners.
Published by Concur Technologies, Inc.
18400 NE Union Hill Road
Redmond, Washington 98052
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Release Notes – October 2011
Finding Additional Product Release Notes
For Travel release notes, log in to Concur Client Central, then click Resources >
Document Library > Travel and then either TMC Partner or Direct Customers.
For all other products, log in to Concur Client Central, then click Resources >
Release Documentation > Release Notes to select and download additional
product-specific release notes matching your Concur solution(s):
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Section 1: Enhancements From Client Suggestions Forum
The following features were submitted using Concur's Suggestion service, available
via Concur's forums. They are now included in this service release.
•

Auto-Update of Travel Request Amount Remaining on Submit of
Linked Expenses
When an expense report entry is linked to a Request entry, on submit of the
expense report for approval the Remaining Amount value of the Request is
automatically updated to take into account the amount of the linked report
entry.

•

Compare Expenses to Travel Request Amounts Using Conditions
Several new Audit Rules conditions that allow comparison of expenses against
pre-approved limits from the travel request and its request entries are
available in this service release.

•

User Can Add Travel or Authorization Request Report Creation
A user can now add additional Travel Requests or Authorization Requests to
the expense report after expenses are assigned to the report.

•

Authorization Request and Travel Request Together on Same Entity
With this release the Authorization Request and Travel Request modules will
now exist within the same entity without issues. A given user may have
access to use both authorization requests and travel requests, though only
one type of request may be linked to an individual expense report.

•

Mexican XML Receipt Files
A new option will allow Mexican users to upload and store the official digital
receipt XML file (Comprobante Fiscal Digital) in the expense record.
Each of the features in this section is described in brief here, and in more
detail in their respective sections within this document - if you need additional
information please refer to these sections.
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Section 2: Expense
The following features are included in this service release.

Travel Request and Authorized Request Modules Available Together
Overview
The Travel Request and Authorization
Request modules are now available
together, within the same company
entity, to all users whose roles allow
access to them. This means that the
user can now choose to add entries
from either the Travel Request or
Authorization Request modules when
creating the expense report.

Business Purpose
This enhancement allows a company to
use the best tool for meeting the
business need - especially important
for global companies with differing
business needs by country of
operation.

The updated interface will now show both the Travel Requests and the
Authorization Requests tabs when viewing the Report Header of the new expense
report, and is shown in the figure below:

NOTE: The expense report can be linked to either of the request types, but cannot be
connected to both a travel and authorization request. Once a request is linked
to the report, only requests of the same type may be added to that report.
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Configuration
A client using either module today would go through the normal additional purchase
and implementation process to add the other module.
For clients transitioning from Authorization Request to Travel Request, an optional
setting on the expense policy will prevent users from creating new authorization
requests while still allowing them to use their existing ones on expense reports.

User Can Add Travel or Authorization Request After Creating Expense
Overview
The user is now able to add an
authorization request or travel request
to an expense report after the report
has expenses added to it. Prior to this
service release, when the user created a
report and added an expense the user was
type to the new report.

Business Purpose
This enhancement provides additional
flexibility and usability when creating a
report.
prevented from adding either request

NOTE: This capability extends to the point of report submission, after which no
request can be added to the report.

Configuration
No additional configuration is required to use this feature.

Linked Travel Request Entry is Auto-Updated on Expense Report Submit
Overview
Business Purpose
If an expense report has a linked Travel
Request segment associated with it,
This enhancement links these values to
that request entry will now be
product an accurate amount total.
automatically updated when the
expense report is submitted and the amount approved (or changed) by the approver
in workflow. Updates to the request segment are also performed if the report is sent
back to the owner, or if the report is deleted.
This allows the request to show the true amount of the remaining amount available
in the travel request.

Configuration
No additional configuration is required to use this feature.
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Mexico Digital XML Format for Reimbursable Expenses Supported
Overview
Business Purpose
Mexico has recently mandated that
vendors provide a receipt in digital XML
This enhancement allows for storage of
format for any reimbursable expense.
the new Mexican XML receipt file
The company must receive and store
alongside the expense.
this file in order to claim the expense
for tax purposes, and must be able to produce the original file in case of audit. To
meet this requirement, the user can now use options in Expense to upload and store
the official digital receipt XML file (Comprobante Fiscal Digital) in the expense record.
In the figure below, the Attach CFD button is used to upload and associate the XML
receipt file, and the green icon confirms the association of the receipt to the expense
entry:

Note that while there is an icon indicating the presence of the file, there is no display
of this raw XML file. This file does not preclude receipt requirements and the user
may attach an imaged receipt to the expense in addition to this XML file.
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Configuration
The administrator will need to enable the Allow user to upload XML tax receipts
option in order to activate the feature. This is done by navigating to Administration >
Expense Admin > Group Configurations and selecting a group for modification. The
option is on the Configuration for Group dialog box as shown in the figure below:

Enhancements to Report Display of Available Company Card Charges
Overview
Business Purpose
The Available Company Card
Charges window now displays the list
This enhancement will help clear dated
of available reports under Select
and often-missed transactions.
Expense Report by oldest (first) to
newest (last), with the oldest report highlighted for selection by default, and the
New Expense Report option occupying the uppermost row - this is shown in the
figure below:

This means that, when the user first opens the Select Expense Report dropdown
list, they will now see the oldest report highlighted at the second to uppermost row
with the New Expense Report option occupying the uppermost row.
Why Make This Change?
This change brings visibility to the oldest expense reports and acts as a reminder
that there may be time-sensitive reports that simply require finalization by adding
the credit card transaction or similar. With the updated interface, if the user simply
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needs to create a new report, they can do so just as before by clicking the
uppermost New Expense Report option to create the new report.
These changes apply to the Available Company Card Charges window that
appears in My Concur, and in the Expense > View Charges page as well:

Configuration
No additional configuration is required to use this feature.

Change Log Enhancement: Search by Date Range Not by Page Count
Overview
With this service release the user now
searches the Change Log for entries by
entering a start and end date range
instead of paging through the entries,
as shown in the figure below:

Business Purpose
This enhancement makes it easier to
find the change log entry you want to
view.

Why Make This Change?
Prior to this change the user would navigate by moving "backwards" against the
logged changes, page by page, without a certainty that the results would include the
log change they wished to view. Now, by knowing the rough date range, the user is
assured that the log change they wish to view will be included in the list of returned
rows.
Note in the figure below that the Start Date range begins with the present day:
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Refer to Expense: Change Log Setup Guide for more information.

Configuration
No additional configuration is required to use this feature.

New Audit Rules to Compare Expenses to Travel Request Information
Overview
Several new Audit Rules conditions that
allow comparison of expenses against
pre-approved limits from the travel
request and its request entries are
available in this service release.

Business Purpose
This enhancement alerts the approver
when expenses exceed the previously
approved amounts in the associated
travel request items.

The new Audit Rule conditions are:
Audit Rule Name

Description

Report Object Conditions:
Exceeds Authorization
Amount

Determine if the total of all expenses (mapped to an
authorization request category) exceeds the total amount
authorized for the authorization request.
Typically used with the Has Authorization Request condition.

Has Travel Request

Determine if the expense report has a travel request associated
with it.

Exceeds Travel Request
Amount

On Submit event, determine if the total of all expenses exceeds
the total amount authorized for the travel request.
NOTE: Expenses are those mapped to an travel request
expense type.
Typically used with the Has Travel Request condition.

Entry Object Conditions:

Concur Release Notes
October 2011

Page 10

Expense Professional / Premium
Concur Clients

Audit Rule Name

Description

Exceeds Category
Authorization Request
Amount

Determine if the amount of this expense (plus any other
submitted expenses or expenses on this report) exceed the
amount pre-approved for the related authorization request
category.
Typically used with the Has Authorization Request condition.

Exceeds Entry Travel
Request Amount

Determine if the amount of this expense (plus any other
submitted expenses or expenses on this report) exceed the
amount pre-approved for the related travel request expense
type.
Typically used with the Has Authorization Request condition.

Configuration
The user will need to build the condition using the Audit Rules tool. The figures below
illustrate some typical rules.
•

Validate that the expense report has a linked travel request:

•

Check to see if the total expenses against a travel request exceed the total
amount pre-approved for that request:

•

Check to see if the total expenses against the hotel segment entry of a travel
request exceed the pre-approved amount of that segment:
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Refer to Expense: Audit Rules User Guide for more information.

User Import: Addition of Travel Request User Column to Template
Overview
The User administrator can now include
Travel Request user roles when
importing users using the User Import
Information template of User Import.

Business Purpose
This enhancement introduces the
Travel Request roles to the User
Import feature.

The new roles include:
•

Request User: Can submit travel requests

•

Request Approver: Can approve travel requests

•

Request Approver: The Employee ID of the user being assigned these roles

Configuration
To use this feature Travel Request must be activated for the client site.
Refer to Shared: User Import User Guide for more information.

German Travel Allowance Enhancements
Overview
The German travel allowance module
has been modified to support an
optional calculation for provided meals
on a partial day of travel.

Business Purpose
This enhancement adds additional
flexibility to the German travel
allowance module.

The days’ allowance is compared to a
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full day’s allowance to determine the proration factor to apply to the provided meal.

Configuration
No additional configuration is required to use this feature.
Refer to Travel Allowance Configuration Guide: Germany for more
information.
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Section 3: Expense Pay
The following features are included in this service release.

Expense Pay Euro: Euro-Denominated Funding Accounts Located in UK
Now Allowed
Overview
Business Purpose
Banks in the UK support Euro
denominated accounts, and some of
This enhancement increases the Euro
those banks support SEPA B2B Direct
funding bank options.
Debits. Administrators can now create
funding accounts from these banks to reimburse employees in Euros. The Funding
Account and Employee Bank Information pages have been enhanced to support
multiple currencies per country, starting with Euro and GBP for UK.

Configuration
No additional configuration is required to use this feature.

Expense Pay Euro: Employees Located in UK Can Be Reimbursed in Euro
Overview
Business Purpose
Some Expense Pay Euro clients need to
reimburse employees located in the UK
This enhancement increases the Euro
in Euros. The Funding Account page
payment options.
now displays UK in the list of available
countries when the currency is set to Euro.

Configuration
No additional configuration is required to use this feature.

Mandate ID Field Added to Euro Funding Accounts
Overview
The Add/Edit Funding Account page
for Euro funding accounts has been
enhanced with the Mandate ID field.

Business Purpose
This enhancement updates Euro
funding bank account support.

The Mandate ID must be unique for
each Euro funding bank account. When the client authorizes their bank to allow
Concur Release Notes
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Concur to debit for the purpose of funding their Expense Pay Euro payments, they
establish a Mandate ID. This field defaults to the client’s entity ID and is editable by
the client to allow them to serialize the mandate ID as needed for each bank account
so that it matches the Mandate ID field on the SEPA B2B Direct Debit Mandate form
they must provide to their bank.

Configuration
No additional configuration is required to use this feature.
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Section 4: Jobs
The following features are included in this service release.

Send Email Notification on Job Completion "Success (No File)"
Overview
Business Purpose
A new setting, Send Email
Notification on Success (No File), is
This enhancement provides additional
included in this service release for job
flexibility when configuring job email
runs that complete with the status
notifications.
Success (No File). This setting tells the
system to notify the administrator by email notification whenever a job completes
successfully where no feed file was found in the folder to process (that is, success
with no file).
Default Behavior Different for New and Existing Clients
For existing clients, this setting will be set to No, meaning that no notification will be
sent unless the client specifically requests that the setting be activated (see below).
New clients from this service release going forward will have this setting set to Yes,
meaning emails will be sent to the administrator for this job type IF the specific job
definition is also configured to send an email notification.

Configuration
This setting is activated by submitting a Service Request to Concur, or contact your
Concur representative for more information.

Change in Behavior of ATM Transactions Imported as Regular Expenses
Overview
A change to how ATM withdrawals and
returns are handled for clients who have
configured their IBIP payment type to
import ATM transactions as regular
expenses is included in this release.

Business Purpose
This enhancement provides more
visibility to the import of this
transaction type.

Description of Change
Before this change only the return was imported and the withdrawal ignored on
import. Now, the system will import both the withdrawal and the return when the job
is configured to import ATM withdrawals as a regular expense. These transaction
types will continue to be hidden on import unless the client has configured the
ATMCHECK audit rule, and that rule is active at the time of import. If the job is
Concur Release Notes
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configured to import these transactions as cash advances, then the ATM withdrawal
and return will be ignored on import for IBIP programs.

Configuration
No additional configuration is required to use this feature.
Refer to Client Fact Sheet: Treating Corporate Card ATM Transactions as a
Regular Expense for information about the ATMCHECK audit rule and best
practice when working with ATM withdrawals as expense types.

Standard Accounting Extract: Processor Reference Number
Overview
A new field, Processor Reference
Number, is now added to the Standard
Accounting Extract at position 162.

Business Purpose
This enhancement adds additional data
options that can be extracted from
Expense.

This field captures the unique
transaction reference number assigned to the processor.

Configuration
No additional configuration is required to use this feature.

Card Icon Color is Selectable in Job Definition
Overview
Business Purpose
The administrator can now set up a job
definition and assign a color to the card
This enhancement allows the user to
icon that displays when card charges
quickly identify the card that was used
appear in My Concur or Expense - View
for the charges they are viewing.
Charges This is helpful for users who
employ multiple cards and want to know which card is responsible for the charges
they are viewing.
For example, a user with both an American Express Corporate Card and a Purchasing
Card (p-card) will not see any differentiation when viewing card charges in My
Concur. With this feature, an Iris color can be assigned to the Corporate Card and
Slate for the p-card. Now, when they are displayed, the user can quickly discern
which card generated the charges.

Available Color Choices
A sample of color choices are shown in the color palette below:
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Name

Color

Name

Sea

Grape

Iris

Suede

Peel

Blush

Slate

Teal

Sage

Rose

Color

Standard Colors - Defaults for selected cards
Mint
(AMEX)

Sunset
(MasterCard)

Sky
VISA

NOTE: If no card color is selected, the system will default to the standard default
color selections, for example Mint (AMEX), Sunset (MasterCard), and Sky
(VISA) colors.

Configuration
To configure this feature, the Integration administrator chooses the color choice
when setting up the job definition. This is done by selecting a color from the Card
Icon to Display drop down box.
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Section 5: Documentation Updates
The following documentation changes are included in this service release.

Release Notes Now Available in Product-Specific Documents
Overview
Business Purpose
With this release the client can now
choose from product-specific release
Administrators can now build the set of
notes, each document or group of
release notes they need for their site
documents matching a specific Concur
without sorting through unnecessary
offering. Now, if one administrator is
material.
tasked with reviewing resolved issues,
they can download a document with only case information in it. The Invoice user can
download either Invoice release notes, or both Invoice and Mobile if that solution
applies to the client site.
How It Works - Concur Client Central
Beginning in April a table will now be displayed when the user logs in to Concur and
proceeds to Release Documentation > Release Notes using the Resources menu.
The design of the table allows the client to use the uppermost row of the table to
quickly identify their Concur product and what notes are applicable to their solutions:
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Each set of release notes include descriptions on the cover detailing what supporting
products can be found within the document. For example, the client who reviews
Expense Pay changes does so by downloading the Expense - Professional/Premium
release notes.
Help System Updates
The Concur administrative Help systems now include links to release notes as well.
When the user opens administrative Help (only), the leftside navigational area now
features the What's New link for the product release notes, plus additional links to
Mobile if that product is applicable to the solutions at the client site.

With this update the administrator can now avoid logging in to Concur Client Central
to view the release notes for their product(s).
Restrictions
To ensure security and "no see" restrictions, only the administrative Help systems
(Expense Tools; Expense Admin; Invoice Admin, etc.) contain the release note links no End User Help system allows viewing of the notes.

Configuration
No additional configuration is required to use this feature.
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Section 6: Supported Configurations
The following configurations are either supported or no longer supported with this
service release.

Certifications for This Release
Support for Mac OS X Lion
Support for Mac OS X Lion (version 10.7) is certified for this release.

Support for Firefox v. 6.0
Support for Firefox version 6.0 under both the Mac OS X and Microsoft Windows
operating systems is certified for this release.

Support for Safari v. 5.1
Support for Safari 5.1 under Mac OS X Lion (version 10.7) is certified for this release.

Support for Google Chrome v. 13.0
Support for Google Chrome version 13.0 under both the Mac OS X and Microsoft
Windows operating systems is certified for this release.

Upcoming Certifications
Support for Firefox v. 7.0
Support for Firefox 7.0 under both the Mac OS X and Microsoft Windows operating
systems will be included in an upcoming release.

Support for Chrome v. 14.0
Support for Google Chrome 14.0 under both the Mac OS X and Microsoft Windows
operating systems will be included in an upcoming release.
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Legal Notice
This document contains proprietary information and data that is the exclusive
property of Concur Technologies, Inc., Redmond, Washington. No part of this
document may be reproduced, transmitted, stored in a retrievable system,
translated into any language, or otherwise used in any form or by any means,
electronic or mechanical, for any purpose, without the prior written consent of
Concur Technologies, Inc.
Information contained in this document applies to the following products in effect at
the time of this document's publication:
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The above product(s) and information contained in this document are subject to
change without notice. Accordingly, Concur Technologies, Inc. disclaims any
warranties, express or implied, with respect to the information contained in this
document, and assumes no liability for damages incurred directly or indirectly from
any error, omission, or discrepancy between the above product(s) and the
information contained in this document.
© 2004 – 2011 Concur Technologies, Inc., Redmond, Washington. All rights
reserved.
Concur® is the trademark of Concur Technologies, Inc. All other company and
product names are the property of their respective owners.
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18400 NE Union Hill Road
Redmond, Washington 98052
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Release Notes – October 2011
FOR CONCUR INTERNAL USE ONLY – DO NOT DISTRIBUTE OUTSIDE CONCUR

Finding Additional Product Release Notes
For Travel release notes, log in to Concur Client Central, then click Resources >
Document Library > Travel and then either TMC Partner or Direct Customers.
For all other products, log in to Concur Client Central, then click Resources >
Release Documentation > Release Notes to select and download additional
product-specific release notes matching your Concur solution(s):
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Section 1: Resolved Issues - Expense
Case ID

Case/Defect Description

110610000672

Product/Feature: Expense/User Admin

110921000359

110805000069

Description: The system will not perform a search for an employee who has
an apostrophe in their name, for example, O'Leary.
Resolution: The code is modified to now recognize and search where an
apostrophe is encountered, and to ignore only the search scenario where a
trailing space is encountered.
Product/Feature: Expense/Audit Rules
Description: A validation rule using the Code Not in and Not Equals for a list
validation finds that each works opposite, as Code in and Equals respectively.
Resolution: The code is modified to now include the Not operation when
using a Not condition against the validation table.

110809001299

Product/Feature: Expense/Itemization
Description: The Is Billable check box value is not copying down from the
parent to the Hotel and Hotel Tax items when itemizing an expense.
Resolution: The code is modified to include the isBillable property on child
expense entries, thereby setting in place the property that the copy down will
now overwrite with the correct value when itemizing.

110810000182

Product/Feature: Expense/Change Log
Description: A paging search in the Change Log for 500 or more records
causes the system to become unresponsive when the user selects a specific
page number rather than next page.
Resolution: A Start and End date filter is now added to the Change Log
page to prevent a timeout when a client attempts to jump from page 1 to a
non-sequential page, such as 7, or 50.

110823000681

Product/Feature: Expense/Itemizations
Description: Changing the expense type between two lodging expense types
causes the Travel Allowance check box to change from its configured value
of Yes (selected) to No (cleared).
Resolution: The code is modified to now clear the cache of the expense entry
in order to apply the correct default state for this check box.

110824001047
110916000229
110818000010

Product/Feature: Expense/Localization
Description: An exception message is returned to the user in English instead
of the expected language of the user.
Resolution: The code is modified to now pass the user's language so that the
exception message is localized in the correct language for the user.

110928000524
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Case ID

Case/Defect Description

110902000143

Product/Feature: Expense/Locations
Description: Audit rules using location names created or edited in Location
Admin are failing because the system is adding a trailing space at the 6th
position, causing a mismatch of the original name, for example, "US-GA"
compared to "US-GA " as the saved, 6 character version.
Resolution: The code is modified to now trim the trailing (6th) character
space, and to update all location names currently resident in the database
with this trailing space.

110908001309

Product/Feature: Expense/Authorization Request
Description: A user is allowed to enter the same category multiple times
within an authorization request - they should be limited to one per request.
Resolution: The code is modified to now take no action if the user attempts
to add another category that is identical to one already entered for the
request.

110916000145

Product/Feature: Expense/Itemizations
Description: A user manually entering a name in the Vendor Name field
does not see that vendor name in the itemized child entry - it is not copied
down from the parent expense.
Resolution: The code is modified to now display the name value.

110919000993

Product/Feature: Expense/Itemization
Description: The Travel Allowance check box is incorrectly being cleared
for itemizations when the user re-saves itemizations of the parent entry using
the Itemization Wizard.
Resolution: The code is modified to now review the child expense status
prior to re-saving the parent and, if the flag is set, reset the cleared flag on
the parent so that state would be copied down to the recreated child entries
on the Save action. This produces the same results as the initial itemization
action.

110926000008

Product/Feature: Expense/Travel Allowance
Description: The Processor role cannot see a travel allowance itinerary
attached to a report. Instead, they see a blank page.
Resolution: The APIs were mistakenly using the incorrect employee key of
the processor, preventing the processor or approver from viewing the
itinerary. The report owner key is now passed in correctly and the Processor
and Approver can now view the travel allowance itinerary.

110926000602
110926001023

Product/Feature: Expense/CC Transactions
Description: The date for an imported transaction shown on an expense
entry is different than that shown by hovering over the credit card icon - they
should match.
Resolution: The code was executing a copy down from the previous expense
entry. This is corrected to never copy down for a card transaction.
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Case ID

Case/Defect Description

110926001214

Product/Feature: Expense/Attendees
Description: Hovering the mouse pointer over the Attendees icon does not
display the list of attendees for the processor as expected.
Resolution: The code was attempting to access a key that had a null value.
The issue is fixed by redirecting the system to access the correct key so that
the attendee information is displayed for an end user, approver or processor
role.

110927000008
111001000004

Product/Feature: Expense/User Permissions
Description: A user not granted an administrative role is able to see and use
the Expense Admin link and access the classic interface - they should not have
these permissions.
Resolution: The code is modified to remove those roles from the database
Permissions list that are incorrectly allowing access to the administrative tab if
the user has certain other roles that, together, should not allow this access.

110930000249
110907001046

110930000359
111003000902

Product/Feature: Expense/Travel Allowance Import
Description: Duplicate records are reported in the error log of the Travel
Allowance import for USGSA rate service clients.
Resolution: The US government changed their country identifiers to use ISO
abbreviations in the October 2011 rate posting. The rate service import has
been modified to take this change into account and correct any resulting
errors previously imported.
Product/Feature: Expense/Attendees
Description: The system will stop responding when clicking Search or
Favorites for attendees if the SYSEMP attendee type is the first one
alphabetically (default) and Allow automatic creation of employees as
attendees check boxes are cleared.
Resolution: The SYSEMP value is being included and sorted when
determining the default attendee type to display in the Search combination
box - this is causing the system to become unresponsive. The issue is fixed by
isolating SYSEMP and not including it as an attendee type.

111003001435
111003000390
111009000121
111004000143

Product/Feature: Expense/Attendees
Description: An Unexpected Software Error (UE) is generated when
accessing the Attendee import templates within Expense Admin.
Resolution: An issue with calling a function that was not present is now
resolved. The code now calls a different function that contains the specific
session information required for this task.
Product/Feature: Expense/Processor List View
Description: If the processor performs a search on the Report List page and
the page includes the addition of any Central Reconciliation-specific columns,
the search results in the generation of an Unexpected Software Error (UE).
Resolution: The following changes are included in fixing this issue:
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•

The code is modified to now hide these columns so that they cannot be
added to the list view.

•

Clients who have added these columns will no longer see them after
upgrade to this service release - the columns will be removed from the
list view.

Page 5

Resolved and Known Issues Case List
Concur Clients

Case ID

Case/Defect Description

111012001293

Product/Feature: Expense/Personal Card Import
Description: Duplicate transactions are being imported due to unique
reference numbers generated after enabling Yodlee in the Personal Card
Import feature.
Resolution: A time difference generated when refreshing credit card created
transactions is causing this issue. The issue is resolved by removing the time
portion of a transaction date (it is unused) to prevent reinsertion of the
transaction.
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Section 2: Resolved Issues - Jobs
Case ID

Case/Defect Description

110803001295

Product/Feature: Jobs/List Import

110824000064

Resolution: The code was modified to process the feeds first in order of the
creation date, and then by file name.

Description: List import feeds are being processed in the wrong order.

110907000216
110815000251
110919001279

110825000876

Product/Feature: Jobs/Standard Accounting Extract (SAE)
Description: Credit Card information in the SAE is not decrypted from its
encrypted state when the encrypted field is passed to a transform.
Resolution: Added code to the transform logic to decrypt any encrypted
parameter fields, before the value for each parameter is passed to the
transform.
Product/Feature: Jobs/Credit Card Import
Description: Zero amount is displayed for line item in level 3 data.
Resolution: The Purchasing detail pop-up was modified to include the
value for the Total Line Amount field.

110907000650

Product/Feature: Jobs/Company Card Import
Description: Certain Bank of Montreal Interest Advances fees are hidden
upon import.
Resolution: Modified the MasterCard CDF 3.0 importer to recognize
AdjustmentReasonCode value of AD04 as an Other Bank Change. The visibility
of these charges will be based on the card’s configuration.
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Section 3: Documentation Updates
The following documentation changes are included in this service release.

Release Notes Now Available in Product-Specific Documents
Overview
Business Purpose
With this release the client can now
choose from product-specific release
Administrators can now build the set of
notes, each document or group of
release notes they need for their site
documents matching a specific Concur
without sorting through unnecessary
offering. Now, if one administrator is
material.
tasked with reviewing resolved issues,
they can download a document with only case information in it. The Invoice user can
download either Invoice release notes, or both Invoice and Mobile if that solution
applies to the client site.
How It Works - Concur Client Central
Beginning in April a table will now be displayed when the user logs in to Concur and
proceeds to Release Documentation > Release Notes using the Resources menu.
The design of the table allows the client to use the uppermost row of the table to
quickly identify their Concur product and what notes are applicable to their solutions:
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Each set of release notes include descriptions on the cover detailing what supporting
products can be found within the document. For example, the client who reviews
Expense Pay changes does so by downloading the Expense - Professional/Premium
release notes.
Help System Updates
The Concur administrative Help systems now include links to release notes as well.
When the user opens administrative Help (only), the leftside navigational area now
features the What's New link for the product release notes, plus additional links to
Mobile if that product is applicable to the solutions at the client site.

With this update the administrator can now avoid logging in to Concur Client Central
to view the release notes for their product(s).
Restrictions
To ensure security and "no see" restrictions, only the administrative Help systems
(Expense Tools; Expense Admin; Invoice Admin, etc.) contain the release note links no End User Help system allows viewing of the notes.

Configuration
No additional configuration is required to use this feature.
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Legal Notice
This document contains proprietary information and data that is the exclusive
property of Concur Technologies, Inc., Redmond, Washington. No part of this
document may be reproduced, transmitted, stored in a retrievable system,
translated into any language, or otherwise used in any form or by any means,
electronic or mechanical, for any purpose, without the prior written consent of
Concur Technologies, Inc.
Information contained in this document applies to the following products in effect at
the time of this document's publication:
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The above product(s) and information contained in this document are subject to
change without notice. Accordingly, Concur Technologies, Inc. disclaims any
warranties, express or implied, with respect to the information contained in this
document, and assumes no liability for damages incurred directly or indirectly from
any error, omission, or discrepancy between the above product(s) and the
information contained in this document.
© 2004 – 2011 Concur Technologies, Inc., Redmond, Washington. All rights
reserved.
Concur® is the trademark of Concur Technologies, Inc. All other company and
product names are the property of their respective owners.
Published by Concur Technologies, Inc.
18400 NE Union Hill Road
Redmond, Washington 98052
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Release Notes – November 2011
Finding Additional Product Release Notes
For Travel release notes, log in to Concur Client Central, then click Resources >
Document Library > Travel and then either TMC Partner or Direct Customers.
For all other products, log in to Concur Client Central, then click Resources >
Release Documentation > Release Notes to select and download additional
product-specific release notes matching your Concur solution(s):
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Section 1: Enhancements From Client Suggestions Forum
The following features were submitted using Concur's Suggestion service, available
via Concur's forums. They are now included in this service release.
•

Add Attendees Enhancement Saves Keystrokes and Time
Users will no longer need to re-open a search and select window to add an
additional attendee to their report. Now, the user may add one attendee after
another, exiting this window only when they are done.

•

Improved Attendee Import Error Messaging
Error messages generated when an attendee import fails are now clearer and
include more detailed information.

•

Company Card Administrator is now Group Aware
The Company Card Admin role is now a Group-aware role.
Each of the features in this section is described in brief here, and in more
detail in their respective sections within this document - if you need additional
information please refer to these sections.
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Section 2: Expense
The following features are included in this service release.

Company Card Administrator Role is now Group Aware
Overview
Business Purpose
With this release the Expense Company
Card Administrator role is now GroupThis enhancement is based on a
aware. This means that the user
Solution Suggestion from our clients.
assigned this role is restricted to
working only with those users who share the same group hierarchy either directly or
through group inheritance.
As an example, assume two groups, one Sales, one R&D, both under the Global
group. A user assigned this role at the Sales group level can edit, assign, and
otherwise perform all card-related actions for Sales. However, they cannot perform
these functions for any users in the R&D group.
Alternatively, if the user assigned this role is granted the role at the Global group
level, they can work with both Sales and R&D (and any other group under Global)
since these groups inherit Global group permissions and the administrator is granted
these permissions through inheritance.
Refer to Expense: Company Card Administrator User Guide for more
information.

Attendees: Improved Error Messaging in Personal Attendee Import
Overview
With this release the error messages
displayed by the system when issues
are found importing attendees are
improved for readability and clarity.
The personal attendee import from
within the expense allows the user to
import a list of attendees in an excel file
to the expense.

Business Purpose
This enhancement brings clear
messaging to the error messages in
attendee management, and provides
user guidance on actions they can
take.

Three enhanced messages have been added:
•

Invalid Attendee Type: An invalid or blank value for attendee type now
generates the message "Attendee Type is missing or invalid. Record cannot be
further validated".
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•

Required Field Left Blank: A required field type that is incorrectly left blank
now generates the message "Missing required field: <fieldname>".

•

Invalid value in a Field: A list item field containing an invalid value now
generates the message "Invalid list item value in:<fieldname>".

The View Errors tab displays any errors caused by the attendee import:

Refer to Expense: Attendees Setup Guide for more information.

Attendees: Search and Add Multiple Attendees at a Time
Overview
Business Purpose
A small usability change to the Attendee
functionality will now save the user
This usability enhancement saves the
additional keystrokes. With this release,
user time/clicks by reducing the
when working with attendees in the
number of actions required to add
Search Attendees window, Favorites,
multiple attendees.
Recently Added, or Groups tab attendee
options, the window remains open so
the user can add additional attendees. Prior to this change, the window (or similar
option) would close, requiring the user to re-open it.
This change is intended to allow the user to search for and add multiple attendees
without need to reopen the closed window. Instead, when the user has finished
adding all attendees, they click Cancel (or equivalent) to exit the window at that
time.
Refer to Expense: Attendees Setup Guide for more information.

Merchant Code Mapping Now Available In Current User Interface
Overview
The Merchant Code Mapping
functionality is now available in Expense
Admin. This feature is in full parity with
the classic user interface.
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administrative function to the current
user interface.
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To access in the current user interface, click Administration > Expense
Tools > Company Card > Merchant Code Mapping tab:

Refer to Expense: Company Card Administrator User Guide for more
information.

Travel Allowance: Display the Per Diem Rate by Date for Hotel Results
Overview
A user booking a hotel within a specified
date range will now be able to view the
per diem hotel rates in the search
results for the dates they have entered.
This guides the user to make more
informed choices about the hotel they
choose to stay in.

Business Purpose
This enhancement allows the employee
to make informed choices about travel
purchases by providing more
information to the purchaser.

This feature is available to companies using both Travel and Expense, are using
travel allowances for lodging within Expense, and have configured their Travel
system to display per diem rates on their hotel search results:

The results are displayed directly under the results listed by the system when the
user performs a hotel search:
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NOTE: Within the Expense area, the application will create a new location record for
each hotel location in the United States that does not exist when the query is
run. These new locations are created with the applicable state, county, and
city names filled in based on a lookup of the data from the hotel zip code.

Support for Carlson Hotel E-Receipts
Overview
Support for eReceipts generated by any
of the Carlson family of lodging choices
is included in this release.

Business Purpose
This enhancement customizes the hotel
booking and receipt display experience.

This means Carlson brand-specific
logos, and room numbers for selected lodging choices, is now displayed to the user.

Travel Allowance: New Options for Calculation of Partial Day Allowance
Overview
This service release includes updates for
new options in the calculation of the
allowance for a partial day of travel for
Austrian travel allowance.
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flexibility to the Austrian travel
allowance module.
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Refer to Travel Allowance Configuration Guide: Austria for more information.
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Section 3: Expense Pay
The following features are included in this service release.

Expense Pay APA: Australia Now Available
Overview
The Expense Pay APA: Australia offering
is now available for Australian clients.
This offering includes the following
features:

Business Purpose
This new feature expands Expense Pay
availability to Australia.

•

Funding Account Page localized
for Australian bank accounts.

•

User Bank Information page localized for Australian bank accounts.

•

Employee Import Record 810 updated to support Australian bank accounts.

•

The User Import has been updated to support Australian bank accounts.

Configuration
Interested clients will need to purchase this feature from Concur. Contact Concur
Client Services for more information.
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Section 4: Jobs
The following features are included in this service release.

Change to American Express TMKD Merchant Code Mapping
Overview
Business Purpose
With this service release the American
Express TMKD importer defaults the
This enhancement provides better
Merchant Category code for Travel
control over the expense type mapping
Agent charges to the generic MCC for
for travel agent charges versus airline
TRAVEL AGENCIES, 4722. Prior to this
charges.
release, the importer mapped those
charges to the Merchant Category code 0000. The current system default for
Merchant Category code 4722 is the travel agency charges expense type.
This change provides greater flexibility for the client by allowing the client to specify
different expense types for Travel Agent charges and other charges. Clients should
anticipate this modified behavior and leverage the new mapping if desired.

Support for Australia in the EFT Detail Bank Account Record Set
Overview
Australia is now added to the list of
countries supported within the 810 EFT
Detail Bank Account imported of the
employee import.

Business Purpose
This enhancement adds another
country to those whose bank account
information can be imported using the
employee import tool.

Refer to Chapter 4: Employee Import of the Expense – Import and Extract
Specifications manual for more information.

Request Processor Roles Added for Import via the Employee Import
Overview
Three processor roles are now added to
the 400-level record for import to Travel
Request:
•

TMC Agent

•

Travel Request Administrator
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•

Travel Request Auditor

All roles are Group-aware, and restrictions are applied that prevent assignment of
two of these roles to a single user.
Refer to Chapter 4: Employee Import of the Expense – Import and Extract
Specifications manual for more information.
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Section 5: Documentation Updates
The following documentation changes are included in this service release.

Release Notes Now Available in Product-Specific Documents
Overview
Business Purpose
With this release the client can now
choose from product-specific release
Administrators can now build the set of
notes, each document or group of
release notes they need for their site
documents matching a specific Concur
without sorting through unnecessary
offering. Now, if one administrator is
material.
tasked with reviewing resolved issues,
they can download a document with only case information in it. The Invoice user can
download either Invoice release notes, or both Invoice and Mobile if that solution
applies to the client site.
How It Works - Concur Client Central
A table displays when the user logs in to Concur and proceeds to Release
Documentation > Release Notes using the Resources menu. The design of the table
allows the client to use the uppermost row of the table to quickly identify their
Concur product and what notes are applicable to their solutions:
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Each set of release notes include descriptions on the cover detailing what supporting
products can be found within the document. For example, the client who reviews
Expense Pay changes does so by downloading the Expense - Professional/Premium
release notes.
Help System Updates
The Concur administrative Help systems now include links to release notes as well.
When the user opens administrative Help (only), the leftside navigational area now
features the What's New link for the product release notes, plus additional links to
Mobile if that product is applicable to the solutions at the client site.

With this update the administrator can now avoid logging in to Concur Client Central
to view the release notes for their product(s).
Restrictions
To ensure security and "no see" restrictions, only the administrative Help systems
(Expense Tools; Expense Admin; Invoice Admin, etc.) contain the release note links no End User Help system allows viewing of the notes.

Configuration
No additional configuration is required to use this feature.
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Section 6: Supported Configurations
The following configurations are either supported or no longer supported with this
service release.

Certifications for This Release
Support for Mac OS X Lion
Support for Mac OS X Lion (version 10.7) is certified for this release.

Support for Firefox v. 6.0
Support for Firefox version 6.0 under both the Mac OS X and Microsoft Windows
operating systems is certified for this release.

Support for Safari v. 5.1
Support for Safari 5.1 under Mac OS X Lion (version 10.7) is certified for this release.

Support for Google Chrome v. 13.0
Support for Google Chrome version 13.0 under both the Mac OS X and Microsoft
Windows operating systems is certified for this release.

Upcoming Certifications
Support for Firefox v. 7.0
Support for Firefox 7.0 under both the Mac OS X and Microsoft Windows operating
systems will be included in an upcoming release.

Support for Chrome v. 14.0
Support for Google Chrome 14.0 under both the Mac OS X and Microsoft Windows
operating systems will be included in an upcoming release.
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Legal Notice
This document contains proprietary information and data that is the exclusive
property of Concur Technologies, Inc., Redmond, Washington. No part of this
document may be reproduced, transmitted, stored in a retrievable system,
translated into any language, or otherwise used in any form or by any means,
electronic or mechanical, for any purpose, without the prior written consent of
Concur Technologies, Inc.
Information contained in this document applies to the following products in effect at
the time of this document's publication:
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The above product(s) and information contained in this document are subject to
change without notice. Accordingly, Concur Technologies, Inc. disclaims any
warranties, express or implied, with respect to the information contained in this
document, and assumes no liability for damages incurred directly or indirectly from
any error, omission, or discrepancy between the above product(s) and the
information contained in this document.
© 2004 – 2011 Concur Technologies, Inc., Redmond, Washington. All rights
reserved.
Concur® is the trademark of Concur Technologies, Inc. All other company and
product names are the property of their respective owners.
Published by Concur Technologies, Inc.
18400 NE Union Hill Road
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Release Notes – November 2011
FOR CONCUR INTERNAL USE ONLY – DO NOT DISTRIBUTE OUTSIDE CONCUR

Finding Additional Product Release Notes
For Travel release notes, log in to Concur Client Central, then click Resources >
Document Library > Travel and then either TMC Partner or Direct Customers.
For all other products, log in to Concur Client Central, then click Resources >
Release Documentation > Release Notes to select and download additional
product-specific release notes matching your Concur solution(s):
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Section 1: Resolved Issues - Expense
Case ID

Case/Defect Description

110506000039

Product/Feature: Expense/VAT
Description: VAT appears to be missing from the report.
Resolution: The code was not properly updating the Has VAT flag to No when
the location of the expense is changed.

110519000829

Product/Feature: Expense/Expense Reports
Description: The Expense "Pending Report" view is not including reports
currently in Cost Object Approval approval status.
Resolution: The query for this view is changed to now include reports that
are pending cost object approval.

110623000294

Product/Feature: Expense/Expense Types
Description: The search function for expense types is not working. The code
cannot properly handle expense types that are entirely a numeric value, and
instead displays an error.
Resolution: All expense types are now treated as strings to avoid throwing
an error when failing an upper case check.

110623000409

Product/Feature: Expense/Connected Lists
Description: Uploading a connected list generates an error message.
Resolution: A large number of error message lines caused this issue. The
code is modified to manage the error message lines if they are over 100 in
number.

110624000781
110804000771

Product/Feature: Expense/Email Reminders
Description: Email reminder to approve is sent to cost object approver who
has already approved the report. These notifications should be sent only to
approvers who have not yet approved their cost object.
Resolution: Completed cost object approval status is now included in the
overall query determining who should or should not receive email reminder
notifications to approve.

110725000198

Product/Feature: Expense/Delegates
Description: A delegate is incorrectly given permissions to delete receipts
after an expense report is submitted if that delegate had been working with
the report prior to or during submission by a different user.
Resolution: A check is now made to determine the state of the report prior to
allowing or disallowing deletion of a receipt.

110808000243
110921000893
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Product/Feature: Expense/Receipt Images
Description: Receipt hover over window closes when the user tries to resize
it.
Resolution: Concur will allow more time after the mouse out before the popup closes, and cancel the close dialog if user does a re-size.

Page 3

Resolved and Known Issues Case List
Concur Clients

Case ID

Case/Defect Description

110810000042

Product/Feature: Expense/Localization

110810000008

110819000028

Description: An exception is not shown in the correct localized language
unless the user exits, then reopens the report.
Resolution: The language code information required to display the localized
text was not being passed, resulting in the default English language. This is
now resolved.
Product/Feature: Expense/User Interface
Description: Client Request: Move the Expense list View dropdown menu to
the left so that it does not partially cover the right pane.
Resolution: The View dropdown menu is now moved to be right aligned to
the button so that it does not cover the right pane.

110822000022

Product/Feature: Expense/Attendees
Description: New user cannot search for and add their own This Employee
record to their favorite attendee list.
Resolution: The behavior is changed to now automatically create the user’s
This Employee entry in the database on search for that attendee type.
Previous behavior only created the record when the user created an expense
that includes the attendee field.
NOTE: The setting Allow automatic creation of employees as attendees needs
to be selected to support this behavior.

110823000568

Product/Feature: Expense/Tax Totals
Description: Parent entry tax totals do not match the sum of the child tax
amounts.
Resolution: The totals are now recalculated at the parent entry level.

110914001081

Product/Feature: Expense/Receipt Report
Description: The PDF file generated when printing a receipt report is not
created and the error message "Failed to download report as a PDF file. Please
right click on the page and select Back to go back to the previous screen, or
close the window to return to the main application." is generated.
Resolution: A report with barcodes cannot be printed in the PDF format.
However, the option to do so was appearing via several paths to the printed
report option. These paths are closed to the user now.
NOTE: A future service release will include the ability to print reports with
barcodes in PDF format.

110922000350

Product/Feature: Expense/
Description: The Attendee Last Name field is incorrectly shown as not
required - this is a system-required field type.
Resolution: The code is now modified to force the Attendee Last Name
field to be a Required field type.

110922000757

Product/Feature: Expense/Localization
Description: A label on the Attendee window incorrectly shows English when
creating an expense. It only changes to the correct, localized label after the
expense report is submitted.
Resolution: The code that was treating the Attendee field name differently
depending on the submit status of the report is removed to fix this issue.
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Case ID

Case/Defect Description

110927000265

Product/Feature: Expense/Expense Types
Description: The Travel Allowance field is not displaying in the Edit
Multiple Fields window if the multiple expenses do not all have the same
value.
Resolution: A change introduced in an earlier service release required the
use of a new property "OriginalAccess" in bulk editing - this is now included to
remedy this issue.

110927000652

Product/Feature: Expense/Forms & Fields
Description: A Processor or Approver is incorrectly prevented from editing
form fields.
Resolution: Modify code so that the form-level access permissions (allocation
table row access) do not override the form field access configuration
(allocation field access within a row).

110927001312

Product/Feature: Expense/Validation Rules
Description: The system is not correctly determining the account code on an
Entry Save action. This is happening because the validation rule is updating a
field on Entry Save, but is not using the new value to determine and update
the account code.
Resolution: The system will now set the updated field on the entry object so
it is present during the account code lookup.

110927001812

Product/Feature: Expense/Vendor Lists
Description: The Vendor List drop down control continues to display vendors
from a deleted vendor list.
Resolution: Lists of the criteria "is_deleted=Y" are now excluded from the
query list that populates this drop down control.

110928000589

Product/Feature: Expense/Printed Reports
Description: A printed report displays the Audit Trail entries in the wrong
order in the report. Re-opening the report fixes the issue.
Resolution: Code to force order by audit date is added to display the Audit
Trail section in the correct location.

110929000017

Product/Feature: Expense/Travel Allowance
Description: Deductions for meal amounts for travel allowance are calculated
incorrectly when the user selects and then clears the provided meals boxes.
Resolution: To resolve, calculations are now performed using a different
table reference.

110929001012

Product/Feature: Expense/Expense Types
Description: Processor cannot change the expense types for itemizations but
can do so for the parent expense type - both behaviors are incorrect.
Resolution: The issue is fixed so that the Processor can now edit expense
types for itemized entries, but is prevented from editing parent entries or
editing hotel expenses for regular entries.
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Case ID

Case/Defect Description

110929001166

Product/Feature: Expense/Travel Allowances
Description: Client Request: If a travel allowance Fixed Expense type is not
active for a policy, the system should throw an Exception with detailed
information about the error.
Resolution: The code is modified to throw the exception and display detailed
text on the error.

110930000650

Product/Feature: Expense/Employee Form
Description: The addition of a Boolean field to the employee form causes an
error message to appear.
Resolution: The control for the Boolean field is a check box, but internally
was interpreted as a list control. This is now corrected.

110930001287

Product/Feature: Expense/Receipt Images
Description: Attendee audit rules based on frequency or total cost for a
certain period - period was not being considered to calculate the frequency
when in the context of same expense report.
Resolution: Modified the code to consider the period information while doing
the frequency or cost calculation.

111003001765

Product/Feature: Expense/
Description: A list of expense types incorrectly displays when editing and
saving an existing expense and moving to the next one.
Resolution: The user is now moved to the next existing expense after saving
the previous one by clicking Yes on the prompt that appears.

111004000041

Product/Feature: Expense/VAT
Description: System is not properly updating adjusted tax values in record
when processor sets the reclaim to zero.
Resolution: Code was calculating the amounts on approve, and has been
updated to recalculate the adjusted tax amounts during the save process.

111004001442

Product/Feature: Expense/Hierarchies
Description: A large number of hierarchy nodes within an Expense hierarchy
certain policy admin actions timeout prior to completion:
•

Activating or deactivating a print report on a policy

•

Adding or editing a policy

•

Activating or deactivating an expense type

This is due to the length of time taken to perform the security check.
Resolution: The issue is resolved by reducing the overall number of nodes to
only those that need to be scanned within the table.
111005000040
110830000005
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Product/Feature: Expense/Processor: Send to Excel
Description: Double-byte characters are not rendered correctly in the Excel
file generated by the Processor using the Send to Excel feature.
Resolution: The Excel output request is moved in the code to avoid using a
third-party component that does not support double byte character display.
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Case ID

Case/Defect Description

111005000244

Product/Feature: Expense/Attendee Types
Description: The Attendee Types list is not loading when the user's session
uses a language code that exceeds 3 characters.
Resolution: The language code can now be up to 5 characters.

111010000613

Product/Feature: Expense/Email Notifications
Description: Employees are incorrectly included or excluded from email
notifications for company card email reminder job.
Resolution: The issue is resolved by referencing a different key for the list of
employee to email.

111012000005

Product/Feature: Expense/Character Display
Description: Double-byte characters are saved incorrectly for exception
messages.
Resolution: The correct datatype is now used by the stored procedure to
save the exception message in the correct format and support double-byte
language types.

111014000008

Product/Feature: Expense/VAT
Description: VAT is not being calculated for fixed meals expenses when the
expenses are automatically itemized by the system.
Resolution: The code for creating fixed expenses was only creating VAT for
Fixed Meals and Fixed Lodging, but not the Fixed Meals (Gross), Provided
Meals, Taxable Meals, and Overnight itemization types.

111014000434

Product/Feature: Expense/Hierarchies
Description: Description: When a report is created the point-in-time report
hierarchy value is saved on the report. If one of those hierarchy segment
values is deleted after report creation, then afterwards the report header
cannot be re-saved. The error message "Report Save Status: This report could
not be saved. The reporting hierarchy for this user is not correct" is displayed.
Resolution: The report header is now allowed to update without an unneeded
check on the reporting hierarchy node.

111021000005

Product/Feature: Expense/Error Messaging
Description: The message "Success! Undefined" appears when the processor
changes approval status for multiple reports. The message should simply read
"Success!".
Resolution: A variable that can be displayed in this error message was being
overwritten by an incorrect value "Undefined". This is now resolved.

111024000489

Product/Feature: Expense/Cost Object Workflow
Description: The 710 level import is failing.
Resolution: Cost object segments are now validated for placement at the
correct level and in the correct list, and will also validate parent references.

111024000586

Product/Feature: Expense/Localization
Description: Inconsistent translation of Smart Expenses in French.
Resolution: All text phrases using this term have been reviewed and
modified by Concur France office.
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Case ID

Case/Defect Description

111025001408

Product/Feature: Expense/Receipts
Description: Receipts Required is not updating if an image is dragged and
dropped to an expense from Receipt Store.
Resolution: Code is modified to re-evaluate receipts required rules when an
image is added or removed from the entry.

111027000657

Product/Feature: Expense/Workflow
Description: While an approver is viewing a report for approval and the user
recalls the report, changes something and submits the report again, the
approver is not notified that the report has been changed and allows the
approver to approve.
Resolution: The code now checks the current status of the report before
executing the approval.

111031001552

Product/Feature: Expense/Travel Allowance
Description: When importing hotel reservation data to the travel allowance
itinerary, the Hotel Departure row is in the wrong position.
Resolution: If hotel departure time is after air on same day then fix the hotel
departure time to be 2 hours before air departure.

111103000812

Product/Feature: Expense/Attendees
Description: The user creates a new attendee from within the expense, and
then tries to edit that same attendee and receives an exception message
about versioning.
Resolution: Auto-population of the external ID with attendee versioning on
was creating a new version of the record, and has been corrected.

111103001136

Product/Feature: Expense/VAT
Description: A negative amount calculated under Canadian VAT RITC is
causing an error when the Processor is saving the entry. This is incorrect
behavior because for RITC, the tax amount is negative for positive expense
amounts.
Resolution: A new validation is now used to verify the calculated amount. In
this validation, the following is performed:

111104000756

♦

Absolute tax amount cannot be greater than absolute expense
amount

♦

If the original tax amount is negative, the new tax amount cannot be
positive

♦

If the original tax amount is positive, the processor cannot modify it
to negative

Product/Feature: Expense/Smart Expenses
Description: When the user manually enters an expense, the smart matching
logic is attempting to match to card transactions that are outside the amount
boundaries.
Resolution: While saving an expense, the system will no longer prompt the
user for possible matching if there are no credit card transactions within a
specified amount range.

Concur Release Notes
November 2011

Page 8

Resolved and Known Issues Case List
Concur Clients

Section 2: Resolved Issues - Jobs
Case ID

Case/Defect Description

110804000032

Product/Feature: Jobs/Company Card Import
Description: Some payment transactions in American Express GL1025 were
not recognized as payments, and were incorrectly hidden.
Resolution: The code was modified to recognize the transactions as
payments.

110906000050

Product/Feature: Jobs/Employee Import
Description: Employee Import job run details includes a message about a
“bad records log file”.
Resolution: The bad records log is a remnant of On Premise code and is not
useful to the hosted offering. The code was modified to remove reference to
the file.

110926000900

Product/Feature: Jobs/Company Card Import
Description: Some payment transactions in American Express GL1025 were
not recognized as payments and were incorrectly hidden.
Resolution: The code was modified to recognized the transactions as
payments.

110930001045

Product/Feature: Jobs/ Company Card Import
Description: New American Express card accounts aren’t automatically
assigned to the employee.
Resolution: Modified the importer for the American Express KR1025 US to
automatically assign card accounts when possible.

111031000077

Product/Feature: Jobs/Imports
Description: The date and time stamp applied to import jobs is placing them
out of order. This date/time stamp is currently set to yyyyMMddHHmmss.
Resolution: To resolve this issue, the time stamp is changed to remove the
time of day (HHmmss). It is now set to yyyyMMdd.
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Section 3: Documentation Updates
The following documentation changes are included in this service release.

Release Notes Now Available in Product-Specific Documents
Overview
Business Purpose
With this release the client can now
choose from product-specific release
Administrators can now build the set of
notes, each document or group of
release notes they need for their site
documents matching a specific Concur
without sorting through unnecessary
offering. Now, if one administrator is
material.
tasked with reviewing resolved issues,
they can download a document with only case information in it. The Invoice user can
download either Invoice release notes, or both Invoice and Mobile if that solution
applies to the client site.
How It Works - Concur Client Central
Beginning in April a table will now be displayed when the user logs in to Concur and
proceeds to Release Documentation > Release Notes using the Resources menu.
The design of the table allows the client to use the uppermost row of the table to
quickly identify their Concur product and what notes are applicable to their solutions:
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Each set of release notes include descriptions on the cover detailing what supporting
products can be found within the document. For example, the client who reviews
Expense Pay changes does so by downloading the Expense - Professional/Premium
release notes.
Help System Updates
The Concur administrative Help systems now include links to release notes as well.
When the user opens administrative Help (only), the leftside navigational area now
features the What's New link for the product release notes, plus additional links to
Mobile if that product is applicable to the solutions at the client site.

With this update the administrator can now avoid logging in to Concur Client Central
to view the release notes for their product(s).
Restrictions
To ensure security and "no see" restrictions, only the administrative Help systems
(Expense Tools; Expense Admin; Invoice Admin, etc.) contain the release note links no End User Help system allows viewing of the notes.

Configuration
No additional configuration is required to use this feature.
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Legal Notice
This document contains proprietary information and data that is the exclusive
property of Concur Technologies, Inc., Redmond, Washington. No part of this
document may be reproduced, transmitted, stored in a retrievable system,
translated into any language, or otherwise used in any form or by any means,
electronic or mechanical, for any purpose, without the prior written consent of
Concur Technologies, Inc.
Information contained in this document applies to the following products in effect at
the time of this document's publication:

Travel & Expense, November 2011

The above product(s) and information contained in this document are subject to
change without notice. Accordingly, Concur Technologies, Inc. disclaims any
warranties, express or implied, with respect to the information contained in this
document, and assumes no liability for damages incurred directly or indirectly from
any error, omission, or discrepancy between the above product(s) and the
information contained in this document.
© 2004 – 2011 Concur Technologies, Inc., Redmond, Washington. All rights
reserved.
Concur® is the trademark of Concur Technologies, Inc. All other company and
product names are the property of their respective owners.
Published by Concur Technologies, Inc.
18400 NE Union Hill Road
Redmond, Washington 98052
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Release Notes – December 2011
Finding Additional Product Release Notes
For Travel release notes, log in to Concur Client Central, then click Resources >
Document Library > Travel and then either TMC Partner or Direct Customers.
For all other products, log in to Concur Client Central, then click Resources >
Release Documentation > Release Notes to select and download additional
product-specific release notes matching your Concur solution(s):

Concur Release Notes
December 2011

Page 2

Expense Professional / Premium
Concur Clients

Section 1: Enhancements From Client Suggestions Forum
The following features were submitted using Concur's Suggestion service, available
via Concur's forums. They are now included in this service release.
•

Suppress the Add Attendee Button In Expenses Attendee Table
To prevent duplicate attendees in a single expense, the administrator can now
suppress the Add Attendee button using a new setting at the Policy level.

•

Create an Attendee Group from a Submitted Report
Users can now create an attendee group from an expense report that has
been submitted - this allows any user with access to the view-only report to
assemble the attendee group (all or part) from the report.

•

Reposition the Attendee Count Column for Easier Laptop Viewing
The Attendee Count column can now be repositioned within the grid for ease
of viewing for those with laptop or netbook devices.

•

Custom Text Enhancement for Receipts Required Feature
The text that reminds a user submitting a report to include receipts as per
company policy can now be customized and localized by the administrator.

•

Mexican CFD XML File Enhancements
Enhancements to support the Mexican requirement for electronic invoices in
XML format are included in this release.

•

TIFF File Format Support in Receipt Store
The TIFF/TIF file format is now supported in the Receipt Store feature.
Each of the features in this section is described in brief here, and in more
detail in their respective sections within this document - if you need additional
information please refer to these sections.
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Section 2: Expense
The following features are included in this service release.

Attendees - Usability Enhancements
Overview
Several enhancements for the
Attendees feature are included in this
service release. Please see the product
documentation for additional
information.

Business Purpose
These enhancements provide additional
flexibility when working with advanced
attendee tracking.

Re-Position the Attendee Count Column in the Attendee Table
The Attendee Count column in the Attendee Detail Form view can now be moved to
a different location within the grid by modifying the Attendee Detail form. This
enhancement allows the administrator to move this column to a more visible area
within the view, allowing users working with laptops or netbooks with smaller
screens to more easily review or edit the total count for the attendees they are
working with.

CONFIGURATION
To move the field, the Expense admin first opens the Attendee Detail View form in
Forms and Fields, then, using standard drag and drop technique, moves the field to
its new location (in the figure below, to the second position from the leftmost):

The result is displayed in all attendee grid-type displays (Detail, Summary) that
include attendee count, with the new location as shown in the figure below:
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Create Attendee Group Using the View-Only Submitted Expense Report
Users can now create an attendee group from attendees included in an expense
report that has been submitted. This allows any user with access to the view-only
report to assemble the attendee group (all or part) from an expense in the report.
The user is no longer prevented from doing this simply because the report is
submitted. This allows the user to quickly and easily create a group for use on
additional expenses for the same event.

Suppress the New Attendee Button in the Attendee Table
Often, a user will add an attendee without validating that the attendee has already
been added to the list of available attendees. To avoid adding duplicate attendees,
and to encourage the user to instead search for an attendee first, the administrator
can now prevent the Add New Attendees button from appearing in the expense
entry attendee grid.
Configuration
Suppressing the Add New Attendees button is performed on a per-expense type
basis by selecting the expense and modifying the configuration. To do this, click
Expense Admin > Policies, then highlight the policy and click Expense Types:

In Modify Expense Type Properties, clear (deactivate) the Display the Add New
Attendees button from the attendee table check box to prevent display:
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Tooltip Added to Attendee Table and Search Dialog Box
Tooltips are now added to several attendee-related buttons in order to clarify the
functions they perform for the end user adding attendees to an expense report. This
enhancement is intended to help the user choose the correct action when working
with attendees.
This functionality extends to the New Attendee, Search, and Add to Expense
buttons on the expense entry, and within the search dialog for attendees. The figure
below shows the tooltip for the New Attendee button:

Refer to Expense: Attendees Setup Guide for more information.

Mexican CFD XML Usability Enhancements
Overview
Several enhancements for the Mexican
CFD XML invoice feature are included in
this service release. Please see the
product documentation for additional
information.
Concur Release Notes
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Hover-Over Action Displays CFD Image Certificate Information
A user who has uploaded a Comprobante Fiscal Digital (CFD) XML file in compliance
with new Mexican regulations for invoice submission can now view selected summary
information about that invoice.
This is done by hovering the mouse pointer over the icon that appears when the CFD
has been uploaded for the expense. The following fields are displayed:
•

Certificate Number

•

Vendor Description

•

Tax ID

•

Total Amount

The hover over reveals the information in row display. If the original XML file is
required, such as for auditing purposes, the file as a whole can be retrieved by
clicking View CFD as shown in the figure below:

Has CFD XML File Expense Entry Object for Condition Editor
A new field, Has CFD XML File, is now available for building audit, workflow, and VAT
rules, and for processor queries as well. The intent of this new field is to identify
those reports that include a Comprobante Fiscal Digital (CFD) XML image.
In the figure below, the administrator builds a rule that blocks submission when the
expense entry does not have a CFD image associated with it:
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TIFF / TIF File Format Support Under Receipt Store
Overview
The Receipt Store feature in Expense
now supports the TIFF / TIF file format.
Receipt Store is used to upload and
store image files for attachment to
expense entries created within the
expense report.

Business Purpose
This enhancement brings another
supported image format to the Receipt
Store feature.

Refer to Expense: Receipt Handling - Receipt Store Setup Guide for more
information.

Locations - Search for and Display System-Created Locations
Overview
Business Purpose
New search functionality in the
Locations feature allows an
This enhancement lets the
administrator to now search for systemadministrator quickly identify and
generated locations within a specified
review system-created locations.
date range. This enhancement is useful
to clients using the new travel allowance rate display within hotel booking - this
feature causes the system to auto-create US locations based on retrieved rate
information. Clients may wish to review these system-generated locations, hence the
ability to search for and view these location types.
For more information about the display of allowance information in the hotel
booking process, refer to the Concur Travel release notes.
Using the Updated Locations Search Functionality
Two new filter options are added to the search functionality, System Created and
Last Modified. Use the System Created criteria to filter the results based on either
system created, non-system created, or all cities. Filter the results further by
selecting the date range, either before or after, the date you select.
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In the figure below, cities created by the system prior to December 16th 2011 will
appear in the result set when the user clicks Search:

Refer to Expense: Locations Setup Guide for more information.

Additional Calculation Methods for Variable Rate Car Mileage
Overview
Business Purpose
A new calculation method specifically for
personal and company car mileage
This enhancement provides flexibility in
configurations incorporating time bands
meeting local regulatory requirements
is introduced in this service release.
for calculating accumulated distance
This enhancement is designed to satisfy
for users with multiple vehicles.
varying country regulatory requirements
requiring different base calculation types (by car; by configuration) for the
accumulation of reimbursable car mileage.
The new Accumulate Distance By field allows the administrator to choose the
distance accumulation calculation method for their Personal Car Variable Rate or
Company Car Variable Rate configurations (only) by selecting one of the following
three options:
•

Configuration: Accumulated distance for one or more cars according to the
overall car configuration.

•

Car Criteria: Accumulated distance for one or more cars according to the
specific car criteria under which the cars are registered.

•

Car: Accumulated distance for this car alone and no others.

The new option is shown in the figure below:
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Please note the following when working with this feature:
•

New car configurations must be created to take advantage of this feature.
Existing configurations will continue with the current accumulation method:
♦

Company cars accumulate based on Car.

♦

Personal cars accumulate based on Configuration.

•

This feature is only available to variable rate configurations of personal or
company cars.

•

The accumulation method appears when registering a car under the new
configuration.

•

The initial distance set for a car at the time of registration sets the amount of
distance accumulated to date in the current reporting period that has already
been reported outside of Concur. This field will show for a new car registration
based on the accumulation method selected:

•

♦

Configuration: Once for the first car registered.

♦

Car Criteria: Once for the first car registered in each car criteria.

♦

Car: Once for each car registered.

The accumulation begins from zero at the start of each accumulation period
defined in the car configuration.
Refer to Expense: Car Configuration Setup Guide for more information.
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Receipts Required Text Can Now be Customized & Localized
Overview
Business Purpose
When a user must include receipts with
their expense entries they are reminded
This enhancement allows specificity in
of this when they submit their report.
instructing the user how to make
The text that appears is default text
receipts available for an entry.
displayed by the system. With this
release, that text can now be customized and localized to allow customized,
instructional text for the user providing receipts.

Configuration
To configure the feature, the administrator opens an existing policy or creates a new
one by clicking Administration > Expense Admin > Policies. Using the Receipt
Text box, the administrator types the text they prefer, up to 1000 characters.

This text will now override the default text. To return to the default text, clear the
custom text. The text appears to the user as shown in the figure below:
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Localizing the Custom Text
The client is responsible for localizing the text they provide for this feature. This is
done using the Policy Names selection in the Localization tool under Expense Admin.
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Section 3: Expense Pay
The following features are included in this service release.

Expense Pay UK: New Funding Banks
Overview
The Expense Pay UK funding bank
support has been expanded to include
the following banks:
•

Nordea Bank

•

BNPP Fortis

Business Purpose
This new feature expands funding bank
support in the UK.

These banks now appear on the Funding Account page, in the Bank Name drop
list for UK companies.

Configuration
No additional configuration is required to use this feature.

Expense Pay EMEA: Support For Euro Payments from Swedish Funding
Banks
Overview
The Funding Account page has been
enhanced to allow clients to enter Euro
bank accounts at Swedish funding
banks.

Business Purpose
This new feature expands Euro funding
bank options.

Configuration
No additional configuration is required to use this feature.

Expense Pay EMEA: Support For Euro Payments from Swiss Funding
Banks
Overview
The Funding Account page has been
enhanced to allow clients to enter Euro
bank accounts at Swiss funding banks.
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Expense Professional / Premium
Concur Clients

Configuration
No additional configuration is required to use this feature.

Expense Pay EMEA: Support for Elavon Visa Card Programs
Overview
The card program support for Expense
Pay EMEA has been expanded to include
Elavon Visa card programs. The new
programs are:
•

Elavon Visa UK

•

Elavon Visa Switzerland

•

Elavon Visa Euro

Business Purpose
This new feature expands European
card program support.

Configuration
No additional configuration is required to use this feature.
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Section 4: Jobs
The following features are included in this service release.

Extracts: Force Value for Country Code & Sub Code Using New Setting
Overview
Business Purpose
A new setting is available to configure
an extract to draw the Country Code
This enhancement provides flexibility
and Country Sub Code values from
when configuring the extract output
either one of two tables when
file.
configuring an extract output file. This
setting, Use Location Information, is selected by default and in this state pulls the
code values from the Location table. Clearing the check box causes the system to
now retrieve this information from the Entry table instead.
The check box is shown in its default state in the figure below:

Why Did We Make This Change?
When a client elects to not use the Location field, then only Country and Country Sub
Codes are available; that is, there will not be a Location Name associated with an
entry. This change provides a way for clients to include Country and Country Sub
Code information in their accounting extract.
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Section 5: Documentation Updates
The following documentation changes are included in this service release.

Release Notes Now Available in Product-Specific Documents
Overview
Business Purpose
With this release the client can now
choose from product-specific release
Administrators can now build the set of
notes, each document or group of
release notes they need for their site
documents matching a specific Concur
without sorting through unnecessary
offering. Now, if one administrator is
material.
tasked with reviewing resolved issues,
they can download a document with only case information in it. The Invoice user can
download either Invoice release notes, or both Invoice and Mobile if that solution
applies to the client site.
How It Works - Concur Client Central
A table displays when the user logs in to Concur and proceeds to Release
Documentation > Release Notes using the Resources menu. The design of the table
allows the client to use the uppermost row of the table to quickly identify their
Concur product and what notes are applicable to their solutions:
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Each set of release notes include descriptions on the cover detailing what supporting
products can be found within the document. For example, the client who reviews
Expense Pay changes does so by downloading the Expense - Professional/Premium
release notes.
Help System Updates
The Concur administrative Help systems now include links to release notes as well.
When the user opens administrative Help (only), the leftside navigational area now
features the What's New link for the product release notes, plus additional links to
Mobile if that product is applicable to the solutions at the client site.

With this update the administrator can now avoid logging in to Concur Client Central
to view the release notes for their product(s).
Restrictions
To ensure security and "no see" restrictions, only the administrative Help systems
(Expense Tools; Expense Admin; Invoice Admin, etc.) contain the release note links no End User Help system allows viewing of the notes.

Configuration
No additional configuration is required to use this feature.
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Section 6: Supported Configurations
The following configurations are either supported or no longer supported with this
service release.

Certifications for This Release
Support for Firefox v. 7.0
Support for Firefox version 7.0 under both the Mac OS X and Microsoft Windows
operating systems is certified for this release.

Support for Google Chrome v. 15.0
Support for Google Chrome version 15.0 under both the Mac OS X and Microsoft
Windows operating systems is certified for this release.

Upcoming Certifications
Support for Firefox v. 8.0
Support for Firefox 8.0 under both the Mac OS X and Microsoft Windows operating
systems will be included in an upcoming release.

Support for Chrome v. 16.0
Support for Google Chrome 16.0 under both the Mac OS X and Microsoft Windows
operating systems will be included in an upcoming release.
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Legal Notice
This document contains proprietary information and data that is the exclusive
property of Concur Technologies, Inc., Redmond, Washington. No part of this
document may be reproduced, transmitted, stored in a retrievable system,
translated into any language, or otherwise used in any form or by any means,
electronic or mechanical, for any purpose, without the prior written consent of
Concur Technologies, Inc.
Information contained in this document applies to the following products in effect at
the time of this document's publication:

Travel & Expense, December 2011

The above product(s) and information contained in this document are subject to
change without notice. Accordingly, Concur Technologies, Inc. disclaims any
warranties, express or implied, with respect to the information contained in this
document, and assumes no liability for damages incurred directly or indirectly from
any error, omission, or discrepancy between the above product(s) and the
information contained in this document.
© 2004 – 2011 Concur Technologies, Inc., Redmond, Washington. All rights
reserved.
Concur® is the trademark of Concur Technologies, Inc. All other company and
product names are the property of their respective owners.
Published by Concur Technologies, Inc.
18400 NE Union Hill Road
Redmond, Washington 98052
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Release Notes – December 2011
FOR CONCUR INTERNAL USE ONLY – DO NOT DISTRIBUTE OUTSIDE CONCUR

Finding Additional Product Release Notes
For Travel release notes, log in to Concur Client Central, then click Resources >
Document Library > Travel and then either TMC Partner or Direct Customers.
For all other products, log in to Concur Client Central, then click Resources >
Release Documentation > Release Notes to select and download additional
product-specific release notes matching your Concur solution(s):
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Section 1: Resolved Issues - Expense
Case ID

Case/Defect Description

110721000783

Expense / Groups:
Not all cash advance employees belonging to a group appear.

110725000812
111018000128

Expense / Card Import:
Error message is incorrect for card import - shows internal message, not client
message.

111020000964

Expense / Account Codes:
Changing value does not cause the account code to also update.

111026000938

Expense / Attendees:
Add to Expense link remains unavailable after adding an attendee group to
expenses that have different pay types (one card, one cash).

111027000034

Expense / Processor Search:
Processor report search does not support the umlaut character.

111028000005

Expense / Exchange Rates:
System does not re-query database rates, instead re-queries Oanda.

111107000131

Expense / Processor:
Processor sees error message when viewing expense report.

111109000505

Expense / Itemization:
Itemization Wizard is blank after assigning to multiple expense types.

111111000045

Expense / Attendees:
Import link is missing.

111114000692

Expense / Expenses:
Selecting multiple expenses for editing causes error - browser stops
responding.

111121001345

Expense / Processor:
Processor - starting group sort order for hierarchy nodes not in alpha-order.

110721000857

Expense / Attendees:
Miscalculation of the Attendee amounts, cost per attendee.

110919001186

Expense / Allocations:
Allocation data is not copying over from Travel Request to Report Entry
consistently for Fixed Meals-type entries.

111018000049

Expense / Exceptions:
Very long text wraps below Exception check box in drop down list, making it
hard to read or select the check box.

111021000479

Expense / Exceptions:
Exception icon does not appear when submitting report with exceptions in
entries.
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Case ID

Case/Defect Description

111031000870

Expense / Role Builder:
Security breach message appears when attempting to access Car
Configuration using a custom role.

111104001296

Expense / Currencies:
Displaying the Currency Helper to change currency allows an entry to be
saved with Amount fields value of zero ("0").

111108001184

Expense / Cash Advance:
Adding comment in Comment box causes an error.

111110001036

Expense / Authorization Request:
Category "Other" is displayed twice under Chinese language.

111125000167

Expense / Delegates:
Unable to scroll through drop down list to select a delegate under using
Mozilla Firefox.

111128000582

Expense / Processor - Query:
Processor query field displays incorrect label of General.Yes or General.No.

111206000030
111206001435
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Section 2: Resolved Issues - Jobs
Case ID

Case/Defect Description

111109000061

Expense / Company Card:
Failed to create Cash Advance when client configured to use only external
exchange rates.

111108000441

Expense / Company Card:
Unrecognized Delinquency Charge AdjustmentReasonCode for Bank of
Montreal.

110929000359

Expense / Accounting Extract:
Country code not included in the extract.

111018000128

Expense / Company Card:
Error code displayed rather than error message.

110916001069

Expense / Email Reminder:
Email reminder failing due to custom field configuration.

Concur Release Notes
December 2011

Page 5

Resolved and Known Issues Case List
Concur Clients

Section 3: Documentation Updates
The following documentation changes are included in this service release.

Release Notes Now Available in Product-Specific Documents
Overview
Business Purpose
With this release the client can now
choose from product-specific release
Administrators can now build the set of
notes, each document or group of
release notes they need for their site
documents matching a specific Concur
without sorting through unnecessary
offering. Now, if one administrator is
material.
tasked with reviewing resolved issues,
they can download a document with only case information in it. The Invoice user can
download either Invoice release notes, or both Invoice and Mobile if that solution
applies to the client site.
How It Works - Concur Client Central
Beginning in April a table will now be displayed when the user logs in to Concur and
proceeds to Release Documentation > Release Notes using the Resources menu.
The design of the table allows the client to use the uppermost row of the table to
quickly identify their Concur product and what notes are applicable to their solutions:
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Each set of release notes include descriptions on the cover detailing what supporting
products can be found within the document. For example, the client who reviews
Expense Pay changes does so by downloading the Expense - Professional/Premium
release notes.
Help System Updates
The Concur administrative Help systems now include links to release notes as well.
When the user opens administrative Help (only), the leftside navigational area now
features the What's New link for the product release notes, plus additional links to
Mobile if that product is applicable to the solutions at the client site.

With this update the administrator can now avoid logging in to Concur Client Central
to view the release notes for their product(s).
Restrictions
To ensure security and "no see" restrictions, only the administrative Help systems
(Expense Tools; Expense Admin; Invoice Admin, etc.) contain the release note links no End User Help system allows viewing of the notes.

Configuration
No additional configuration is required to use this feature.
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property of Concur Technologies, Inc., Redmond, Washington. No part of this
document may be reproduced, transmitted, stored in a retrievable system,
translated into any language, or otherwise used in any form or by any means,
electronic or mechanical, for any purpose, without the prior written consent of
Concur Technologies, Inc.
Information contained in this document applies to the following products in effect at
the time of this document's publication:

Travel & Expense, December 2011

The above product(s) and information contained in this document are subject to
change without notice. Accordingly, Concur Technologies, Inc. disclaims any
warranties, express or implied, with respect to the information contained in this
document, and assumes no liability for damages incurred directly or indirectly from
any error, omission, or discrepancy between the above product(s) and the
information contained in this document.
© 2004 – 2011 Concur Technologies, Inc., Redmond, Washington. All rights
reserved.
Concur® is the trademark of Concur Technologies, Inc. All other company and
product names are the property of their respective owners.
Published by Concur Technologies, Inc.
18400 NE Union Hill Road
Redmond, Washington 98052

Concur Release Notes
December 2011

Page 8

Resolved and Known Issues Case List
Concur Clients

